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Novedades
 
Para obtener más información, vea estos recursos recomendados en línea.

Importación y grabación en CD
video2brain (7 de mayo de 2012)
vídeo
Produzca fácilmente CD de audio de calidad profesional.

Controladores de hardware y automatización grabable
video2brain (7 de mayo de 2012)
vídeo
Mezclas perfectas.

Corrección de tono
video2brain (7 de mayo de 2012)
vídeo
Controles visuales y automáticos intuitivos.

Tutorial sobre plantillas de sesión
Durin Gleaves (7 de mayo de 2012)
vídeo
Cree elementos multipista comunes con rapidez.

Mejoras en los efectos
video2brain (7 de mayo de 2012)
vídeo
Procese audio con una amplia gama de herramientas creativas.

Mejoras en la edición multipista
video2brain (7 de mayo de 2012)
vídeo
Alinee la voz, los efectos de reacción en cadena, etc.

Almacenamiento de sesiones multipista
video2brain (7 de mayo de 2012)
vídeo
Mejore al máximo la eficacia de sus proyectos.

Mejoras en la edición de formas de onda
video2brain (7 de mayo de 2012)
vídeo
Las mejoras en los controles de marcadores, transporte y previsualizaciones agilizan el flujo de trabajo.

Parte del contenido vinculado a esta página puede estar solo en inglés.
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Agrupación de clips multipista

Recorte de clips multipista según las selecciones de tiempo

Detección de clips multipista

Previsualización de ediciones con Omitir selección

Varios portapapeles en el editor de forma de onda
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Edición de audio más rápida y precisa
Ampliación de clips multipista
Alineación de voz automática
Compatibilidad con diferentes superficies de control mediante la automatización de parámetros
Potentes controles de tono
Administración eficaz de archivos
Más formatos de audio y vídeo
Grabación de CD
Más efectos, enrutamiento flexible y compatibilidad con VST3
Automatización de radio integrada
Procesamiento por lotes mejorado
Metrónomo configurable
Métodos abreviados de teclado mejorados

Edición de audio más rápida y precisa

Seleccione varios clips y elija Clip > Grupos > Agrupar clips. Puede mover y editar los clips agrupados e incluso
ampliarlos proporcionalmente si está activada la función de ampliación de clips. La ampliación de grupos, la ganancia, el color y otros ajustes
están disponibles en el panel Propiedades (Ventana > Propiedades).

Para editar temporalmente todos los clips agrupados por separado, seleccione Clip > Grupos > Suspender grupos. Para volver a agrupar los clips
con rapidez durante una sesión, anule la selección del comando Suspender grupos.
Para editar un clip del grupo por separado, haga clic en él con el botón derecho y seleccione Quitar selección de clips del grupo.

El comando Recortar hasta la selección de tiempo recorta las partes de los clips
que no se utilizan y ayuda a alinearlos en una sesión con elementos musicales o de vídeo relacionados.

1. Seleccione un intervalo de tiempo y uno o varios clips con la herramienta Selección de tiempo .
2. Elija Clip > Recortar hasta la selección de tiempo.

En la sección Información del panel Propiedades, introduzca horas específicas de inicio y finalización del clip para
colocar los clips seleccionados con precisión.

En los controles de transporte de la parte inferior del panel Editor, haga clic en el botón
Omitir selección  para omitir el audio seleccionado durante la reproducción, lo que le permitirá previsualizar las ediciones con mayor precisión.

Coloque el cabezal de reproducción antes de la selección para definir la cantidad predeterminada de predesplazamiento y postdesplazamiento.
Audition aplica el mismo ajuste a la próxima previsualización con Omitir selección.

Elija Edición > Definir portapapeles actual para copiar y pegar el audio de un máximo de
cinco portapapeles distintos. Estará siempre disponible cuando necesite pegar material específico que utilice con frecuencia.

Ampliación de clips multipista
Amplíe los clips a la longitud deseada con rapidez y previsualice el resultado durante la reproducción. En el panel Editor, seleccione varios clips
para ampliarlos proporcionalmente. En el panel Propiedades, elija entre una gran variedad de tipos de ampliación optimizados para varios tipos de
contenido de audio.

Para obtener más información, consulteAmpliación de clips multipista en CS6.

Alineación de voz automática
Utilice la alineación de voz automática para alinear con rapidez el diálogo doblado con el audio de producción original. Audition hace coincidir
cada palabra, incluso si el audio original es ruidoso o su longitud total es diferente.

En el editor Multipista, seleccione dos clips que contengan el mismo diálogo y tengan una longitud similar. A continuación, elija Clip > Alineación
de voz automática.

http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/es-es/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
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En los menús Canal de referencia, seleccione los canales con el diálogo más claro. Para mejorar aún más la alineación, recorte el silencio al
principio o al final de los clips.

Compatibilidad con diferentes superficies de control mediante la automatización de
parámetros
Utilice los protocolos EUCON, Mackie MCU o Logic Control (incluida la serie Avid Artist de Euphonix) para mezclar el audio de forma interactiva
con las superficies de control más populares. También puede utilizar controladores de terceros basados en tablets que admitan estos protocolos.
Puede incluso utilizar varios dispositivos de forma simultánea.

Para conectar el controlador a Audition, elija Edición > Preferencias > Superficie de control. Elija el protocolo del controlador en el menú Clase de
dispositivo. A continuación, haga clic en Configurar para especificar las entradas y salidas de MIDI (para los controladores Mackie y Logic), o
Asignaciones de los botones (para los controladores Mackie y Red Rover).

Audition CS6 admite la toda la gama de modos de automatización (Leer, Escribir, Enclavar y Tocar) para todos los parámetros de efectos,
panorámica y a nivel de pista. Elija el modo de automatización en el menú situado en la parte inferior de los controles de pistas en el panel Editor,
o encima del atenuador en el Mezclador.

Para obtener información sobre cada modo de automatización, consulteOpciones de automatización de pistas.

Controles de tono eficaces
Corrija el tono de forma precisa con el control automático y manual de tono o manipule el audio forma creativa para obtener diseños de sonido
innovadores.

Para obtener el mejor resultado, aplique la corrección de tono a pistas vocales o instrumentales individuales.

Efecto Corrección de tono manual (solo en el Editor de forma de onda)
El efecto Corrección de tono manual permite ajustar el tono visualmente con la Visualización de tono espectral. La Visualización de tono espectral
muestra el tono fundamental como una línea azul brillante y los tonos armónicos en matices del amarillo al rojo. El tono corregido aparece como
una línea verde brillante.

Elija Efectos > Tiempo y tono > Corrección de tono manual. Para obtener instrucciones detalladas, consulte Efecto Corrección manual de tono.

Puede controlar el tono visualmente en cualquier momento, sin utilizar el efecto Corrección de tono manual. Tan solo tiene que hacer clic en el
icono Visualización de tono espectral de la barra de opciones.

Efecto Corrección automática de tono
El efecto Corrección automática de tono está disponible en los editores Forma de onda y Multipista. En el segundo caso, sus parámetros pueden
automatizarse en el tiempo mediante el uso de fotogramas clave y superficies de control externas.

Elija Efectos > Tiempo y tono > Corrección automática de tono. Para obtener instrucciones detalladas, consulte Efecto Corrección automática de
tono.

Administración eficaz de archivos

Navegador de medios
Seleccione Ventana > Navegador de medios para previsualizar los archivos en sus unidades locales y de red, con especificaciones y metadatos
de archivo muy útiles. En la parte inferior del panel, haga clic en el botón Reproducir  para oír el audio y el botón Reproducir en bucle  para
capturar los detalles. A continuación, arrastre los archivos directamente a los paneles Archivos o Volumen de coincidencia, sesiones multipista o
diseños de CD.

Para marcar una carpeta que use con frecuencia, acceda a ella en el Navegador de medios y, a continuación, haga clic en el icono Agregar
método abreviado en la esquina superior derecha del panel.

Panel Archivos
Para buscar archivos con rapidez en el panel Archivos , introduzca datos en el cuadro de búsqueda, como, por ejemplo, el nombre, canales, o el
tipo de medio. En la parte inferior del panel, haga clic en los botones Reproducir  y Reproducir en bucle .

Para ahorrar espacio en los paneles Navegador de medios y Archivos, haga clic en el botón de menú del panel situado en la esquina superior
derecha y anule la selección de Mostrar transporte de vista previa. Aparece un botón Reproducir más pequeño en la parte superior y los
comandos de reproducción automática y previsualización de bucle permanecen disponibles en el menú del panel.

http://idiom-q-win-1/content/help/es/audition/using/manual-pitch-correction-effect--.html
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Panel Marcadores
El panel Marcadores dispone de un cuadro de texto de búsqueda similar y estas características:

En la esquina superior derecha del panel, haga clic en el icono Mostrar marcadores de todos los archivos  para ver los marcadores en toda una
sesión de trabajo. Utilice los iconos situados en la parte superior del panel para insertar los intervalos de marcador seleccionados en sesiones
multipista, diseños de CD o listas de reproducción.

Haga clic en el icono Insertar en multipista  para añadir intervalos de marcadores a una sesión multipista existente o crear una sesión nueva.

Los nuevos tipos de marcador incluyen:

Subclip para rangos de un archivo que desea que Adobe Premiere Pro muestre como clips independientes en el panel
Proyecto.
Pista de CD. Consulte Grabación de CD.
Temporizador de carro para sistemas de automatización de radio. Consulte Automatización de radio integrada.

Plantillas de sesión, archivos y mezclas
Elija Archivo > Exportar > Sesión como plantilla para crear plantillas multipista que aceleren los proyectos recurrentes que requieran ajustes,
tareas y archivos de origen similares. Para aplicar una plantilla a una nueva sesión, elija Archivo > Nuevo > Sesión multipistay, a continuación,
elija una opción de Plantilla.

Para archivar sesiones enteras o moverlas a otros sistemas junto con marcadores, metadatos y archivos de origen, elija Archivo > Exportar >
Sesión. En el cuadro de diálogo Exportar sesión, para personalizar los archivos de origen exportados, seleccione Guardar copias de archivos
asociadosy haga clic en Opciones. Para cambiar el formato de archivo, seleccione Convertir archivos. Para exportar archivos de origen completos
o recortados, seleccione Opciones de medios.

Elija Archivo > Exportar > Mezcla, y revise la sección Opciones de mezcla. Haga clic en Cambiar para que las pistas se procesen como archivos
separados o para procesar a la vez versiones maestras 5.1, mono y estéreo.

Más formatos de audio y vídeo
Importe y reproduzca vídeo HD en una gran variedad de velocidades de fotogramas, incluyendo 23,976, 59,94 con fotograma eliminado y 59,94
sin fotograma eliminado. La regla y el resto de visualizaciones de código de tiempo coinciden automáticamente.

Los formatos de importación compatibles ahora incluyen FLV, Shockwave y RED R3D, así como Monkey's Audio y toda una gama de formatos de
audio del estándar libsndfile.

Los formatos de exportación también incluyen Monkey's Audio y libsndfile, FLAC, OGG y MPEG-1 Audio Layer II (MP2).

Nota: Para habilitar ciertos formatos, debe seleccionar Habilitar compatibilidad con formato DLMS en las preferencias de Caché de medios y de
disco.

Para ver una lista completa de formatos y ajustes relacionados, consulte Formatos de importación compatibles y Ajustes del formato de
importación.

Grabación de CD
Elija Archivo > Nuevo > Diseño de CD para ensamblar archivos que desee grabar en un CD de audio con el estándar Red Book. También puede
añadir pistas directamente desde los paneles Archivos y Marcadores: haga clic con el botón derecho del ratón y elija Insertar en diseño de CD.
(Para que esta opción esté disponible para los intervalos de marcadores, elija Pista de CD en la columna Tipo.)

Presione Mayús + M durante la reproducción para marcar rápidamente los puntos de inicio y fin de una pista en el CD. A continuación,
seleccione los puntos adyacentes en el panel Marcadores y haga clic en el icono Combinar marcadores seleccionados para crear rangos de
tiempo para cada pista.

Puede ensamblar varios archivos de diseño de CD simultáneamente y elegir entre ellos en el panel Archivos. En el panel Propiedades,
especifique propiedades del disco como Número de catálogo de medios (MCN), Título y Artista.

Al finalizar el diseño de un CD, elija Archivo > Exportar > Grabar audio en CD. (En el cuadro de diálogo Grabar audio, seleccione Modo de
escritura > Probar para garantizar que la transferencia de datos será lo suficientemente rápida para evitar errores.)

Para grabar un solo archivo y sus marcadores de pista con rapidez, seleccione Archivo > Exportar > Grabar audio en CD en el Editor de forma
de onda. (Los marcadores de pista deben ser intervalos de tiempo y no puntos.)

Más efectos, enrutamiento flexible y compatibilidad con VST3

Efectos favoritos
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Audition CS6 reinstaura varios efectos clave. Desde el menú Efectos, seleccione las opciones siguientes:

Generar tonos le permite seleccionar una forma de onda, añadir armonías, crear un barrido y ajustar la fase para crear
elementos de diseño de sonido y tonos de prueba.
Especial > Desfasador Doppler (solo en el Editor de forma de onda) crea el efecto de un sonido que pasa a través del oyente
o incluso gira a su alrededor.
Imágenes estéreo > Desfasador de fase gráfico permite identificar el grado de control sobre la fase para cada parte del
espectro de frecuencias.
Filtro y EC > Filtro de rechazo de banda le permite ajustar frecuencias específicas para reducir el ruido, obtener efectos EC
extremos o resonancias intensas.

Reacción en cadena y enrutamiento flexible de efectos
Las mejoras de enrutamiento le permiten asignar entradas y salidas de efectos a canales específicos, una técnica especialmente flexible para las
mezclas de 5.1 envolventes. (Por ejemplo, puede aplicar efectos mono o estéreo a orígenes 5.1.) En la esquina superior derecha de las ventanas
de efectos, haga clic en el icono Editor de asignación de canales .

La reacción en cadena para los plugins compatibles y el efecto Procesamiento dinámico integrado permite ajustar la amplitud según una señal
externa. La técnica más popular baja automáticamente el volumen de la música o el ruido de fondo cuando habla un locutor:

1. Abra una sesión multipista.

2. Aplique el efecto Amplitud y compresión > Procesamiento dinámico a la pista de fondo que desee comprimir.

3. En el Bastidor de efectos, haga doble clic en el efecto para modificar los ajustes.

4. En la esquina superior derecha de la ventana Procesamiento dinámico, haga clic en el icono Establecer entrada de reacción
en cadena . A continuación, seleccione la configuración de canales para el audio de origen: Mono, Estéreoo 5.1.

5. Vaya a la pista de voz en off. En la sección Envíos  del panel Editor, elija Reacción en cadena > Procesamiento dinámico
[nombre de la pista de destino].

Compatibilidad con VST3 y estabilidad sólida
La compatibilidad con los efectos VST3 abre un nuevo mundo de efectos suplementarios. Una exploración independiente de los efectos de
terceros mantiene Audition en funcionamiento incluso si un plugin se vuelve inestable.

Automatización de radio integrada
Audition CS6 se integra completamente con los sistemas de automatización de radio.

1. Para definir visualmente los temporizadores AES CART en una forma de onda de audio, coloque el cabezal de reproducción
en el panel Editor y, a continuación, pulse la tecla C. (Para colocar temporizadores con rapidez, pulse la tecla C durante la
reproducción.)

2. En el panel Marcadores, haga clic en los menús emergentes de la columna Nombre para elegir entre los códigos de carro
predeterminados. (Puede escribir códigos personalizados de cuatro caracteres como máximo para su sistema.)

Los sistemas de carro solo leen los primeros ocho temporizadores de un archivo; los posteriores se omitirán.

Seleccione Ventana > Metadatos para acceder a estas opciones de radio:

En la ficha CART, puede editar rápidamente Id, frases opcionales, fechas de inicio y finalización, etc. (Los mismos metadatos
aparecen en la sección AES CART de la ficha XMP.)
En la ficha RIFF, seleccione Mostrar como > Sector radiofónico para ver un subconjunto simplificado de metadatos RIFF.

Procesamiento por lotes mejorado
En el panel Proceso por lotes, podrá aplicar favoritos a varios archivos simultáneamente en cualquier momento, no solo durante la exportación. Al
exportar en los paneles Proceso por lotes o Volumen de coincidencia, si desea especificar rápidamente convenciones comunes de denominación
de archivos, haga clic en Exportar ajustes y, a continuación, seleccione Plantilla.

Seleccione Archivo > Guardar todo el audio como proceso por lotes para procesar todos los archivos abiertos. Para obtener más información,
consulte Procesamiento de archivos por lotes.
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Metrónomo configurable
Un metrónomo configurable proporciona una gran variedad de patrones de pulsación y sonidos. Elija Edición > Metrónomo > Editar patrón o
Cambiar el tipo de sonido.

Para activar el metrónomo, haga clic en el icono del metrónomo  en los paneles Propiedades o Editor. Ajuste el volumen y la panorámica en la
pista Metrónomo que aparece en la parte superior del panel Editor.

Para cambiar el tempo y la firma de tiempo de la sesión actual, modifique los ajustes de la sección Visualización de la hora del panel
Propiedades.

Para la pista Metrónomo, puede aplicar efectos, asignar envíos y salidas de hardware y automatizar la mezcla como en las pistas de audio.

Métodos abreviados de teclado mejorados
Para acceder a los métodos abreviados con rapidez, elija Edición > Métodos abreviados de teclado y escriba comandos en el cuadro de búsqueda
o haga clic en Copiar en el portapapeles para imprimir desde un editor de texto.

http://creativecommons.org/licenses/by-nc-sa/3.0/deed.es_GT
http://help.adobe.com/es_ES/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_es


Novedades
Nota: Algunas de las funciones de la versión para Windows de Adobe Audition 3.0 no están disponibles en CS5.5. Por ejemplo, la grabación de
CDs, MIDI, el metrónomo, algunos formatos de archivo y efectos, la agrupación de clips y expansión de tiempo, así como la compatibilidad con la
superficie de control. Para obtener una lista completa, consulte Funciones de Adobe Audition 3.0 reemplazadas o no implementadas en CS5.5.
Adobe Audition CS5.5 combina las mejores funciones de los productos de audio de Adobe en un solo paquete multiplataforma, con las
herramientas de mezcla multipista y edición líderes del sector, opciones potentes de refinamiento de audio y un rendimiento sólido.

Compatibilidad con Mac OS Aproveche al máximo el procesamiento multinúcleo, audio nativo y potencia DSP de los ordenadores Apple
Macintosh.
Motor de audio de alto rendimiento Realice múltiples tareas de forma eficaz con un nivel de respuesta muy mejorado en proyectos de todos los
tamaños. Abra archivos hasta tres veces más rápido. Trabaje de forma simultánea en varias sesiones multipista y archivos de audio. Importe
procese por lotes archivos en segundo plano mientras continúa editando audio. Agilice los efectos en sistemas de multiprocesador.
Edición de retorno con aplicaciones de vídeo como Adobe Premiere Pro Aproveche las herramientas de procesamiento y limpieza de audio
directamente desde Adobe Premiere Pro con la mezcla y la edición de retorno. Intercambie archivos OMF y XML con estaciones de trabajo de
audio digital y editores no lineales como Avid Pro Tools y Apple Final Cut Pro. Consulte Uso de aplicaciones de vídeo y Exportación de sesiones
en formato OMF o Final Cut Pro Interchange.
Edición y mezcla de sonido envolvente 5.1 integrado Mezcle sonido envolvente 5.1 directamente en el Editor multipista. El panel
Panoramizador de pista proporciona controles intuitivos y retroalimentación visual que ayudan a localizar sonidos de forma precisa en el campo
envolvente. Abra los archivos de mezcla 5.1 en el Editor de forma de onda para editar los canales seleccionados. Consulte sonido envolvente
5.1.
Flujos de trabajo de efectos mejorados Ajuste los parámetros del efecto mientras realiza selecciones, reproduce audio o incluso aplica
reducción de ruido complejo. Aplique efectos multipista a clips individuales. Amplíe las posibilidades de procesamiento de audio con plugins de
terceros VST y Audio Units. Consulte Aplicación de efectos.
Efectos nuevos Adobe Audition CS5.5 incluye nuevos efectos entre los que se incluyen Reverberación envolvente, optimizado para archivos 5.1,
hasta un conjunto de efectos de diagnóstico que corrigen problemas de audio comunes. Para obtener más información, consulte lo siguiente:

Efecto Reverberación envolvente

Efecto Amplificador vocal

Efecto Nivelador de volumen de voz

Efecto Compresor de una sola banda

Efectos de diagnóstico (solo Editor de forma de onda)

Efecto DeHummer

Efecto DeEsser

Efecto Coro/Bordeador

Efecto Ajustador de fase

Biblioteca ampliada de bases musicales libres de derechos y efectos de sonido. Realce su pista de sonido con más de 10.000 archivos
libres de derechos disponibles en el panel Resource Central. Localice y previsualice archivos con rapidez y después simplemente arrastre desde
el panel a los proyectos de audio y genere bandas sonoras profesionales y en capas.
Flujo de trabajo de metadatos funcional con compatibilidad con Broadcast Wave Simplifique la gestión y edición de metadatos con el panel
Metadatos basado en XMP. La compatibilidad con XMP se amplía al formato Broadcast WAV (BWF), permitiendo flujos de trabajo automatizados
para sistemas de producción de radio y TV. Consulte Visualización y edición de metadatos XMP.
Formato de sesión XML nativo Guarde sesiones multipista en formato XML flexible, un estándar legible que facilita la conversión a formatos
propietarios utilizados por distintos fabricantes. Las sesiones de Adobe Audition XML se pueden abrir y editar en editores de texto o creadas
mediante programación a partir de scripts y otras herramientas. Consulte Almacenamiento de sesiones multipista.
Coincidencia de volumen del clip multipista Mezcla de audio con facilidad de varios orígenes. Consulte Coincidencia del volumen de clip
multipista.
Análisis de audio multipista Analice las relaciones de fase y respuesta de frecuencia en tiempo real utilizando el panel Contador de fase y
Análisis de frecuencia. Consulte Análisis de fase y Análisis de intervalo de frecuencias.
Vistas espectrales y de forma de onda simultáneas Evalúe la frecuencia y la amplitud de audio con máxima precisión. Consulte Visualización
de formas de onda de audio y espectros.
Favoritos para grabación Almacene combinaciones de efectos, transiciones y ajustes de amplitud y vuelva a aplicarlos con rapidez en cualquier
archivo o selección en el Editor de forma de onda. Consulte Favoritos.
panel Historia Devuelva fácilmente ediciones y mezclas a estados anteriores, comparando diferentes procesamientos de efectos, reducción de
ruido, flujo de señal, etc. Recupere sus ajustes originales con un solo clic. Consulte Cómo deshacer y rehacer el historial.
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Ampliación de clips multipista en CS6
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Modo

Tipo

Duración, Ampliación y Tono

Ajustes avanzados

1. Elija Clip > Ampliación > Activar ampliación del clip global.

2. En el panel Editor, arrastre los triángulos blancos de la esquina superior derecha o izquierda de los clips.

Seleccione varios clips para ampliarlos proporcionalmente.

Para personalizar los ajustes de ampliación de los clips seleccionados, ajuste las opciones de Ampliación siguientes en el panel Propiedades:

Elija entre las siguientes opciones:
Desactivado desactiva la ampliación y devuelve el clip a su longitud original.
Tiempo real le permite oír los resultados de la ampliación a medida que arrastra los clips. Este modo es una buena opción
durante el proceso de edición.
Procesado (alta calidad) requiere un mayor procesamiento pero puede evitar las irregularidades de audio. Elija este modo si la
reproducción o el rendimiento son lentos en el modo de tiempo real.

Elija entre las siguientes opciones:
Monofónica es la mejor opción para instrumentos musicales solistas o diálogos.
Polifónica es la mejor opción para música con varios instrumentos o sonidos ambientales complejos.
Velocidad variable cambia el tono además de la duración, de forma similar a disminuir la velocidad o acelerar las máquinas
con cintas analógicas.

Para aplicar el mismo modo a todos los clips con rapidez, elija Clip > Ampliación > Todos los clips ampliados en tiempo real o Procesar todos
los clips ampliados.

Si se introducen entradas numéricas, los ajustes serán más precisos que los permitidos cuando se arrastran clips
en el panel Editor.

Establezca las siguientes opciones:
Sensibilidad transitoria (disponible en el modoPolifónica) establece la sensibilidad de las transiciones como la batería y los
principios de notas, que se utilizan como puntos de anclaje para la ampliación. Auméntelo si las transiciones no suenan
naturales.
Tamaño de ventana define el tamaño, en milisegundos, de cada fragmento de audio procesado. Ajústelo solo si se producen
ecos o irregularidades en el sonido.
Los ajustes Precisión (disponibles en el modo Procesado) determinan el equilibrio entre la calidad y la velocidad de
procesamiento.
Conservar componentes (disponible al seleccionar Procesado y Monofónica) ajusta el timbre de los instrumentos y las voces, y
mantiene el realismo en los cambios de tono.

Para que las voces masculinas suenen femeninas y viceversa, seleccione Conservar componentes y cambie el tono drásticamente.
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Comparación de audio analógico y digital
Con un audio analógico y digital, el sonido se transmite y almacena de forma muy diferente.

Audio analógico: voltaje positivo y negativo
Un micrófono convierte las ondas de sonido bajo presión en cambios de tensión en un cable: la alta presión se convierte en tensión positiva,
mientras que la baja presión lo hace en negativa. Cuando estos cambios de tensión viajan a través de un cable de micrófono, puede grabarse en
cinta como cambios en intensidad magnética o en discos de vinilo como cambios en tamaño de surco. Un altavoz funciona como un micrófono,
pero a la inversa: toma las señales de tensión de un audio que graba y vibra para volver a crear la onda de presión.

Audio digital: ceros y unos
A diferencia de los medios de almacenamiento analógicos, como las cintas magnéticas o los discos de vinilo, los equipos informáticos almacenan
información de audio de forma digital como una serie de ceros y unos. En el almacenamiento digital, la forma de onda original se desglosa en
instantáneas individuales denominadas muestras. Este proceso se conoce normalmente como digitalización o muestreo del audio, pero en
ocasiones recibe el nombre de conversión de analógico a digital.

Cuando graba en un equipo desde un micrófono, por ejemplo, los conversores de analógico a digital transforman la señal analógica en muestras
digitales que los equipos pueden almacenar y procesar.

Conceptos básicos sobre la velocidad de muestreo
Las velocidades de muestreo indican el número de instantáneas digitales que se toman en una señal de audio cada segundo. Esta velocidad
determina el intervalo de frecuencias de un archivo de audio. Cuanto más alta sea la velocidad de muestreo, más se asemejará la forma de la
onda digital a la forma de la onda analógica original. Las velocidades de muestreo bajas limitan el intervalo de frecuencias que pueden grabarse,
lo que puede dar como resultado una grabación que no representa correctamente el sonido original.

Dos velocidades de muestreo
A.  Velocidad de muestreo baja, que distorsiona la forma de sonido original. B.  Velocidad de muestreo alta, que reproduce perfectamente la
forma de sonido original.

Para reproducir una frecuencia determinada, la velocidad de muestreo ha de ser al menos el doble de la frecuencia. Por ejemplo, los CD tienen
una velocidad de muestreo de 44.100 muestras por segundo, por lo que pueden reproducir frecuencias de hasta 22.050 Hz, lo que está justo por
encima del límite de audición humana (20.000 Hz).

Las velocidades de muestreo más habituales para el audio digital son las siguientes:

Velocidad de muestreo Nivel de calidad Rango de frecuencias
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11.025 Hz Calidad baja de radio AM (multimedia de
gama baja)

0–5.512 Hz

22.050 Hz Prácticamente radio FM (multimedia de
gama alta)

0–11.025 Hz

32.000 Hz Mejor que la radio FM (velocidad de
difusión estándar)

0–16.000 Hz

44.100 Hz CD 0–22.050 Hz

48.000 Hz DVD estándar 0–24.000 Hz

96.000 Hz DVD Blu-ray 0–48.000 Hz

Conceptos básicos sobre la profundidad de bits
La profundidad de bits determina el rango dinámico. Cuando se muestrea una onda de sonido, se asigna a cada muestra el valor de amplitud más
cercano a la amplitud de la onda original. Una profundidad de bits más alta proporciona más valores de amplitud posibles, lo que produce un
rango dinámico más grande, una base de ruido inferior y mayor fidelidad.

Para obtener la mejor calidad de audio, Audition transforma todo el audio al modo de 32 bits y, al guardar archivos, lo convierte a una
profundidad de bits especificada.

Profundidad de bits Nivel de calidad Valores de amplitud Rango dinámico

8 bits Telefonía 256 48 dB

16 bits CD de audio 65.536 96 dB

24 bits DVD de audio 16.777.216 144 dB

32 bits Óptima 4.294.967.296 192 dB

Las profundidades de bits más altas proporcionan un mayor rango dinámico.

Medición de amplitud en dBFS
En el campo del audio digital, la amplitud se mide en decibelios bajo escala completa o dBFS. La máxima amplitud posible es 0 dBFS; todas las
amplitudes por debajo de la misma se expresan como números negativos.

Nota: Un valor dBFS determinado no se corresponde directamente con el nivel de presión del sonido original medido en dB acústico.

Contenidos y tamaño de un archivo de audio
Un archivo de audio en el disco duro, como un archivo WAV, consta de un pequeño encabezado que indica la velocidad de muestreo y la
profundidad de bits y, a continuación, una larga serie de números, uno para cada muestra. Estos archivos pueden ser muy grandes. Por ejemplo,
a 44.100 muestras por segundo y 16 bits por muestra, un archivo mono requiere 86 KB por segundo (unos 5 MB por minuto). Esa cifra se duplica
a 10 MB por minuto para un archivo estéreo, que tiene dos canales.

Cómo digitaliza el audio Adobe Audition



 

Cuando se graba audio en Adobe Audition, la tarjeta de sonido inicia el proceso de grabación y especifica qué velocidad de muestreo y
profundidad de bits se deben utilizar. A través de los puertos de entrada de línea (Line In) o de entrada de micrófono (Microphone In), la tarjeta de
sonido recibe audio analógico y lo muestrea digitalmente a la velocidad especificada. Adobe Audition almacena cada una de las muestras
ordenadas hasta que se detiene la grabación.

Cuando se reproduce un archivo en Adobe Audition, tiene lugar el proceso contrario. Adobe Audition envía una serie de muestras digitales a la
tarjeta de sonido. La tarjeta reconstruye la forma de onda original y la envía como señal analógica a través de los puertos de salida de línea (Line
Out) a los altavoces.

En resumen, el proceso de digitalización de audio comienza con una onda de presión en el aire. Un micrófono convierte esta onda de presión en
cambios de tensión. Una tarjeta de sonido convierte estos cambios de tensión en muestras digitales. Una vez que el sonido analógico se
convierte en audio digital, Adobe Audition puede grabarlo, editarlo, procesarlo y mezclarlo; el límite a las posibilidades lo impone la imaginación del
usuario.
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Ondas de sonido
El sonido empieza con vibraciones en el aire, como las que producen las cuerdas de una guitarra, las cuerdas vocales o un altavoz. Estas
vibraciones fuerzan la unión de las moléculas cercanas de aire, lo que eleva ligeramente la presión de aire. Las moléculas de aire sometidas a
presión empujan a las otras moléculas de aire que las rodean, que empujan a las moléculas colindantes, y así sucesivamente. Cuando las zonas
de alta presión se desplazan por el aire, dejan detrás áreas de baja presión. Cuando estas oleadas de cambios de presión llegan hasta nosotros,
vibran en los receptores de nuestros oídos y escuchamos las vibraciones en forma de sonido.

Cuando se observa una forma de onda visual que representa audio, refleja estas ondas de presión de aire. La línea cero de la forma de onda es
la presión del aire en reposo. Cuando la línea sube a un pico, representa una presión más elevada; si baja a un valle, representa una presión más
baja.

Una onda de sonido representada como forma de onda visual
A.  Línea cero B.  Área de baja presión C.  Área de alta presión

Medidas de la forma de onda
Algunas medidas describen las formas de onda:

Amplitud Refleja el cambio de presión desde el pico de la forma de onda hasta el mínimo. Las formas de onda de alta amplitud son altas; las de
baja amplitud son más silenciosas.
Ciclo Describe una única secuencia repetida de cambios de presión, desde presión cero a alta presión, a baja presión y de nuevo a cero.
Frecuencia Se mide en hercios (Hz) y describe el número de ciclos por segundo. (Por ejemplo, una forma de onda de 1.000 Hz tiene 1.000
ciclos por segundo.) Cuando mayor sea la frecuencia, más alto será el tono musical.
Fase Se mide en 360 grados e indica la posición de una forma de onda en un ciclo. Cero grados es el punto de inicio, seguido de 90º a alta
presión, 180º en el punto central, 270º a baja presión y 360º en el punto final.
Longitud de onda Se mide en unidades, como pulgadas o centímetros, y es la distancia entre dos puntos con el mismo grado de fase. A medida
que aumenta la frecuencia, disminuye la longitud de onda.

Un ciclo único a la izquierda y una forma de onda completa de 20 Hz a la derecha
A.  Longitud de onda B.  Grado de fase C.  Amplitud D.  Un segundo

Cómo interactúan las ondas de sonido
Cuando se encuentran dos o más ondas de sonido, se suman y restan entre sí. Si sus picos y mínimos están perfectamente en fase, se refuerzan



 

unas a otras, lo que da como resultado una forma de onda que tiene una amplitud mayor que las formas de onda individuales.

Las ondas en fase se refuerzan entre sí.

Si los picos y mínimos de dos formas de onda están perfectamente desfasados, se cancelan entre sí, lo que provoca que no haya forma de onda
alguna.

Las ondas desfasadas se cancelan entre sí.

En la mayoría de los casos, no obstante, las ondas se desfasan en diversas magnitudes, lo que da como resultado una forma de onda combinada
que es más compleja que las formas de onda individuales. Una forma de onda compleja que representa música, voz, ruido y otros sonidos, por
ejemplo, combina las formas de onda de cada sonido.

Como consecuencia de su estructura física única, un solo instrumento puede producir ondas sumamente complejas. Por eso, un violín y una
trompeta suenan diferentes incluso cuando tocan la misma nota.

Dos ondas sencillas se combinan para crear una onda compleja.
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Viewing, zooming, and navigating audio
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Comparing the Waveform and Multitrack editors
Zoom audio in the Editor panel
Navigate through time

Comparing the Waveform and Multitrack editors
Adobe Audition provides different views for editing audio files and creating multitrack mixes. To edit individual files, use the Waveform Editor. To
mix multiple files and integrate them with video, use the Multitrack Editor.

The Waveform and Multitrack editors use different editing methods, and each has unique advantages. The Waveform Editor uses a destructive
method, which changes audio data, permanently altering saved files. Such permanent changes are preferable when converting sample rate and bit
depth, mastering, or batch processing. The Multitrack Editor uses a nondestructive method, which is impermanent and instantaneous, requiring
more processing power, but increasing flexibility. This flexibility is preferable when gradually building and reevaluating a multilayered musical
composition or video soundtrack.

You can combine destructive and nondestructive editing to suit the needs of a project. If a multitrack clip requires destructive editing, for example,
simply double-click it to enter the Waveform Editor. Likewise, if an edited waveform contains recent changes that you dislike, use the Undo
command to revert to previous states—destructive edits aren’t applied until you save a file.

For more information about the Waveform Editor, see Editing audio files; for more information about the Multitrack Editor, see Mixing multitrack
sessions.

Basic components of the editors
Though available options differ in the Waveform and Multitrack editors, both views share basic components, such as the tool and status bars, and
the Editor panel.

Basic components of Waveform and Multitrack editors (Waveform shown) 
A. View buttons and toolbar B. Editor panel with zoom navigator at top C. Various other panels D. Status bar 

Switch editors
Do one of the following:

From the View menu, choose Waveform or Multitrack Editor.

In the toolbar, click the Waveform  or Multitrack Editor  button.

In the Multitrack Editor, double-click an audio clip to open it in the Waveform Editor. Alternatively, double-click a file in the
Files panel.

In the Waveform Editor, choose Edit > Edit Original to open the multitrack session that created a mixdown file. (This
command requires embedded metadata in the file. See Embed edit-original data in exported mixdown files.)

http://help.adobe.com/en_US/audition/cs/using/WS58a04a822e3e5010548241038980c2c5-7e43.html#WS58a04a822e3e5010548241038980c2c5-7e41
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Zoom audio in the Editor panel

To zoom into a specific time range, right-click and drag. 
A. Zoom navigator B. Timeline ruler 

Zoom into a specific time range

In either the zoom navigator or the timeline ruler, right-click and drag. The magnifying glass icon  creates a selection showing the range that will
fill the Editor panel.

Zoom into a specific frequency range

In the vertical ruler for the spectral display, right-click and drag. (See View audio waveforms and spectrums.)

Extend or shorten the displayed range

Place the pointer over the left or right edge of the highlighted area in the zoom navigator, and then drag the magnifying glass icon .

Gradually zoom in or out

In the lower right of the Editor panel, click the Zoom In  or Zoom Out  button.

You can set the Zoom Factor in the General section of the Preferences dialog box. (See Customize preferences.)

Zoom with the mouse wheel or Mac trackpad

Place the pointer over the zoom navigator or ruler, and either roll the wheel or drag up or down with two fingers. (In the Waveform Editor, this
zoom method also works when the pointer is over the waveform.)

Roll or drag over the spectral display, and press Shift to switch between logarithmic and linear frequency scales. (Logarithmic better reflects
human hearing; linear makes individual frequencies more visually distinct.)

Magnify selected audio

In the lower right of the Editor panel, click the Zoom In At In Point , Zoom In At Out Point , or Zoom To Selection  buttons.

Display the entire audio file or multitrack session

In the lower right of the Editor panel, click the Zoom Out Full button .

To display zoom buttons in a separate panel, choose Window > Zoom.

Navigate through time
At higher zoom levels, you can navigate to different audio content in the Editor panel.

Navigate by scrolling

Scrolling with the zoom navigator

In the zoom navigator, drag left or right.

To scroll through audio frequencies in the spectral display, drag up or down in the vertical ruler. (See View audio waveforms
and spectrums.)

Navigate with the Selection/View panel
The Selection/View panel shows the start and end of the current selection and view in the Editor panel. The panel displays this information in the
current time format, such as Decimal or Bars And Beats. (See Change the time display format.)

1. To display the Selection/View panel, choose Window > Selection/View Controls.
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2. (Optional) Enter new values into the Begin, End, or Duration boxes to change the selection or view.

Dock, group, or float panels
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Configuración de entradas y salidas de audio
Aplicación de configuración de hardware específica del equipo para los usuarios de red (Audition CS6)
Asignación de canales de archivo a entradas y salidas

Puede utilizar una amplia gama de entradas y salidas de hardware con Adobe Audition. Las entradas de la tarjeta de sonido permiten la entrada
de audio de fuentes como micrófonos, platinas y unidades de efectos digitales. Las salidas de la tarjeta de sonido le permiten monitorizar el audio
a través de fuentes como altavoces y auriculares.

A.  Las entradas de la tarjeta de sonido se conectan a fuentes como
micrófonos y platinas. B.  Las salidas de la tarjeta de sonido se conectan con altavoces y auriculares.

Configuración de entradas y salidas de audio
Cuando se configuran las entradas y las salidas para la grabación y reproducción, Adobe Audition puede utilizar este tipo de controladores de
tarjeta de sonido:

En Windows, los controladores ASIO admiten tarjetas profesionales y los controladores MME suelen admitir tarjetas estándar.

En Mac OS, los controladores CoreAudio admiten tarjetas estándar y profesionales.

Los controladores ASIO y CoreAudio son preferibles ya que proporcionan mejor rendimiento y una latencia inferior. También puede controlar el
audio mientras lo graba y escuchar instantáneamente los cambios en el volumen, la panorámica y los efectos durante la reproducción.

1. Elija Editar > Preferencias > Hardware de audio (Windows) o Adobe > Preferencias > Hardware de audio (Mac OS).
2. En el menú Clase de dispositivo, seleccione el controlador para la tarjeta de sonido que desee utilizar.
3. Seleccione Salida y Entrada predeterminada en la tarjeta.

En el Editor multipista, puede omitir los valores predeterminados para pistas específicas. Consulte Asignación de entradas
y salidas de audio a pistas.

4. (MME y CoreAudio) Para Reloj maestro, seleccione la entrada o salida en la que desee que se sincronice otro hardware de
audio digital (garantizando la correcta alineación de las muestras).

5. Para Tamaño de búfer de E/S (ASIO y CoreAudio) o Latencia (MME), especifique el ajuste más bajo posible sin eliminaciones
de audio. El ajuste ideal depende de la velocidad de su sistema, de modo que quizá deba experimentar un poco.

6. Seleccione una Velocidad de muestreo para el hardware de audio. (Para las velocidades comunes para diferentes medios de
salida, consulte Conceptos básicos sobre la velocidad de muestreo.)

7. (Opcional) Para optimizar el rendimiento de las tarjetas ASIO y CoreAudio, haga clic en Ajustes. Si desea más información,
consulte la documentación de la tarjeta de sonido.

Nota: De manera predeterminada, Adobe Audition controla la tarjeta de sonido ASIO durante la reproducción y el control de audio. Si desea
acceder a la tarjeta en otra aplicación, seleccione Liberar controlador ASIO en el fondo. (Audition aún controla la tarjeta mientras graba para evitar
que las grabaciones se detengan bruscamente.)

Aplicación de configuración de hardware específica del equipo para los usuarios de red
(Audition CS6)
En entornos de red, las preferencias de Audition se almacenan en cada cuenta de usuario. Esto crea una experiencia personalizada para cada
usuario en las preferencias de edición, interfaz, etc. Sin embargo, las preferencias de hardware de audio normalmente son consistentes en un
equipo determinado, lo que garantiza que todas las entradas y salidas de la interfaz de audio instalada estén disponibles en Audition.

1. Elija Editar > Preferencias > Hardware de audio (Windows) o Adobe > Preferencias > Hardware de audio (Mac OS).
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2. En la parte inferior de los ajustes de Hardware de audio, seleccione Utilizar valores predeterminados del dispositivo
específicos del equipo. (Anule la selección de esta opción solo si los usuarios trasladan una interfaz de audio asignada de un
equipo a otro.)

Si prefiere duplicar la configuración de hardware de un equipo a otros, busque y copie el archivo MachineSpecificSettings.xml.

Asignación de canales de archivo a entradas y salidas
1. Seleccione Editar > Preferencias > Asignación de canal de audio (Windows) o Audition > Preferencias > Asignación de canal

de audio (Mac OS).

2. En la parte más a la derecha de los elementos de las listas Entrada y Salida, haga clic en loe triángulos para elegir un puerto
de hardware para cada canal de archivo.

Este procedimiento también establece las salidas predeterminadas para la pista Maestra en el Editor multipista. Para omitir estos valores
predeterminados, consulte Asignación de entradas y salidas de audio a pistas.

Más temas de ayuda
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Personalización y almacenamiento de los ajustes de la aplicación
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Personalización de preferencias
Restauración de preferencias a ajustes predeterminados
Exportación e importación de los ajustes personalizados de la aplicación

Personalización de preferencias
El cuadro de diálogo Preferencias le permite personalizar la visualización de Adobe Audition, el comportamiento de la edición, el uso del espacio
en disco duro y otros ajustes.

 Elija Editar > Preferencias (Windows) o Audition > Preferencias (Mac OS). Después seleccione el área que desee personalizar.

Para obtener información sobre una opción concreta, sitúe el ratón sobre la misma hasta que aparezca una información indicativa.

En las preferencias de Caché de medios y de disco, elija la unidad más rápida para la carpeta temporal principal y una unidad independiente
para la carpeta temporal secundaria. Seleccione Guardar archivos de pico para almacenar información sobre cómo mostrar archivos WAV.
(Sin archivos de pico, los archivos WAV de mayor tamaño se vuelven a abrir más lentamente.)

Restauración de preferencias a ajustes predeterminados
El comportamiento inesperado puede indicar archivos de preferencias dañados. Para volver a crear los archivos de preferencias, realice lo
siguiente.

 Mantenga presionada la tecla Mayús e inicie Adobe Audition.

Exportación e importación de los ajustes personalizados de la aplicación
Los archivos de ajustes de la aplicación almacenan todas las preferencias actuales, la configuración de los efectos y los espacios de trabajo.
Exporte e importe estos archivos para almacenar grupos de ajustes personalizados para flujos de trabajo específicos o transfiera los ajustes
favoritos a otro equipo.

1. Seleccione Archivo > Exportar > Ajustes de la aplicación. A continuación especifique un nombre de archivo y ubicación.

2. Para volver a aplicar los ajustes posteriormente, seleccione Archivo > Importar > Ajustes de la aplicación.

Para importar las preferencias desde Audition 2.0 o 3.0, busque en el sistema el archivo audition_settings.xml. Puede importar ese archivo en
las versiones Mac y Windows de Audition CS.

Más temas de ayuda
Uso de marcadores

Personalización de la visualización espectral

Cambio del formato de visualización de tiempo

Desplazamiento en el tiempo y reproducción de audio
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Acerca de los espacios de trabajo
Elección de un espacio de trabajo
Acoplar, agrupar o flotar paneles
Cambio del tamaño de los grupos de paneles
Abrir o cerrar paneles y desplazarse a ellos
Trabajo con varios monitores
Muestra la barra de herramientas
Visualización de la barra de estado
Cambio del rendimiento, brillo y colores de la interfaz
Guardar, restablecer y eliminar espacios de trabajo

Acerca de los espacios de trabajo
Las aplicaciones de vídeo y audio de Adobe ofrecen un espacio de trabajo uniforme y personalizable. Aunque cada aplicación tiene su propio
conjunto de paneles (por ejemplo, Proyecto, Metadatos o Línea de tiempo), mueva y agrupe los paneles de la misma manera que lo hace en los
productos.

La ventana principal de un programa es la ventana de la aplicación. Los paneles se organizan en esta ventana en una disposición denominada
espacio de trabajo. El espacio de trabajo por defecto contiene grupos de paneles y paneles independientes.

Un espacio de trabajo se personaliza organizando los paneles en el diseño que mejor se adapta a su estilo de trabajo. A medida que se
reorganizan los paneles, los demás paneles se redimensionan automáticamente para adaptarse a la ventana. Se pueden crear y guardar varios
espacios de trabajo personalizados para diferentes tareas, por ejemplo, uno para edición y otro para previsualización.

Se pueden utilizar ventanas flotantes para crear un espacio de trabajo más parecido a los de versiones anteriores de las aplicaciones de
Adobe o para colocar paneles en varios monitores.

Espacio de trabajo de ejemplo
A.  Ventana de aplicación B.  Paneles agrupados C.  Panel individual

Elección de un espacio de trabajo
Cada aplicación de vídeo y de audio de Adobe incluye varios espacios de trabajo predefinidos que optimizan el diseño de paneles para tareas
específicas. Cuando elija uno de estos espacios de trabajo, o cualquier espacio de trabajo personalizado que haya guardado, el espacio de
trabajo actual se vuelve a dibujar de la forma correspondiente.

 Abra el proyecto sobre el que desea trabajar, elija Ventana > Espacio de trabajo y seleccione el espacio de trabajo que desee.
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Puede acoplar paneles, moverlos a un grupo o fuera de él y desacoplarlos de manera que floten encima de la ventana de la aplicación. Conforme
arrastra un panel, se resaltan las zonas de colocación a las que puede mover el panel. La zona de colocación que elige determina el lugar en el
que se inserta el panel y si se acopla o se agrupa con otros paneles.

Zonas de acoplamiento
Las zonas de acoplamiento existen a lo largo de los bordes de un panel, grupo o ventana. Al acoplar un panel se coloca junto al grupo existente,
redimensionando todos los grupos para alojar al panel nuevo.

Arrastrar el panel (A) a la zona de acoplamiento (B) para acoplarlo (C)

Zonas de agrupamiento
Las zonas de agrupamiento existen en la mitad de un panel o grupo, y en el área de ficha de paneles. Al soltar un panel en una zona de
agrupamiento, se apila con los demás paneles.

Arrastrar el panel (A) a la zona de agrupamiento (B) para agruparlo con los paneles existentes (C)

Acoplar o agrupar paneles

1. Si el panel que desea acoplar o agrupar no está visible, elíjalo en el menú Ventana.

2. Realice una de las siguientes acciones:

Para mover un panel individual, arrastre el área de agarre de la esquina superior izquierda de la ficha de un panel a la
zona de colocación deseada.
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Arrastrar el agarre del panel para mover un panel

Para mover un grupo completo, arrastre el área de agarre del grupo de la esquina superior derecha a la zona de
colocación deseada.

Arrastrar el agarre de grupo para mover todo el grupo

La aplicación acopla y agrupa el panel en función del tipo de zona de colocación.

Desacoplar un panel en una ventana flotante
Cuando desacopla un panel en una ventana flotante, puede añadir paneles a la ventana o modificarla de manera similar a como lo hace con la
ventana de la aplicación. Puede utilizar ventanas flotantes para utilizar un monitor secundario o para crear espacios de trabajo como los de
versiones anteriores de aplicaciones de Adobe.

 Seleccione el panel que desea desacoplar (si está oculto, selecciónelo en el menú Ventana) y, a continuación, realice una de las operaciones
siguientes:

Seleccione Desacoplar panel o Desacoplar fotograma en el menú del panel. El comando Desacoplar fotograma desacopla el
grupo de paneles.

Mantenga pulsada la tecla Ctrl (Windows®) o Comando (Mac OS®) y arrastre el panel o el grupo fuera de su ubicación actual.
Cuando suelte el botón del ratón, el panel o el grupo aparecerá en una nueva ventana flotante.

Arrastre el panel o el grupo fuera de la ventana de la aplicación. (Si la ventana de la aplicación se maximiza, arrastre el panel
a la barra de tareas de Windows.)

Cambio del tamaño de los grupos de paneles
Cuando coloque el puntero encima de los divisores entre grupos de paneles, aparecen los iconos de cambio de tamaño. Cuando arrastre estos
iconos, se cambiará el tamaño de todos los grupos que compartan el divisor. Por ejemplo, supongamos que el espacio de trabajo contiene tres
grupos de paneles apilados verticalmente. Si arrastra el divisor entre los dos grupos inferiores, estos se redimensionan pero el grupo superior no
cambia.

Para maximizar rápidamente un panel que se encuentra debajo del puntero, pulse la tecla de acentuación. (No pulse Mayús.) Pulse
nuevamente la tecla de acentuación para que el panel recupere su tamaño original.

1. Lleve a cabo una de las siguientes acciones:

Para cambiar el tamaño horizontal o verticalmente, coloque el puntero entre dos grupos de paneles. El puntero se
convierte en una doble flecha .
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Para cambiar el tamaño en ambas direcciones a la vez, coloque el puntero en la intersección entre tres o más grupos de

paneles. El puntero se convierte en una flecha de cuatro direcciones .

2. Mientras mantiene pulsado el botón del ratón, arrastre para redimensionar los grupos de paneles.

Arrastrar el divisor entre los grupos de paneles para redimensionarlos horizontalmente
A.  Grupo original con icono de cambio de tamaño B.  Grupos redimensionados

Abrir o cerrar paneles y desplazarse a ellos
Al cerrar un grupo de paneles en la ventana de la aplicación, se redimensionan los demás grupos para ocupar el espacio que acaba de quedar
disponible. Al cerrar una ventana flotante, también se cierran los paneles incluidos en ella.

Para abrir o cerrar un panel, selecciónelo en el menú Ventana.
Para cerrar un panel o una ventana, haga clic en su botón Cerrar .
Para ver todas las fichas de paneles en un grupo de paneles reducido, arrastre la barra de desplazamiento horizontal.
Para traer un panel al frente de un grupo de paneles, siga una de estas instrucciones:

Haga clic en la ficha del panel que desea traer al frente.

Coloque el cursor encima del área de la ficha y desplace la rueda del ratón. El desplazamiento trae al frente los paneles,
uno después de otro.

Arrastre las fichas horizontalmente para cambiar el orden.

Para mostrar los paneles ocultos en un grupo de paneles reducido, arrastre la barra de desplazamiento por encima del grupo
de paneles.

Arrastre la barra de desplazamiento horizontal para ver todos los paneles en un grupo reducido

Trabajo con varios monitores
Para aumentar el espacio de pantalla disponible, utilice varios monitores. Cuando se trabaja con varios monitores, la ventana de la aplicación
aparece en un monitor y se colocan ventanas flotantes en el segundo monitor. Las configuraciones del monitor se almacenan en el espacio de
trabajo.
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Muestra la barra de herramientas
La barra de herramientas proporciona un acceso rápido a las herramientas, el menú Espacio de trabajo y los botones que se alternan entre los
editores multipista y de forma de onda. Algunas herramientas son únicas para cada vista. Del mismo modo, algunas herramientas del Editor de
forma de onda se encuentran disponibles solo en la visualización espectral.

De forma predeterminada, la barra de herramientas se coloca justo debajo de la barra de menús. Sin embargo, puede desacoplar la barra de
herramientas y convertirla en el panel Herramientas, que se puede manipular igual que cualquier otro panel.

Para mostrar u ocultar la barra de herramientas, seleccione Ventana > Herramientas. Una marca de verificación junto al
comando Herramientas indica que es visible.
Para desacoplar la barra de herramientas de su ubicación predeterminada, arrastre el control del borde izquierdo hasta otra
ubicación en el espacio de trabajo.
Para reacoplar el panel Herramientas en su ubicación predeterminada, arrastre la ficha del mismo hasta la zona de colocación
que abarca todo el ancho de la ventana Adobe Audition, justo debajo de la barra de menú.

Las herramientas disponibles difieren en cada vista.
A.  Herramientas del Editor de forma de onda para visualización espectral B.  Herramientas del Editor multipista

Visualización de la barra de estado
La barra de estado se encuentra en la parte inferior del área de trabajo de Adobe Audition. La parte más a la izquierda de la barra de estado
indica el tiempo necesario para abrir, guardar o procesar un archivo, así como el estado de transporte actual (Reproduciendo, Grabando o
Detenida). La parte más a la derecha de la barra muestra diversa información que se puede personalizar.

Barra de estado
A.  Tiempo para abrir, guardar o procesar el archivo B.  Velocidad de fotograma de vídeo C.  Estado del archivo D.  Tipo de muestra E.
Tamaño de audio sin comprimir F.  Duración G.  Espacio libre H.  Detectar muestras eliminadas

Para mostrar u ocultar la barra de estado, seleccione Vista > Barra de estado > Mostrar. Una marca de verificación indica que
la barra de estado está visible.
Para cambiar la información que se muestra en la parte más a la derecha de la barra, seleccione Ver > Barra de estado, o
bien, haga clic en la barra. Después elija una de las siguientes opciones:
Velocidad de fotograma de vídeo Muestra la velocidad de fotogramas actual y de destino de los archivos de vídeo abiertos
en el Editor multipista.

Estado del archivo Indica el momento en que sucede el procesamiento para los ajustes de amplitud y los efectos.

Tipo de muestra Visualiza la información de muestra acerca de la forma de onda abierta actualmente (Editor de forma de
onda) o del archivo de sesión (Editor multipista). Por ejemplo, un archivo estéreo de 16 bits a 44,100 Khz se muestra como
estéreo 44100 Hz • 16 bits •.

Tamaño de audio sin comprimir Indica qué tamaño tendría el archivo de audio activo si se guardara en un formato sin
comprimir como, por ejemplo, WAV y AIFF, o el tamaño total de una sesión multipista.

Duración Muestra la longitud de la forma de onda o de la sesión actual. Por ejemplo, 0:01:247 significa una forma de onda o
sesión de 1,247 segundos de longitud.

Espacio libre Muestra la cantidad de espacio disponible en el disco duro.

Espacio libre (tiempo) Muestra el tiempo restante para la grabación, en función de la velocidad de muestro seleccionada
actualmente. Este valor aparece como minutos, segundos y milésimas de segundo. Por ejemplo, si Adobe Audition está
ajustado para grabar audio mono de 8 bits a 11.025 Hz, el tiempo restante puede leerse como 4399:15.527 libre. Si cambia
las opciones de grabación a 16 bits estéreo a 44.100 Hz, el tiempo restante pasará a ser 680:44.736 libre.

De forma predeterminada, se oculta la información de Espacio libre (tiempo). Para mostrarla, haga clic con el botón
derecho en la barra de estado y seleccione Espacio libre (tiempo) en el menú desplegable.

Detectar muestras eliminadas Indica que no había muestras durante la grabación o la reproducción. Si aparece este
indicador, considere la nueva grabación del archivo para evitar exclusiones sonoras.
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Cambio del rendimiento, brillo y colores de la interfaz
1. Seleccione Editar > Preferencias > Aspecto (Windows) o Audition > Preferencias > Aspecto (Mac OS).

2. Ajuste una de las opciones siguientes y haga clic en Aceptar:
Ajustes preestablecidos Aplica, guarda y elimina una combinación de ajustes de colores y brillo.

Colores Haga clic en una muestra para cambiar el color de las formas de onda, selecciones o el indicador de tiempo
actual.

Brillo Ilumina u oscurece los paneles, las ventanas y los cuadros de diálogo.

Utilizar degradados Cuando se anula su selección, se eliminan las sombras y los resaltes de los paneles, botones y
medidores.

Guardar, restablecer y eliminar espacios de trabajo

Guardado de un espacio de trabajo personalizado
Conforme personaliza un espacio de trabajo, la aplicación realiza un seguimiento de los cambios, almacenando el diseño más reciente. Para
almacenar un diseño específico de manera más permanente, guarde un espacio de trabajo personalizado. Los espacios de trabajo
personalizados guardados aparecen en el menú Espacio de trabajo, adonde puede regresar y restaurarlos.

 Organice los fotogramas y paneles como desee y, a continuación, elija Ventana > Espacio de trabajo > Nuevo espacio de trabajo. Introduzca
un nombre para el espacio de trabajo y haga clic en Aceptar (Windows) o en Aceptar (Mac OS).

Nota: (After Effects, Premiere Pro, Encore) Si un proyecto guardado con un espacio de trabajo personalizado se abre en otro sistema, la
aplicación busca un espacio de trabajo con el mismo nombre. Si no encuentra una coincidencia (o la configuración del monitor no coincide), utiliza
el espacio de trabajo local actual.

Restauración de un espacio de trabajo
Restaure el espacio de trabajo actual para regresar a su diseño original, guardado, de paneles.

 Elija Ventana > Espacio de trabajo > Restablecer nombre de espacio de trabajo.

Eliminación de un espacio de trabajo

1. Seleccione Ventana > Espacio de trabajo > Eliminar espacio de trabajo.

2. Elija el espacio de trabajo que desee eliminar y a continuación, haga clic en Aceptar.

Nota: no puede eliminar el espacio de trabajo activo actualmente.

Más temas de ayuda
Comparación de los editores Forma de onda y Multipista
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Formatos de importación compatibles
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Nota:

Formatos de importación de audio
Formatos de importación de vídeo

Formatos adicionales de importación de vídeo en Audition CS6

Formatos de importación de audio
Adobe Audition puede abrir archivos de audio en los siguientes formatos:

AAC (incluido HE-AAC en Audition CS6)
AIF, AIFF, AIFC (incluyendo archivos con hasta 32 canales)

Existen diversas variaciones del formato AIFF. Audition puede abrir todos los archivos AIFF sin comprimir y la mayoría de versiones comprimidas
más comunes.

Para ver los metadatos de Autor en archivos AIFF, consulte el campo Dublin Core: Creador de la ficha XMP del panel Metadatos.
(Consulte Visualización y edición de metadatos XMP.)

APE (Audition CS6)
AU
AVR
BWF
CAF (todas las versiones sin comprimir y la mayoría de versiones comprimidas)
FLAC
HTK
IFF
M4A
MAT
MPC
MP2
MP3 (incluidos archivos de sonido envolvente MP3)
OGA, OGG
PAF
PCM
PVF
RAW
RF64
SD2
SDS
SF
SND
VOC
VOX
W64
WAV (incluyendo archivos con hasta 32 canales)

Existen diferentes variaciones del formato WAV. Adobe Audition puede abrir todos los archivos WAV sin comprimir y la mayoría de versiones
comprimidas más comunes.

WMA (habilitado con compatibilidad con el formato DLMS en las preferencias de caché de medios y de disco)
WVE
XI
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Volver al principioFormatos de importación de vídeo
El Editor de forma de onda permite abrir la parte de audio de los archivos de vídeo en los siguientes formatos. El Editor multipista permite insertar
los mismos tipos de archivo y proporciona una previsualización en el panel Vídeo.

Para acceder a estos formatos de vídeo, se debe instalar QuickTime. Para importar formatos adicionales, amplíe la compatibilidad con
QuickTime. Para obtener más información, consulte este artículo en el sitio Web de Apple.

AVI
DV
MOV (incluyendo archivos con hasta 32 canales de audio)
MPEG-1
MPEG-4
3GPP y 3GPP2

Formatos adicionales de importación de vídeo en Audition CS6
MPEG-2 (si está instalado CS6 Production Premium o Master Collection)

Para activar los siguientes formatos, seleccione Habilitar compatibilidad con formato DLMS en las preferencias de Caché de medios y de disco.
(Esta opción está desactivada de forma predeterminada para obtener el máximo rendimiento.)

AVI (solo para Windows)
FLV
R3D
SWF
WMV

Inserción de un archivo de vídeo en una sesión multipista

Exportación de una mezcla multipista a Premiere Pro CS5.5

http://creativecommons.org/licenses/by-nc-sa/3.0/deed.es_GT
http://help.adobe.com/es_ES/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_es
http://www.adobe.com/go/learn_audition_qtformats_es


Navigating time and playing audio

Note:

To the top

To the top

Pause

Monitoring time
Position the current-time indicator
Preview audio by scrubbing
Play audio linearly or in a loop
Synchronize the current-time indicator across files or views
Change the time display format

Some features in the Windows version of Adobe Audition 3.0 are not available in CS5.5. Examples include CD burning, MIDI, the
metronome, some file formats and effects, clip grouping and time stretching, and control surface support. For a complete list, see Adobe Audition
3.0 features replaced or not implemented in CS5.5.

Monitoring time
In the Editor panel, the following features help you monitor time:

In the timeline near the top of the panel, the current-time indicator  lets you start playback or recording at a specific point.

In the lower left of the panel, the time display shows the current time in numerical format. The default time format is Decimal,
but you can easily change it. (See Change the time display format.) The same format is used by the timeline.

To show the time display in separate panel, choose Window > Time.

Features that help you monitor time 
A. Current-time indicator  B. Timeline  C. Time display 

Position the current-time indicator

In the Editor panel, do any of the following:

In the timeline, drag the indicator  or click a specific time point.

In the time display at lower left, drag across the numbers, or click to enter a specific time.

At the bottom of the panel, click one of the following buttons:

To display these buttons in a separate panel, choose Window > Transport.

 Temporarily stops the current-time indicator. Click the Pause button again to resume playback or recording.

http://kb2.adobe.com/cps/895/cpsid_89588.html
http://kb2.adobe.com/cps/895/cpsid_89588.html
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/es-es/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/es-es/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/


Move CTI to Previous

Rewind

Fast Forward

Move CTI to Next

To the top

To the top

Return CTI to Start Position on Stop

Play Spectral Selection Only

Note:

To the top

 Places the current-time indicator at the beginning of the next marker. If there are no markers,
the current-time indicator moves to the beginning of the waveform or session.

 Shuttles the current-time indicator backward in time.

Right-click the Rewind button to set the rate at which the cursor moves.

 Shuttles the current-time indicator forward in time.

Right-click the Fast Forward button to set the rate at which the cursor moves.

 Moves the current-time indicator to the next marker. If there are no markers, the current-time
indicator moves to the end of the waveform or session.

Preview audio by scrubbing
To scrub audio (producing an audible preview as you shuttle across a file), do any of the following:

Drag the current-time indicator .

Press the Rewind  or Fast Forward  buttons.

Press the J, K, and L keys to shuttle backward, stop, or shuttle forward. Repeatedly pressing the J or L key gradually increases
shuttle speed. (To change the default, set JKL Shuttle Speed in the Playback preferences.)

Play audio linearly or in a loop
To quickly start and stop playback, press the spacebar.

1. In the Editor panel, position the current-time indicator, or select a range.

2. (Optional) At the bottom of the panel, right-click the Play button , and select one of the following:

Reflects the behavior of Audition 3.0 and earlier. (Press Shift+X to toggle this option
on and off.)

Plays only frequencies you’ve selected with the Marquee , Lasso , or Paintbrush

Selection  tool.

3. (Optional) Click the Loop Playback button  if you want to fine-tune a selected range or experiment with different effects
processing.

4. To start playback, click the Play button.

By default, the Editor panel scrolls when playback extends beyond the visible section of a waveform. In the Playback area of the
Preferences dialog box, you can disable auto-scrolling.

Synchronize the current-time indicator across files or views

In the Waveform Editor, you can maintain the position of the current-time indicator when you switch between files—a useful technique when editing
different versions of the same waveform. In the Multitrack Editor, you can maintain the position of the current-time indicator when you switch to the
Waveform Editor—a useful technique when applying edits and effects in both views.

Synchronize the current-time indicator between files in the Waveform Editor

1. Choose Edit > Preferences > General (Windows) or Adobe Audition Preferences > General (Mac OS).

http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/es-es/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/es-es/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/es-es/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/es-es/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
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Decimal (mm:ss.ddd)

Compact Disc 75 fps

SMPTE 30 fps

SMPTE Drop (29.97 fps)

SMPTE 29.97 fps

SMPTE 25 fps (EBU)

SMPTE 24 fps (Film)

Samples

Bars and Beats

Custom (X frames per second)

2. Select Synchronize Selection, Zoom Level, and CTI Across Files In The Waveform Editor.

Synchronize the current-time indicator between the Multitrack and Waveform Editors

1. Choose Edit > Preferences > Multitrack (Windows) or Adobe Audition Preferences > Multitrack (Mac OS).

2. Select Synchronize Clips With Waveform Editor.

Change the time display format
By default, all audio files and multitrack sessions use the same time display format. To customize the format for an open file or session, choose
Window > Properties, expand the Advanced settings, and deselect Synchronize With Time Display Preferences.

Choose View > Display Time Format, and choose the desired option:

Displays time in minutes, seconds, and thousandths of a second.

Displays time in the same format used by audio compact discs, where each second equals 75 frames.

Displays time in the SMPTE format, where each second equals 30 frames.

Displays time in the SMPTE drop-frame format, where each second equals 29.97 frames.

Displays time in the SMPTE non-drop-frame format, where each second equals 29.97 frames.

Displays time using the European PAL television frame rate, where each second equals 25 frames.

Displays time in a format where each second equals 24 frames, suitable for film.

Displays time numerically, using as a reference the actual number of samples that have passed since the beginning
of the edited file.

Displays time in a musical measures format of bars:beats:subdivisions. To customize settings, choose Edit
Tempo, and set the following options in the Properties panel:

Tempo

Specifies beats per minute.

Time Signature

Specifies the number of beats per measure, and the note that represents full beats. For example, with a signature of 3/8, there
are three notes per measure, and eighth-notes represent full beats.

Subdivisions

Specifies the number of sections each beat is divided into, or the value after the decimal point. For example, if you enter 32
subdivisions per beat, a time setting of 4:2:16 represents an eighth note halfway between beats 2 and 3 in 4/4 time.

Displays time in a custom format. To modify a custom format, choose Edit Custom Frame
Rate, and enter a number of frames per second. Valid values are whole numbers from 2 to 1000.

Customize start offset and time display for multitrack sessions

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/en_US/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/es-es/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/es-es/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/es-es/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/es-es/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/es-es/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/es-es/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/es-es/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/es-es/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/es-es/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/es-es/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/


Importing with the Files panel

  Twitter™ and Facebook posts are not covered under the terms of Creative Commons.

Legal Notices   |   Online Privacy Policy

To the top

To the top

To the top

Import files into the Files panel
Insert from the Files panel into a multitrack session
Change displayed metadata in the Files panel

The Files panel displays a list of open audio and video files for easy access.

Double-click an empty area of the file list to quickly access the Open File dialog box.

Import files into the Files panel
Import files into the Files panel if you want to retain the currently open file in the Editor panel. This technique is particularly helpful when
assembling files for a multitrack session.

1. Do either of the following:

In the Files panel, click the Import File button .

Choose File > Import > File.

2. Select an audio or video file. (See Supported import formats.)

Insert from the Files panel into a multitrack session
1. In the Files panel, select the files you want to insert.

To select multiple adjacent files, click the first file in the desired range, and then Shift-click the last. To select nonadjacent
files, Ctrl-click (Windows) or Command-click (Mac OS).

2. At the top of the Files panel, click the Insert Into Multitrack button . Then choose either New Multitrack Session (see
Create a new multitrack session) or an open session.

The files are inserted on separate tracks at the current time position.

Change displayed metadata in the Files panel
1. In the upper right of the Files panel, click the menu icon , and choose Metadata Display.
2. Select the metadata you want to display, and click OK
3. To move metadata columns left or right, drag column headers such as Name or Duration.

To change the sort order of files, click column headers.
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Nota:

Extracción de pistas de CD con el comando Extraer audio desde CD
Configuración de información de pistas y bases de datos de CD (Audition CS6)

Extracción de pistas de CD con el comando Abrir (Mac OS)

Extracción de pistas de CD con el comando Extraer audio desde CD
El comando Extraer audio desde CD es más rápido y proporciona más control, incluyendo la capacidad para optimizar la velocidad de unidad y
cambiar el nombre de las pistas.

1. Coloque un CD de audio en la unidad de CD-ROM del equipo.
2. Seleccione Archivo > Extraer audio desde CD.
3. Para Unidad, seleccione la unidad que contenga el CD de audio.
4. Para Velocidad, seleccione entre todas las velocidades de extracción que admite la unidad seleccionada. La opción de

velocidad máxima suele producir resultados satisfactorios, pero en caso de producir errores, especifique una velocidad
menor.

5. Realice cualquiera de las acciones siguientes:
Para previsualizar una pista, haga clic en su botón Reproducir.

Para incluir o excluir pistas, active las casillas de verificación situadas a la izquierda de los números de pista o haga clic
en Conmutar todo.

Para cambiar el nombre de una pista, haga doble clic sobre ella.

Configuración de información de pistas y bases de datos de CD (Audition CS6)
En el centro del cuadro de diálogo Extraer audio desde CD, la información de Artista, Álbum, Género y Año se obtiene de forma predeterminada
desde la base de datos de CD especificada. Para ajustar estas entradas, realice cualquiera de las acciones siguientes:

Para personalizar información, sobrescriba las entradas actuales.
Para insertar la información original de la base de datos, haga clic en el icono Recuperar títulos .
Si aparece un mensaje que indica que varios registros coinciden, haga clic en las flechas para insertar diferentes registros de
la base de datos.
Para especificar una base de datos y convención de nomenclatura diferentes, haga clic en el icono Ajustes de título . Para
obtener más detalles sobre cada opción de Ajustes de título, coloque el ratón sobre la misma hasta que aparezca la
información sobre herramienta.

Nota: si se detectan varias entradas de Artista, Audition selecciona automáticamente la opción Compilación. En el cuadro de diálogo Ajustes de
título, introduzca un carácter Separador para compilaciones para separar Artista y Título de pista para cada pista.

Extracción de pistas de CD con el comando Abrir (Mac OS)
Este método de extracción puede reducir significativamente el rendimiento de Audition. El comando Extraer audio desde CD suele ser la

mejor elección.

El comando Abrir permite extraer las pistas en formato AIFF pero requiere que Audition continúe leyendo datos de audio desde el CD,
ralentizando la importación y la edición.

1. Coloque un CD de audio en la unidad de CD-ROM del equipo.
2. Seleccione Archivo > Abrir.
3. Seleccione QuickTime como tipo de archivo y desplácese a la unidad de CD-ROM.
4. Seleccione las pistas que desee extraer y haga clic en Abrir.
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Supervisión de los niveles de grabación y reproducción
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Descripción general de los limnímetros
Personalización de los limnímetros
Ajuste de los niveles de grabación de las tarjetas de sonido estándar

Descripción general de los limnímetros
Para supervisar la amplitud de las señales entrantes y salientes durante la grabación y la reproducción, se utilizan los limnímetros. El Editor de
forma de onda proporciona estos metros únicamente en el panel Niveles. El Editor multipista los proporciona tanto en el panel Niveles, que
muestra la amplitud de una sesión completa, como en los medidores de pista, que muestran la amplitud de pistas individuales.

Puede acoplar el panel Niveles horizontal o verticalmente. Cuando el panel se acopla horizontalmente, el medidor superior representa el canal
izquierdo y el inferior el derecho.

Para mostrar u ocultar el panel, seleccione Ventana > Limnímetros.

Panel Niveles, acoplado horizontalmente.
A.  Canal izquierdo B.  Canal derecho C.  Indicadores de pico D.  Indicadores de clip

Los medidores muestran niveles de señal en dBFS (decibelios bajo escala completa), donde un nivel de 0 dB es la amplitud máxima posible antes
de que se produzca un recorte. Los indicadores de pico amarillos permanecen durante 1,5 segundos para que pueda determinar la amplitud de
pico fácilmente.

Si la amplitud es demasiado baja, la calidad del sonido se reduce, si la amplitud es demasiado alta, se produce un recorte que provoca distorsión.
El indicador de clip rojo a la derecha de los medidores se ilumina cuando los niveles sobrepasan un máximo de 0 dB.

Para borrar los indicadores de clip, haga clic en los mismos de forma individual, o bien, haga clic con el botón derecho en los medidores y
seleccione Restablecer indicadores.

Personalización de los limnímetros
Haga clic con el botón derecho en los medidores y selección cualquiera de las siguientes opciones:

Señal de entrada de medidor En el Editor de forma de onda, muestra el nivel de la entrada de hardware predeterminada. (Consulte
Configuración de entradas y salidas de audio.) Para habilitar o deshabilitar rápidamente esta opción, haga doble clic en los limnímetros.
Opciones de rango Cambia el rango de decibelios mostrado.
Mostrar valles Muestra los indicadores de valle en los puntos de poca amplitud.

Si los indicadores de valle se encuentran cerca de los indicadores de pico, el rango dinámico (la diferencia entre los sonidos más altos y los
más bajos) es bajo. Si hay mucha separación entre los indicadores, el rango dinámico es alto.

Mostrar degradado de color Gradualmente cambia los medidores de verde a amarillo y a rojo. Anule la selección de esta opción para mostrar
cambios bruscos de color de amarillo a -18 dBFS y rojo a -6.
Mostrar medidores LED Muestra una barra independiente para cada nivel de decibelio completo.
Picos estáticos y dinámicos Cambia el modo de los indicadores de pico. Los Picos dinámicos restablecen los indicadores de nivel de pico
amarillos en un nuevo nivel de pico tras 1,5 segundos, permitiendo ver una amplitud de pico reciente de forma rápida. Conforme el audio va
bajando de volumen, los indicadores de pico se alejan. Los Picos estáticos mantienen los indicadores de pico, permitiendo determinar la amplitud
máxima de la señal desde el momento en que comienza la supervisión, la reproducción o la grabación. Sin embargo, se pueden seguir
restableciendo manualmente los indicadores de pico haciendo clic en los indicadores de clip.

Para saber cómo será de alto el volumen del audio antes de grabarlo, seleccione Picos estáticos. Después controle los niveles de entrada; los
indicadores de pico muestran el nivel de la parte más alta.

Ajuste de los niveles de grabación de las tarjetas de sonido estándar
Ajuste los niveles si las grabaciones resultan demasiado bajas (crean ruido no deseado) o demasiado altas (crean distorsiones). Para obtener los
mejores resultados de sonido, grabe el audio al volumen más alto posible sin recortes. Cuando se establezcan los niveles de grabación, observe
los medidores e intente conservar los picos más altos a menos de -3 dB en el rango amarillo

Adobe Audition no controla directamente los niveles de grabación de una tarjeta de sonido. Con una tarjeta de sonido profesional, puede ajustar



 

los niveles mediante la aplicación de mezcla de la propia tarjeta (consulte la documentación de la tarjeta para obtener instrucciones). Con las
tarjetas de sonido estándar puede utilizar la aplicación de mezcla de los sistemas operativos Windows o Mac OS.

Ajuste de los niveles de la tarjeta de sonido en Windows 7 y Vista

1. Haga clic con el botón derecho en el icono del altavoz de la barra de tareas y seleccione Dispositivos de grabación.

2. Haga doble clic en el origen de entrada que desee utilizar.

3. Haga clic en la ficha Niveles y ajuste el regulador según sea necesario.

Ajuste de los niveles de la tarjeta de sonido en Windows XP

1. Haga doble clic en el icono del altavoz en la barra de tareas.

2. Elija Opciones > Propiedades.

3. Seleccione Grabación y, a continuación, haga clic en Aceptar.

4. Seleccione el origen de entrada que desee utilizar y ajuste el control deslizante de Volumen según sea necesario.

Ajuste de los niveles de la tarjeta de sonido en Mac OS

1. Elija Preferencias del sistema del menú Apple.

2. Haga clic en Sonido y, a continuación, en la ficha Entrada.

3. Seleccione el dispositivo que desee utilizar y ajuste el control deslizante de Volumen de entrada según sea necesario.

  |  
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Grabación de audio en el Editor de forma de onda
Corrección del desplazamiento de DC
Grabación directa en archivo en el Editor multipista
Grabación de clips de audio en el Editor multipista
Perforación en un rango determinado en el Editor multipista
Perforación durante una reproducción en el Editor multipista
Selección de tomas perforadas

Nota: Algunas de las funciones de la versión para Windows de Adobe Audition 3.0 no están disponibles en CS5.5. Por ejemplo, la grabación
temporizada, la grabación de CDs, MIDI, el metrónomo, algunos formatos de archivo y efectos, así como la compatibilidad con la superficie de
control. Para obtener una lista completa, consulte Funciones de Adobe Audition 3.0 reemplazadas o no implementadas en CS5.5.

Grabación de audio en el Editor de forma de onda
Se puede grabar audio desde un micrófono o cualquier dispositivo que pueda conectar al puerto de entrada de línea de una tarjeta de sonido.
Antes de grabar, puede que necesite ajustar la señal de entrada para optimizar los niveles de señal/ruido. (Consulte Ajuste de los niveles de
grabación de las tarjetas de sonido estándar o la documentación para una tarjeta profesional.)

1. Establezca las entradas de audio. (Consulte Configuración de entradas y salidas de audio.)
2. Realice una de las acciones siguientes:

Cree un archivo nuevo.

Abra un archivo existente para sobrescribir o agregar audio nuevo y coloque el indicador de tiempo actual  donde
desee comenzar la grabación.

3. En la parte inferior del panel Editor, haga clic en el botón Grabar  para iniciar o detener la grabación.

Corrección del desplazamiento de DC
Algunas tarjetas de sonido graban con un ligero desplazamiento de DC, por lo que se introduce corriente directa en la señal, haciendo que el
centro de la forma de onda se desplace desde el punto cero (la línea central de la visualización de forma de onda). El desplazamiento de DC
puede provocar un chasquido o una detonación al principio y al final de un archivo.

 En el Editor de forma de onda, seleccione Favoritos > Reparar desplazamiento de DC.
Para medir el desplazamiento de DC, consulte Análisis de amplitud.

Grabación directa en archivo en el Editor multipista
En el Editor multipista, Adobe Audition graba automáticamente cada clip grabado directamente en un archivo WAV. La grabación directa en
archivo permite grabar y guardar rápidamente varios clips, ofreciendo una gran flexibilidad.

Dentro de la carpeta de la sesión, encontrará cada clip grabado en la carpeta [nombre de sesión]_Grabada. Los nombres de archivo de clip
comienzan con un nombre de pista, seguido del número de captura (por ejemplo, Pista 1_003.wav).

Tras la grabación, podrá editar las tomas para producir una mezcla final perfeccionada. Por ejemplo, si crea varias tomas de un solo de guitarra,
podrá combinar las mejores secciones de cada solo. (Consulte Recorte y ampliación de clips.) O podrá utilizar una versión del solo para una
banda sonora de vídeo y otra versión para un CD de audio.

Grabación de clips de audio en el Editor multipista
En el Editor multipista, puede grabar audio en varias pistas mediante predoblaje. Cuando se doblan previamente las pistas, se escuchan pistas
grabadas anteriormente y se manipulan para crear sofisticadas composiciones a capas. Cada grabación se convierte en un nuevo clip de audio
de una pista.

1. En el área Entradas/Salidas del panel Editor, seleccione un origen de un menú de entrada de pista.
Nota: Para cambiar las entradas disponibles, seleccione Hardware de audio y, a continuación, haga clic en Ajustes.

2. Haga clic en el botón Preparar para grabar  de la pista.
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Los medidores de pista muestran la entrada, ayudando a optimizar los niveles. (Para desactivar este valor predeterminado y
mostrar los niveles solo durante la grabación, anule la selección de Activar medida de entrada cuando se preparen las pistas
en las preferencias de Multipista.)

3. Para escuchar las entradas de hardware enrutadas mediante cualquier envío y efecto de pista, haga clic en el botón Controlar
entrada .
Nota: El enrutamiento de entradas mediante efectos y envíos requiere un procesamiento importante. Para reducir la latencia
(retardo audible) que interrumpe la sincronización de los intérpretes, consulte Configuración de entradas y salidas de audio.

4. Para grabar simultáneamente en varias pistas, repita los pasos 1-3.

5. En el panel Editor, coloque el indicador de tiempo actual  en el punto de inicio que desee o seleccione un rango para el
nuevo clip.

6. En la parte inferior del panel, haga clic en el botón Grabar  para iniciar y detener la grabación.

Perforación en un rango determinado en el Editor multipista
Si no está satisfecho con un intervalo de tiempo de un clip grabado, podrá seleccionar ese intervalo y “perforar” en una nueva grabación, dejando
el clip original intacto. Aunque puede grabar en un rango determinado sin tener que perforar, perforar permite escuchar audio inmediatamente
antes y después de un rango; ese audio ofrece contexto que ayuda a crear transiciones naturales.

Para secciones especialmente importantes o difíciles, se puede perforar en varias tomas y, a continuación, seleccionar o editar tomas para
obtener el mejor rendimiento.

Una toma creada mediante perforación

1. En el panel Editor, arrastre la Herramienta de selección de tiempo  en la pista adecuada para seleccionar un intervalo de
tiempo para el clip.

2. Seleccione la entrada de pista correcta. (Consulte Asignación de entradas y salidas de audio a pistas.)

3. Haga clic en el botón Preparar para grabar  de la pista.

4. Coloque el indicador de tiempo actual  unos segundos antes del rango seleccionado.

5. En la parte inferior del panel Editor, haga clic en el botón Grabar .

Audition reproduce el audio que precede a la selección, graba la duración del rango seleccionado y posteriormente reanuda la reproducción.

Perforación durante una reproducción en el Editor multipista
Si no necesita perforar en un rango determinado, podrá perforar rápidamente en un área general durante la reproducción.

1. Habilite una o más pistas para grabar. (Consulte Grabación de clips de audio en el Editor multipista.)

2. En la parte inferior del panel Editor, haga clic en el botón Reproducir .

3. Cuando alcance un área en la que desee comenzar a grabar, haga clic en el botón Grabar . Cuando termine, haga clic
de nuevo en el botón.

Selección de tomas perforadas
Si perfora en varias tomas, Audition coloca las tomas una encima de la otra en el panel Editor. Para elegir entre tomas, haga lo siguiente:

1. Con la herramienta Selección de tiempo , seleccione un rango que se ajuste al inicio y al final de las tomas perforadas.
(Consulte Ajuste para recortar los puntos finales.)

http://helpx.adobe.com/en/audition/using/arranging-editing-multitrack-clips.html#snap_to_clip_endpoints


 

2. En la pista, coloque el ratón sobre el encabezado del clip. (El encabezado muestra el nombre de la pista, seguido por el
número de toma.)

3. Arrastre la toma superior a una ubicación distinta (normalmente al final de la sesión para evitar la reproducción no deseada).
4. Reproduzca la sesión. Si prefiere una toma que haya movido, vuelva a arrastrarla hasta el rango seleccionado.

Para silenciar el clip original durante todo el intervalo de perforación, ajuste el envolvente de volumen. (Consulte Automatización de ajustes de
clip.)

Más temas de ayuda
Creación de un nuevo archivo de audio en blanco

Colocación del indicador de tiempo actual

  |  

http://helpx.adobe.com/en/audition/using/automating-mixes-envelopes1.html#automating_clip_settings
http://helpx.adobe.com/en/audition/using/automating-mixes-envelopes1.html#automating_clip_settings
http://helpx.adobe.com/en/audition/using/creating-opening-files.html#create_a_new_blank_audio_file
http://helpx.adobe.com/en/audition/using/navigating-time-playing-audio.html#position_the_current_time_indicator
http://creativecommons.org/licenses/by-nc-sa/3.0/


Edición de archivos de audio

Parte del contenido vinculado a esta página puede estar solo en inglés.



Copying, cutting, pasting, and deleting audio
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Copied and Existing Audio

Invert Copied Audio

Modulate

Crossfade
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Copy or cut audio data
Paste audio data
Mix audio data when pasting
Delete or crop audio

Some features in the Windows version of Adobe Audition 3.0 are not available in CS5.5. Examples include Audition-specific clipboards, CD
burning, MIDI, the metronome, some file formats and effects, and control surface support. For a complete list, see Adobe Audition 3.0 features
replaced or not implemented in CS5.5.

Copy or cut audio data
1. In the Waveform Editor, select the audio data you want to copy or cut. Or, to copy or cut the entire waveform, deselect all

audio data.
2. Choose one of the following:

Edit > Copy to copy audio data to the clipboard.

Edit > Copy To New to copy and paste the audio data into a newly created file.

Edit > Cut to remove audio data from the current waveform and copy it to the clipboard.

Paste audio data
Do either of the following:

To paste audio into the current file, place the current-time indicator  where you want to insert the audio or select existing
audio you want to replace. Then choose Edit > Paste.

To paste audio data into a new file, choose Edit > Paste To New. The new file automatically inherits the sample type (rate
and bit depth) from the original clipboard material.

Mix audio data when pasting
The Mix Paste command mixes audio data from the clipboard with the current waveform.

1. In the Editor panel, place the current-time indicator  where you want to start mixing the audio data. Alternately, select the
audio data you want to replace.

2. Choose Edit > Mix Paste.
3. Set the following options:

Adjust the percentage of each.

Reverses the phase of copied audio, either exaggerating or reducing phase cancellation if the existing
audio contains similar content. (To understand phase cancellation, see How sound waves interact.)

Modulates the amount of copied and existing audio, producing more audible variation.

Applies a crossfade to the beginning and end of the pasted audio, producing smoother transitions. Specify the
fade length in milliseconds.

Delete or crop audio
Do one of the following:

Select audio you want to delete, and choose Edit > Delete.

Select audio you want to keep, and choose Edit > Crop. (Unwanted audio at the beginning and end of the file is removed.)

Convert a waveform between surround, stereo, and mono

Channel Mixer effect
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Displaying audio in the Waveform Editor

To the top

To the top

View audio waveforms and spectrums
About the waveform display
About the spectral display
View layered or uniquely colored waveform channels
Customize the spectral display
Change the vertical scale

View audio waveforms and spectrums
In the Waveform Editor, the Editor panel provides a visual representation of sound waves. Below the panel’s default waveform display, which is
ideal for evaluating audio amplitude, you can view audio in the spectral display, which reveals audio frequency (low bass to high treble).

To view the spectral display, do either of the following:.
In the toolbar, click the Spectral Display  button.

In the Editor panel, drag the divider between the waveform and spectral displays to change the proportion of each. To
instantly show or hide the spectral display, double-click the handle or click the triangle to its right.

Viewing the waveform and spectral displays 
A. Drag the divider to change the proportion of each. B. Click the triangle to show or hide the spectral display. 

To identify specific channels in stereo and 5.1 surround files, note the indicators in the vertical ruler.

About the waveform display
The waveform display shows a waveform as a series of positive and negative peaks. The x-axis (horizontal ruler) measures time, and the y-axis
(vertical ruler) measures amplitude—the loudness of the audio signal. Quiet audio has both lower peaks and lower valleys (near the center line)
than loud audio. You can customize the waveform display by changing the vertical scale and colors.

With its clear indication of amplitude changes, the waveform display is perfect for identifying percussive changes in vocals, drums, and more. To
find a particular spoken word, for example, simply look for the peak at the first syllable and the valley after the last.

Stereo file in waveform display



To the top
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Windowing Function

Spectral Resolution

About the spectral display
The spectral display shows a waveform by its frequency components, where the x-axis (horizontal ruler) measures time and the y-axis (vertical
ruler) measures frequency. This view lets you analyze audio data to see which frequencies are most prevalent. Brighter colors represent greater
amplitude components. Colors range from dark blue (low-amplitude frequencies) to bright yellow (high-amplitude frequencies).

The spectral display is perfect for removing unwanted sounds, such as coughs and other artifacts.

Spectral display, with high frequencies selected

View layered or uniquely colored waveform channels
For stereo and 5.1 surround files, you can view layered or uniquely colored channels. Layered channels better reveal overall volume changes.
Uniquely colored channels help you visually distinguish them.

Choose View > Waveform Channels, and then select Layered or Uniquely Colored.

Channel View options 
A. Uniquely Colored B. Layered (with Uniquely Colored still selected) 

Customize the spectral display
The Spectral Display preferences help you enhance different details and better isolate artifacts.

1. Choose Edit > Preferences > Spectral Display (Windows) or Audition > Preferences > Spectral Display (Mac OS).

2. Set the following options

Determines the Fast Fourier transform shape. These functions are listed in order from narrowest to
widest. Narrower functions include fewer surrounding frequencies but less precisely reflect center frequencies. Wider functions
include more surrounding frequencies but more precisely reflect center frequencies. The Hamming and Blackman options
provide excellent overall results.

Specifies the number of vertical bands used to draw frequencies. As you increase resolution, frequency
accuracy increases, but time accuracy decreases. Experiment to find the right balance for your audio content. Highly
percussive audio, for example, may be better reflected by low resolution.

To adjust resolution directly in the Editor panel, right-click the vertical ruler next to the spectral display, and choose
Increase or Decrease Spectral Resolution.
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Decibel Range

Play Only Selected Frequencies When A Spectral Selection Exists

To the top

Decibels

Percentage

Sample Values

Normalized Values

More Logarithmic or Linear

Full Logarithmic or Linear

Changes the amplitude range over which frequencies are displayed. Increasing the range intensifies colors,
helping you see more detail in quieter audio. This value simply adjusts the spectral display; it does not change audio
amplitude.

Deselect this option to hear all frequencies in the
same time range as a selection.

Change the vertical scale
In the Waveform Editor, you can change the amplitude or frequency scale of the vertical ruler.

Change the amplitude scale of the waveform display

In the waveform display, right-click the vertical ruler and select one of the following:

Indicates amplitude on a decibel scale that ranges from –Infinity to zero dBFS.

Indicates amplitude on a percentage scale that ranges from –100% to 100%.

Indicates amplitude on a scale that shows the range of data values supported by the current bit depth. (See
Understanding bit depth.) 32-bit float values reflect the normalized scale below.

Indicates amplitude on a normalized scale that ranges from –1 to 1.

Change the frequency scale of the spectral display

In the spectral display, right-click the vertical ruler and select one of the following:

Gradually displays frequencies in a more logarithmic scale (reflecting human hearing) or a more
linear scale (making high frequencies more visually distinct).

Hold down Shift and roll the mouse wheel over the spectral display to show frequencies more logarithmically (up) or linearly
(down).

Displays frequencies completely logarithmically or linearly.

Sound waves

Change interface colors, brightness, and performance

Select spectral ranges

Techniques for restoring audio
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Plantilla (CS6)

Velocidad de muestreo

Nota:

Creación de un nuevo archivo de audio en blanco
Creación de una nueva sesión multipista
Apertura de archivos de audio y mezclas multipista existentes
Adición de archivos de audio a otros (Audition CS6)
Importación de un archivo como datos sin procesar
Inserción de un archivo de audio en una sesión multipista
Inserción de espacio de un archivo Broadcast Wave en una sesión

Creación de un nuevo archivo de audio en blanco
Los archivos de audio nuevos y en blanco son perfectos para grabar audio nuevo o combinar audio pegado.

1. Elija Archivo > Nuevo > Archivo de audio.

Para crear de forma rápida un archivo a partir de audio seleccionado en un archivo abierto, seleccione Edición > Copiar en
nuevo. (Consulte Copia o corte de datos de audio.)

2. Indique un nombre de archivo y establezca las siguientes opciones:

Determina el rango de frecuencia del archivo. Para reproducir una frecuencia determinada, la
velocidad de muestreo ha de ser al menos el doble de la frecuencia. (Consulte Conceptos básicos sobre la velocidad de
muestreo.)

Determina si la forma de onda es mono, estéreo o envolvente 5.1.

Para las grabaciones de solo voz, la opción mono es una buena opción que genera un procesamiento más rápido y
archivos más pequeños.

Determina el rango de amplitud del archivo. El nivel de 32 bits proporciona una flexibilidad de
procesamiento máxima en Adobe Audition. Sin embargo, para obtener compatibilidad con aplicaciones comunes, realice la
conversión a una profundidad de bits más baja cuando se complete la edición. (Consulte Profundidad de bits y Modificación
de la profundidad de bits de un archivo.)

Creación de una nueva sesión multipista
Los archivos de sesión (*.sesx) no contienen datos de audio. Son pequeños archivos basados en XML que hacen referencia a otros archivos de
audio del disco duro. Un archivo de sesión realiza un seguimiento de los archivos que forman parte de la sesión, del lugar donde se insertan, de
los envolventes y los efectos que se aplican, etc.

Para examinar los ajustes detalladamente, los archivos SESX se pueden abrir en editores de texto o almacenarse en sistemas de control de
versiones (por ejemplo, Perforce, que es popular en la industria de los juegos).

1. Seleccione Archivo > Sesión multipista.
2. Indique un nombre de archivo y ubicación y establezca las siguientes opciones:

Especifica una plantilla predeterminada o una que haya creado. Las plantillas de sesión especifican archivos
de origen y ajustes como la velocidad de muestreo y profundidad de bits.

Determina el rango de frecuencia de la sesión. Para reproducir una frecuencia determinada, la
velocidad de muestreo ha de ser al menos el doble de la frecuencia. (Consulte Conceptos básicos sobre la velocidad de
muestreo.)

Todos los archivos agregados a una sesión deben compartir la velocidad de muestreo. Si intenta importar archivos con
velocidades de muestreo diferentes, Adobe Audition le pedirá que los vuelva a muestrear, lo que puede reducir la calidad de
audio. Para cambiar la cualidad de remuestreo, defina los ajustes de Conversión de velocidad de muestreo en las
preferencias de datos.
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Velocidad de muestreo

Canales

Codificación

Determina el rango de amplitud de la sesión, incluyendo grabaciones y archivos creados con el
comando Multipista > Mezcla en nuevo archivo. (ConsulteConceptos básicos sobre profundidad de bits.)

Seleccione una profundidad de bits con cuidado, ya que no se puede cambiar una vez creada la sesión. Lo ideal es
trabajar a un nivel de 32 bits con sistemas rápidos. Si el sistema presenta lentitud, inténtelo con una profundidad de bits más
baja.

Determina si las pistas se mezclan en una pista mono, estéreo o maestra 5.1. (Consulte Enrutamiento de audio a
buses, envíos y pista Maestra.)

Apertura de archivos de audio y mezclas multipista existentes
Los siguientes tipos de archivo se abren en el Editor multipista: Audition Session, Adobe Premiere Pro Sequence XML, Final Cut Pro XML
Interchange y OMF.

Todos los demás tipos de archivo compatibles se abren en el Editor de forma de onda, incluyendo la parte de audio de los archivos de vídeo.

Los archivos de sesión SES de Audition 3.0 y versiones anteriores no son compatibles. Si dispone de Audition 3.0, guarde las sesiones en
formato XML para abrirlas en versiones CS. Sin embargo, tenga en cuenta que se excluyen los efectos anteriores en CS6 y los efectos y la
ampliación de tiempo en CS5.5.

Si se abren varios archivos, el panel Editor permite seleccionar qué archivo mostrar.

1. Seleccione Archivo > Abrir.
2. Seleccione un archivo de audio o vídeo. (Consulte Formatos de importación admitidos.)

Si no se ve el archivo que desea, seleccione Todos los medios compatibles en el menú situado en la parte interior del
cuadro de diálogo.

Adición de archivos de audio a otros (Audition CS6)
Agregue archivos con marcadores de pista de CD para montar audio con rapidez y aplicar un procesamiento coherente.

1. En el Editor de forma de onda, realice una de las acciones siguientes:

Para agregar al archivo activo, seleccione Archivo > Abrir anexo > Con actual.
Para añadir un nuevo archivo, seleccione Archivo > Abrir anexo > A nuevo.

2. En el cuadro de diálogo Abrir anexo, seleccione uno o más archivos. 

Si los archivos seleccionados tienen una velocidad de muestreo, profundidad de bits o tipo de canal distintos del
archivo de abierto, Audition convierte los archivos seleccionados para que coincidan con el archivo abierto. Para obtener los
mejores resultados, agregue archivos con el mismo tipo de muestra que el archivo de original.

3. Haga clic en Abrir.

Importación de un archivo como datos sin procesar
Si no se puede abrir un archivo concreto, puede que falte información de encabezado necesaria que describa el tipo de muestra. Para especificar
manualmente esta información, importe el archivo como datos sin procesar.

1. Seleccione Archivo > Importar > Datos sin procesar.
2. Selecciónelo y haga clic en Abrir.
3. Defina las opciones siguientes:

Debe coincidir con la velocidad conocida del archivo, si es posible. Para ver ejemplos de ajustes
comunes, consulte Conceptos básicos sobre la velocidad de muestreo. Adobe Audition puede importar datos sin procesar con
velocidades que van de 1 a 10.000,000 Hz, pero la reproducción y la grabación se admiten solo entre 6000 Hz y 192.000 Hz.

Introduzca un número entre 1 y 32.

Especifica el esquema de almacenamiento de datos para el archivo. Si no sabe con seguridad qué codificación
usa el archivo, consulte al proveedor del archivo, o bien, la documentación de la aplicación que lo creó. En muchos casos, la
prueba y el error pueden ser necesarios.
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Orden de bytes

Desplazamiento de byte de inicio (CS6)

Volver al principio

Volver al principio

Especifica la secuencia numérica para los bytes de datos. El método Little-Endian es común en los archivos
WAV, mientras que Big-Endian es común en los archivos AIFF. Con Orden de bytes predeterminado se aplica
automáticamente el valor predeterminado para el procesador del sistema y suele ser la mejor opción.

Especifica el punto de datos en el archivo en el que debería comenzar el proceso
de importación.

Inserción de un archivo de audio en una sesión multipista
Al insertar un archivo de audio en el Editor multipista, el archivo se convierte en clip de audio en la pista seleccionada. Si inserta varios archivos a
la vez, o un solo archivo mayor que el espacio disponible en la pista seleccionada, Adobe Audition insertará nuevos clips en las pistas vacías más
cercanas.

1. En el Editor multipista, seleccione una pista y, a continuación, coloque el cabezal de reproducción  en la posición de tiempo
que desee.

2. Seleccione Multipista > Insertar archivo.
3. Seleccione un archivo de audio o vídeo. (Consulte Formatos de importación admitidos.)

En CS6, arrastre los rangos desde el panel Marcadores del Editor multipista para convertirlos automáticamente a clips.

Inserción de espacio de un archivo Broadcast Wave en una sesión
Cuando se inserta un archivo Broadcast Wave (BWF) en una sesión multipista, Adobe Audition puede utilizar la marca horaria incrustada para
insertar el archivo en un momento específico. A esto se le suele denominar inserción de espacios.

1. Seleccione Editar > Preferencias > Multipista (Windows) o Audition > Preferencias > Multipista (Mac OS).
2. Seleccione Utilizar código de tiempo incorporado al insertar clips en multipista.
3. En el Editor multipista, seleccione una pista.
4. Seleccione Multipista > Insertar audio y elija un archivo BWF.

Adobe Audition inserta un clip de audio en el tiempo de inicio designado.

Para ver o editar la marca horaria para un clip de BWF, abra el clip en el Editor de forma de onda y seleccione Ventana > Metadatos. En la
ficha BWF, el valor de marca de hora aparece como Referencia de tiempo.

Acerca de las sesiones multipista

Inserción de un archivo de vídeo en una sesión multipista
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Favoritos
Coincidencia de volumen en varios archivos
Procesamiento de archivos por lotes

Favoritos
Favoritos son combinaciones de efectos, transiciones y ajustes de amplitud que se pueden guardar y volver a aplicar rápidamente a cualquier
archivo o selección en el editor de forma de onda. El menú Favoritos muestra opciones predeterminadas, así como los favoritos adicionales que
el usuario cree.

Para asignar favoritos a métodos abreviados de teclado, consulte Personalización de métodos abreviados.

Creación de un favorito a partir de una combinación de ajustes

1. En el Editor de forma de onda, seleccione Favoritos > Comenzar a grabar favorito.

2. Aplique los efectos, transiciones y ajustes de amplitud que desee guardar.

3. Seleccione Favorito > Detener grabación de favorito y el nombre del favorito.

Creación de un favorito a partir de un efecto específico

1. Ajuste la configuración del efecto como desee.

2. En la parte superior del cuadro de diálogo del efecto, haga clic en el icono Favorito . A continuación indique el nombre del
favorito.

Creación de un favorito desde el bastidor de efectos (CS6)

1. En el bastidor de efectos, ajuste la configuración y el orden de los efectos.

2. En la parte superior derecha del bastidor de efectos, haga clic en el icono Favorito . A continuación indique el nombre del
favorito.

Eliminación de un favorito

1. Seleccione Favoritos > Eliminar favorito.

2. Seleccione el nombre del favorito y haga clic en Aceptar.

Coincidencia de volumen en varios archivos
Si piensa recopilar un grupo de archivos de audio en un CD, la web u otro medio, utilice el panel Volumen de coincidencia para hacer que el
sonido sea coherente.

Para hacer coincidir clips multipista sin cambiar los archivos de origen, consulte Hacer coincidir el volumen de clip

1. En el Editor de forma de onda, seleccione Ventana > Volumen de coincidencia.

2. Arrastre archivos del panel Archivos al panel Volumen de coincidencia. O bien, haga clic en el botón Agregar archivos  en
el panel para buscar archivos en el sistema.

De forma predeterminada, Volumen de coincidencia solo procesa unos cuantos archivos a la vez para obtener un
rendimiento óptimo. Para procesar más archivos, cambie el valor de Número máximo de procesos de archivo concurrentes en
las preferencias de Datos.

3. (Opcional) Para mostrar las estadísticas de amplitud como, por ejemplo, volumen percibido y máximo de cada archivo, haga
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Nota:
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clic en el icono de cálculo . A continuación, haga clic en Ajustes para especificar valores de destino basados en estas
estadísticas.

4. Realice una de las acciones siguientes:

Para procesar los archivos existentes y guardarlos posteriormente, anule la selección de Exportar en la parte inferior del
panel. 
Para procesar archivos nuevos, seleccione Exportar. (Para personalizar Exportar ajustes, consulte Procesamiento de
archivos por lotes.) 

5. Haga clic en Ejecutar.

Interpretación de las estadísticas de volumen de coincidencia

Valor de amplitud medio. (Para Audition CS6, esto refleja el estándar ITU-R BS.1770-2, lo que garantiza niveles de difusión constantes
compatibles con EBU R 128.)

Valor de amplitud medio ajustado para la mayor sensibilidad del oído en las frecuencias de rango medio.

Amplitud de raíz cuadrada media más común en todo el archivo. Por ejemplo, si la mayor parte de dos archivos es -50 dBFS, los
valores de raíz cuadrada media (RMS) podrían reflejarlo, aunque un archivo contenga pasajes más altos.

La amplitud RMS suele reflejar mejor la amplitud percibida que el promedio de volumen absoluto.

Amplitud máxima.

Es la amplitud máxima definida por el estándar ITU-R BS.1770-2.

Es el porcentaje de la forma de onda que se recortará como resultado de la normalización. El recorte no se producirá si se utiliza la
limitación. Sin embargo, lo ideal sería evitar el recorte antes de la limitación. Si algún archivo coincidente muestra más de un 0% de recorte, haga
clic en Deshacer y realice la coincidencia con una amplitud algo más baja.

Ajuste de la configuración del volumen de coincidencia

En el panel Volumen de coincidencia, haga clic en Ajustes para ajustar las siguientes opciones:

Determina el modo en que la amplitud se compara matemáticamente:

Hace coincidir un volumen general especificado.

Hace coincidir el volumen general de un archivo seleccionado. Elija esta opción si un archivo refleja el
volumen de destino que desea conseguir.

Coincide con un volumen medio especificado.

Coincide con el nivel de volumen percibido, teniendo en cuenta las frecuencias medias a las que
es más sensible el oído. Esta opción funciona bien a menos que el énfasis de la frecuencia varíe significativamente en
un archivo (por ejemplo, si se pronuncian frecuencias medias en un fragmento corto, pero todas las demás
frecuencias son bajas).

Coincide con la amplitud máxima especificada, normalizando los archivos. Como esta opción
conserva el rango dinámico, resulta ideal para archivos para los que tiene previsto un procesamiento posterior o para
audio muy dinámico, como la música clásica.

Aplica los límites forzados para que los picos no se recorten. (Al amplificar el audio, algunas muestras
pueden ampliarse superando el punto de recorte.)

Especifica el número de milisegundos que son necesarios para atenuar el audio
antes de alcanzar el pico más alto.

Si este valor es demasiado bajo, es posible que se produzcan distorsiones auditivas. Asegúrese de que el valor es de 5
milisegundos como mínimo.

Especifica el número de milisegundos para que la atenuación se recupere 12 dB (o
aproximadamente el tiempo necesario para que el audio retome el volumen normal tras un pico extremadamente alto).

http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/es-es/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/es-es/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/es-es/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/es-es/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/es-es/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/es-es/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/es-es/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/es-es/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/es-es/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/es-es/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/es-es/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/es-es/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/es-es/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/es-es/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/es-es/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/


  Las publicaciones de Twitter™ y Facebook no están sujetas a los términos de Creative Commons.

Avisos legales   |   Política de privacidad en línea

Nota:

Volver al principio

Nota:

Prefijo y Postfijo del nombre de archivo

Plantilla

Ubicación

Igual que ubicación de archivo origen

Sobrescribir archivos existentes

Formato

Tipo de muestra

Nuevo tipo de muestra

Eliminar los archivos del panel al finalizar

Incluir marcadores y otros metadatos

Un valor de 200 milisegundos funciona para evitar frecuencias de graves bajas. Si el valor es demasiado alto, es
posible que el audio esté por debajo de los niveles normales durante un rato.

Procesamiento de archivos por lotes
Procese por lotes grupos de archivos para aplicar rápidamente el procesamiento favorito, volver a muestrear o guardar en un nuevo formato.
Automatice rápidamente las tareas comunes como la exportación a formato mp3 o la aplicación de efectos idénticos a archivos relacionados.

1. En el Editor de forma de onda, seleccione Ventana > Proceso por lotes.

2. En el panel Proceso por lotes, haga clic en el botón Agregar archivos  para buscar archivos en el sistema. (Para agregar
todos los archivos abiertos con rapidez, seleccione Archivo > Guardar todo el audio como proceso por lotes).

De forma predeterminada, el procesamiento por lotes se limita a tres archivos de una vez para obtener un rendimiento
óptimo. Para procesar más archivos, cambie el valor de Número máximo de procesos de archivo concurrentes en las
preferencias de Datos.

3. Seleccione una opción de procesamiento en el menú Favorito. A continuación, realice una de las siguientes operaciones:

Para procesar los archivos existentes, anule la selección de Exportar en la parte inferior del panel y, a continuación, haga
clic en Ejecutar.
Para procesar archivos nuevos, seleccione Exportar y, a continuación, haga clic en Ejecutar. (Para personalizar Exportar
ajustes, consulte el paso siguiente.)

4. Haga clic en Exportar ajustes y establezca las siguientes opciones:

Ayuda a identificar los archivos por lotes.

Especifica una convención de nomenclatura para los archivos procesados, como Artista, Fecha, Canción
(%a/%d/%s/).

Especifica la carpeta de destino para los archivos procesados.

Guarda los archivos modificados en la misma carpeta que el archivo de
origen del archivo.

Reemplaza automáticamente los archivos existentes con el mismo nombre.

Especifica el formato de archivo. El área Ajustes de formato indica los modos de almacenamiento y compresión de
datos; para ajustar estos campos, haga clic en Cambiar. (Consulte Ajustes de formato de audio.)

Indica la velocidad de muestro y la profundidad de bits. Para personalizar estas opciones, haga clic en
Cambiar. (Consulte Cambio de la velocidad de muestreo de un archivo.)

Indica la velocidad de muestro y la profundidad de bits tras la exportación. Si los archivos de origen
tienen distintos tipos de muestra, haga clic en el menú emergente para ver cómo se convertirá cada archivo. (El menú no
aplica las opciones de conversión; para ajustarlas, haga clic en Cambiar en Tipo de muestra.)

Elimina los nombres de archivo del panel Proceso por lotes tras la exportación.

Incluye marcadores de audio e información del panel Metadatos en los archivos
procesados. (Consulte Uso de marcadores y Visualización y edición de metadatos XMP.)

Selección de audio

Efecto Normalizar (solo Editor de forma de onda)

Análisis de amplitud
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Automating common tasks (CS5.5)
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To the top

Note:

Loudness

Perceived

Favorites
Match volume across multiple files
Batch process files

Favorites
Favorites are combinations of effects, fades, and amplitude adjustments that you can save and quickly reapply to any file or selection in the
Waveform Editor. The Favorites menu lists some defaults to get you started, plus any additional favorites you create.

To assign favorites to keyboard shortcuts, see Customize shortcuts.

Create a favorite from a combination of adjustments

1. In the Waveform Editor, choose Favorites > Start Recording Favorite.

2. Apply the effects, fades, and amplitude adjustments you want to save.

3. Choose Favorite > Stop Recording Favorite, and name the favorite.

Create a favorite from a specific effect

1. Adjust effect settings as desired.

2. In the upper right of the effect dialog box, click the Favorite icon . Then name the favorite.

Delete a favorite

1. Choose Favorites > Delete Favorite.

2. Select the favorite name, and click OK.

Match volume across multiple files
If you plan to present a group of audio files on CD, the web, or elsewhere, use the Match Volume panel to make them sound consistent.

To match multitrack clips without changing source files, see Match clip volume

1. In the Waveform Editor, choose Window > Match Volume.

2. Drag files from the Files panel to the Match Volume panel. Or click the Add Files button  in the panel to browse to files on
your system.

By default, Match Volume processes at most three files at a time for optimal performance. To process more files,
change the value for Maximum Number Of Concurrent File Processes in the Data preferences.

3. (Optional) To display amplitude statistics such as perceived and peak volume for each file, click the Compute icon . Then
click Settings to specify target values based on these statistics.

4. Click Match Volume to apply the necessary amplitude changes. Or click Batch Process to apply those changes and export to
the same file format and sample type. (See Batch process files.)

Understanding Match Volume statistics

Is the average amplitude value.

Is the average amplitude value adjusted for the human ear’s greater sensitivity to midrange frequencies.
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Peak

% Clip

Match To

Total RMS

File

Loudness

Perceived Loudness

Peak Volume

Use Limiting

Lookahead Time

Note:

Release Time

Note:

To the top

Note:

Apply Favorite

Filename Prefix and Postfix

Location

Is the most common root-mean-square amplitude across the entire file. For example, if the majority of two files is -50 dBFS, the total
RMS values would reflect that, even if one file contains more loud passages.

RMS amplitude often better reflects perceived amplitude than the absolute Loudness average.

Is the maximum amplitude.

Is the percentage of the waveform that would be clipped as a result of normalization. Clipping won’t occur if limiting is used. However,
clipping should ideally be avoided prior to limiting. If any matched files show more than 0% clipping, click Undo, and match to a slightly lower
amplitude.

Adjust Match Volume settings

In the Match Volume panel, click Settings to adjust the following options:

Determines how amplitude is mathematically compared:

Matches an overall loudness you specify.

Matches the overall loudness of a selected file. Choose this option if one file reflects the target volume you want
to achieve.

Matches an average loudness you specify.

Matches the perceived loudness level, accounting for middle frequencies that the ear is most
sensitive to. This option works well unless frequency emphasis varies greatly in a file (for example, midrange
frequencies are pronounced in a short passage, but bass frequencies are elsewhere).

Matches a maximum amplitude you specify, normalizing the files. Because this option retains dynamic
range, it’s a good choice for files you plan to process further, or for highly dynamic audio like classical music.

Applies hard limiting to keep peaks from being clipped. (When you amplify audio, some samples may extend
beyond the clipping point.)

Specifies the number of milliseconds to attenuate audio before reaching the loudest peak.

If this value is too small, audible distortion might occur. Make sure that the value is at least 5 milliseconds.

Specifies the number of milliseconds for attenuation to rebound 12 dB (roughly the amount needed to
resume normal volume after an extremely loud peak is encountered).

A setting of 200 milliseconds works well to preserve low bass frequencies. If the setting is too high, audio may stay
below normal levels for a while.

Batch process files
Batch process groups of files to quickly apply favorite processing, resample, or save to a new format. Quickly automate common tasks like
exporting to mp3 format or applying identical effects to related files.

1. In the Waveform Editor, choose Window > Batch Process.

2. In the Batch Process panel, click the Add Files button  to browse to files on your system.

By default, batch processing is limited to three files at a time for optimal performance. To process more files, change
the value for Maximum Number Of Concurrent File Processes in the Data preferences.

3. Click Batch Process, and set the following options:

Applies a combination of effects, fades, and amplitude adjustments. (See Favorites.)

Help you identify batched files.

Specifies the destination folder for processed files.
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Same As Source File Location

Overwrite Existing Files

Format

Sample Type

Clear Batch Process Panel Upon Completion

Include Markers and Other Metadata

Saves modified files in the same folder as the file’s source file.

Automatically replaces existing files with the same name.

Specifies the file format. The Format Settings area below indicates data compression and storage modes; to adjust
these, click Change. (See Audio format settings.)

Indicates the sample rate and bit depth. To adjust these options, click Change. (See Convert the sample rate
of a file.)

Removes filenames from the source list after the files are converted
successfully.

Includes audio markers and information from the Metadata panel in processed files.
(See Working with markers and Viewing and editing XMP metadata.)

Selecting audio

Normalize effect (Waveform Editor only)

Analyze amplitude
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Working with markers

Note:

To the top

Add, select, and rename markers
Adjust, merge, convert, or delete markers
Save audio between markers to new files
Creating playlists

Markers (sometimes called cues) are locations that you define in a waveform. Markers make it easy to navigate within a waveform to make a
selection, perform edits, or play back audio.

In Adobe Audition, a marker can be either a point or a range. A point refers to a specific time position within a waveform (for instance, 1:08.566
from the start of the file). A range has both a start time and an end time (for example, all of the waveform from 1:08.566 to 3:07.379). You can
drag start and end markers for a range to different times.

In the timeline at the top of the Editor panel, markers have white handles you can select, drag, or right-click to access additional commands.

Examples of markers 
A. Marker point B. Marker range 

To preserve markers when you save a file, select Include Markers and Other Metadata.

Add, select, and rename markers
Though you can add markers directly in the Editor panel, you use the Markers panel (Windows > Markers) to define and select markers.

To hide or show information such as Duration and Type, choose Markers Display from the panel menu .

Add a marker

1. Do one of the following:

Play audio.

Place the current-time indicator  where you want a marker point to be.

Select the audio data you want to define as a marker range.

2. Either press the M key, or click the Add Marker button  in the Markers panel.

To automatically create markers where silence occurs, see Delete Silence and Mark Audio options.

Select markers

Click a marker in the Editor or Markers panel. Or double-click to move the current-time indicator  to that location and select
the area for range markers.

To select adjacent markers, click the first marker you want to select in the Markers panel, and then Shift-click the last.

To select nonadjacent markers, Ctrl-click (Windows) or Command-click (Mac OS) them in the Markers panel.

To move the current-time indicator to the nearest marker, choose Edit > Marker > Move CTI to Next or Previous.

Rename a marker

1. In the Markers panel, select the marker.

2. Click the marker name, and enter a new name.
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Use Marker Names In Filename

Prefix

Postfix Starting #

Location

Format

Sample Type

Include Markers and Other Metadata

To the top

Adjust, merge, convert, or delete markers
After creating markers, you can fine-tune them to best address the needs of an audio project.

Reposition markers

In the Editor panel, drag marker handles to a new location.

In the Markers panel, select the marker, and enter new Start values for point markers, or Start, End, and Duration values for
range markers.

Merge individual markers

In the Markers panel, select the markers you want to merge, and click the Merge button .

The new merged marker inherits its name from the first marker. Merged point markers become range markers.

Convert a point marker to a range marker

Right-click the marker handle, and choose Convert to Range.

The marker handle splits into two handles.

Convert a range marker to a point marker

Right-click a marker handle, and choose Convert to Point.

The two parts of the range marker handle merge into a single handle, with the start time of the range becoming the time for the
point marker.

Delete markers

Select one or more markers, and click the Delete button  in the Markers panel.

Right-click the marker handle in the Editor panel, and choose Delete Marker.

Save audio between markers to new files

1. In the Waveform Editor, choose Window > Markers.

2. Select one or more marker ranges. (See Working with markers .)

3. Click the Export Audio button  in the Markers panel.

4. Set the following options:

Uses the marker name as the prefix for the filename.

Specifies a filename prefix for the new files.

Specifies the number to begin with when adding numbers to the filename prefix. Adobe Audition
automatically adds numbers after the prefix (for example, prefix02, prefix03) to distinguish saved files.

Specifies the destination folder for saved files. Click Browse to specify a different folder.

Specifies the file format. The Format Settings area below indicates and data compression and storage modes; to
adjust these, click Change. (See Audio format settings.)

Indicates the sample rate and bit depth. To adjust these options, click Change. (See Convert the sample rate
of a file.)

Includes audio markers and information from the Metadata panel in processed files.
(See Viewing and editing XMP metadata.)

Creating playlists
A playlist is an arrangement of marker ranges that you can play back in any order and loop a specified number of times. A playlist lets you try
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Note:

different versions of an arrangement before you commit to edits. You create playlists in the Playlist panel (Window > Playlist).

To store a playlist with a file, you must save in WAV format. (See Save audio files.)

Create a playlist

1. In the Playlist panel, click the Open Markers Panel button .

2. In the Markers panel, select marker ranges you want to add to the playlist. Then click the Insert Selected Range Markers Into
Playlist button , or drag the range markers to the Playlist panel.

Change the order of items in a playlist

Drag the item up or down.

Play items in a playlist

To play all or part of the list, select the first item you want to play. Then click the Play button  at the top of the panel.

To play a specific item, click the Play button to the left of the item name.

Loop an item in a playlist

Select an item, and enter a number in the Loops column. Each item can loop a different number of times.

Delete items from a playlist

Select the items, and click the Remove button .

Delete Silence and Mark Audio options

Batch process files
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Análisis de fase, frecuencia y amplitud

Volver al principio

Volver al principio

Análisis de fase
Análisis de intervalo de frecuencias
Análisis de amplitud

Adobe Audition ofrece diversas maneras de analizar el audio. Para comparar las relaciones de fase entre cualquier de los dos canales, utilice el
panel Medidor de fase. Para analizar rango tonal y dinámico, utilice los paneles Análisis de frecuencia y Estadísticas de amplitud.

El Editor de forma de onda también proporciona la visualización de frecuencia espectral, que puede utilizar junto con los métodos de análisis
anteriores. (Consulte Visualización de audio en el Editor de forma de onda.)

Análisis de fase
El panel Medidor de fase muestra los canales fuera de fase para las formas de onda envolvente y estéreo, que se pueden corregir con el
comando Efectos > Invertir. (Consulte Inversión de una forma de onda.) Este panel también ayuda a identificar los canales en fase que sonarán
de forma similar si se suman a mono. (Consulte Conversión de una forma de onda entre envolvente, estéreo y mono.)

(Para obtener más información sobre la fase de audio, consulte Cómo interactúan las ondas de sonido.)

1. Seleccione Ventada > Medidor de fase.
2. Haga clic con el botón derecho en el panel Contador de fase y seleccione los canales en los menús Canal y Comparar con.
3. En el panel Editor, seleccione un rango, si lo desea, e inicie la reproducción.

En el Contador de fase, el audio de la izquierda está más desfasado, mientras que el audio de la derecha está más en fase. -1.0 refleja la
cancelación de fase total, mientras que 1.0 refleja el contenido de audio idéntico en cada canal.

Para personalizar la apariencia del medidor, haga clic con el botón derecho en el mismo y seleccione Mostrar degradado de color o Mostrar
medidores LED.

Análisis de intervalo de frecuencias
Puede usar el panel Análisis de frecuencia para identificar bandas de frecuencia problemáticas, que puede corregir con un efecto de filtro.

1. Seleccione Ventana > Análisis de frecuencia.
2. En el panel Editor, haga clic en un punto de tiempo, seleccione un intervalo o inicie la reproducción.
3. En el panel Análisis de frecuencia, observe la frecuencia a lo largo del eje horizontal y la amplitud en el eje vertical.

Si selecciona un intervalo, Adobe Audition analiza solo el punto central. Para analizar la frecuencia general del rango,
haga clic en Explorar selección.

Opciones de Análisis de frecuencia
Escala Muestra la escala de frecuencia de forma logarítmica (reflejando el oído humano) o lineal (proporcionando más información para las
frecuencias superiores).

Copiar todos los datos gráficos Copia un informe de texto de los datos de frecuencia en el portapapeles del sistema.
Botones Mantener Le permiten tomar un máximo de ocho instantáneas de frecuencia a medida que se reproduce una forma de onda. El
contorno de la frecuencia (que se procesa en el mismo color que el botón en el que se hace clic) está congelado en el gráfico y superpuesto en
otros contornos de frecuencia. Para borrar un contorno de frecuencia congelado, haga clic en su correspondiente botón Mantener de nuevo.
Mostrar Cambia la visualización del gráfico. Elija uno de los siguientes estilos:

Líneas  Muestra la amplitud en cada frecuencia con líneas sencillas. De forma predeterminada, el canal izquierdo es verde y el derecho
azul.
Área  Asimismo, muestra líneas para la amplitud, pero rellena el área bajo las líneas de un color sólido y suaviza las diferencias de
amplitud en la misma área.
Barras  Muestra el efecto de la resolución de análisis, dividiendo la pantalla en segmentos rectangulares. Cuanto mayor sea el tamaño de
FFT, mayor será la resolución de análisis y más estrecha las barras.

Canal superior Determina qué canal de un archivo envolvente o estéreo aparece sobre otros en el gráfico. Para combinar los canales
visualizados, seleccione Promedio.
Explorar o Explorar selección Explora todo el archivo o selección y muestra los datos de frecuencia media en el gráfico. (De forma
predeterminada, el gráfico muestra datos desde el punto central de los archivos y selecciones.)

Opciones avanzadas
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Tamaño FFT Especifica el tamaño de transformación de Fourier rápida (FFT). Los tamaños de FFT más altos informan sobre datos de frecuencia
de forma más eficaz, pero requieren mayores tiempo de procesamiento.
Ventana Determina la forma de transformación Fast Fourier. Estas funciones se incluyen ordenándose de más breves a más amplias. Las
funciones más limitadas incluyen menores frecuencias envolventes y frecuencias centrales de reflejo menos precisas. Las funciones más amplias
incluyen más frecuencias envolventes y frecuencias centrales de reflejo más precisas. Los filtros Hamming y Blackman ofrecen excelentes
resultados globales.
Referencia 0 dB Determina la amplitud a la que se visualizan los datos de audio a escala completa y 0 dBFS. Por ejemplo, un valor de cero
visualiza audio de 0 dBFS a 0 dB. Un valor de 30 visualiza audio de 0 dBFS a –30 dB. Este valor simplemente mueve el gráfico hacia arriba o
hacia abajo; no cambia la amplitud de los datos de audio.

Ajuste la Referencia 0 dB para calibrar esta visualización en otra referencia de decibelios, como nivel de presión de sonido (SPL).

Valor en [x] Hz Muestra la amplitud precisa para frecuencias específicas cuando el ratón se sitúa sobre el gráfico.
Frecuencia global Para el punto de inicio del rango seleccionado, indica la frecuencia media.
Nota musical global Para el punto de inicio de un rango seleccionado, indica la posición del teclado y la varianza de la sintonización estándar
(A440). Por ejemplo, A2 +7 es igual a la segunda A (nota La) más baja en un teclado con una afinación un 7% más alta de lo normal.

Gráficos de frecuencia de zoom
En el panel Análisis de frecuencia, puede aplicar el zoom a los gráficos para analizar la frecuencia con más detalle.

 Realice cualquiera de las acciones siguientes:

Para acercar un gráfico, haga clic con el botón derecho y arrastre el icono de lupa en la regla vertical u horizontal.

Para desplazarse por un gráfico ampliado, haga clic con el botón izquierdo y arrastre el icono de la mano  hasta la regla
vertical u horizontal.

Para alejarse de un gráfico ampliado, haga clic con el botón derecho en la regla vertical u horizontal y seleccione Alejar para
volver a la ampliación anterior, o bien, Alejar del todo para alejarse completamente.

Uso del zoom y desplazamiento en un gráfico del Análisis de frecuencia

Análisis de amplitud
1. En el Editor de forma de onda, seleccione Ventana > Estadísticas de amplitud.
2. Para calcular las estadísticas desde un archivo o selección completos, haga clic en Explorar o Explorar selección. (De forma

predeterminada, las estadísticas se calculan desde el punto central de archivos y selecciones.)
Puede ajustar una selección en el panel Editor. Haga clic de nuevo en Explorar selección para volver a calcular las
estadísticas.

3. Evalúe la amplitud en las siguientes fichas:

La ficha General muestra estadísticas numéricas que indican el intervalo dinámico, identifican muestras recortadas y
resaltan los posibles desplazamientos de DC.

La ficha Histograma RMS muestra un gráfico que indica la prevalencia relativa de cada amplitud. La regla horizontal mide
la amplitud en decibelios y la vertical la prevalencia utilizando la fórmula RMS. Seleccione un canal para ver desde el
menú Mostrar canal.

Utilice la ficha Histograma para identificar las amplitudes prevalecientes y, a continuación, comprímalas, limítelas o
normalícelas con un efecto de amplitud.

Opciones generales



 

Haga clic en los iconos a la derecha de los valores para desplazarse a la ubicación correspondiente en el archivo.

Amplitud de pico Muestra la muestra con la amplitud más alta en forma de decibelios.
Valor máximo de muestra Muestra la muestra con la amplitud más alta.
Valor mínimo de muestra Muestra la muestra con la amplitud más baja.
Muestras posiblemente recortadas Muestra el número de muestras que probablemente hayan superado 0 dBFS. Haga clic en el icono 
situado a la derecha de este valor para desplazarse a la primera muestra recortada en el archivo de audio. (Si es necesario, haga clic de nuevo
en el icono para ver las siguientes muestras recortadas.)
Amplitud RMS media, mínima, máxima y total Muestra de los valores de raíz cuadrada media de la selección. Los valores RMS se basan en la
prevalencia de las amplitudes específicas, reflejando a menudo el volumen percibido mejor que las amplitudes medias o absolutas.
Desplazamiento de DC Muestra cualquier desplazamiento directo actual que se haya aplicado a la forma de onda durante la grabación. Los
valores positivos se encuentran por encima de la línea central y los valores negativos por debajo. (Consulte Corrección del desplazamiento de
DC.)
Profundidad de bits medida Informa de la profundidad de bits de la forma de onda. (32 indica que la forma de onda utiliza el rango flotante
completo de 32 bits).
Rango dinámico Refleja la diferencia entre la Amplitud RMS máxima y mínima.
Rango dinámico utilizado Muestra el rango dinámico menos los periodos excepcionalmente largos de amplitud RMS baja como, por ejemplo,
pasajes en silencio.
Volumen Muestra la amplitud media.
Volumen percibido Compensa en énfasis del oído humano en las frecuencias medias.
Copiar Copia todas las estadísticas en la ficha General en el portapapeles del sistema.

Opciones de configuración de RMS
Para ajustar el modo en que se calculan las estadísticas RMS, establezca las siguientes opciones:

0dB = onda sinusoidal FS Corresponde al nivel de dB en una onda sinusoidal de escala completa, donde la amplitud de pico es de unos 3,01
dB más bajos que una onda cuadrada de escala completa.
0dB = onda cuadrada FS Corresponde al nivel de dB en una onda cuadrada de escala completa, donde la amplitud de pico es de unos 3,01 dB
más altos que una onda sinusoidal de escala completa.
Cuenta para DC Omite cualquier desplazamiento de DC en las mediciones.
Anchura de ventana Especifica el número de milisegundos en cada ventana RMS. Un intervalo seleccionado contiene una serie de ventanas de
este tipo, de las que Adobe Audition obtiene el promedio para calcular los valores RMS mínimo y RMS máximo. Para conseguir los valores RMS
más precisos, utilice ventanas anchas para el audio con un intervalo dinámico ancho y ventanas estrechas para el audio con un intervalo
dinámico estrecho.

  |  
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Escucha de un archivo a una velocidad de muestreo distinta
El comando Interpretar velocidad de muestreo le permite escuchar cómo sonará un archivo de audio a una velocidad de muestreo distinta.
(Consulte Conceptos básicos sobre la velocidad de muestreo.) Este comando ayuda a identificar los archivos que especifican una velocidad
incorrecta en el encabezado de archivo. Para convertir de forma permanente la velocidad de muestreo, seleccione Editar > Convertir tipo de
muestra.

1. En el Editor de forma de onda, seleccione Editar > Interpretar velocidad de muestreo.
2. Introduzca una velocidad de muestreo en el cuadro de texto o elija una velocidad de muestreo común de la lista.

Nota: Aunque puede trabajar con cualquier velocidad de muestreo desde 6000 a 192.000 Hz en Adobe Audition, puede que su tarjeta de sonido
no pueda reproducir todas las velocidades correctamente. Para determinar las velocidades de muestreo admitidas, consulte la documentación de
la tarjeta.

Cambio de la velocidad de muestreo de un archivo
La velocidad de muestreo de un archivo determina el rango de frecuencia de la forma de onda. Al convertir la velocidad de muestreo, tenga
presente que la mayoría de tarjetas de sonido solo admiten ciertas velocidades de muestreo.

1. En el Editor de forma de onda, seleccione Editar > Convertir tipo de muestra.
Para acceder rápidamente al cuadro de diálogo Convertir tipo de muestra, haga doble clic en la sección Tipo de muestra
de la barra de estado. (Consulte Visualización de la barra de estado.)

2. Seleccione una velocidad de la lista Velocidad de muestreo o introduzca una velocidad personalizada en el cuadro de texto.
3. En la sección Avanzadas, arrastre el control de Calidad para ajustar la calidad de la conversión de muestra.

Los valores más altos conservan más frecuencias altas, pero la conversión tarda más. Los valores más bajos requieren
menos tiempo de procesamiento pero reducen las frecuencias altas.

Utilice valores más de mayor calidad siempre que convierta una velocidad alta a una velocidad baja. Cuando realiza el
muestro, los valores más altos tienen efecto de título.

4. Para obtener mejores resultados, seleccione Filtro previo/posterior para evitar el ruido de suavizado.

Conversión de una forma de onda entre envolvente, estéreo y mono
El comando Convertir tipo de muestra es la forma más rápida de convertir una forma de onda en un número diferente de canales.

1. En el Editor de forma de onda, seleccione Editar > Convertir tipo de muestra.
2. En el menú Canales, seleccione Mono, Estéreo o 5.1.
3. En la sección Avanzadas, indique los porcentajes para Mezcla izquierda y Mezcla derecha:

Al convertir de mono a estéreo, las opciones Mezcla izquierda y Mezcla derecha le permiten especificar la amplitud
relativa con la que la señal mono original se coloca a cada lado de la nueva señal estéreo. Por ejemplo, puede colocar el
mono original solo en el canal izquierdo, solo en el canal derecho o en cualquier punto entre los dos.

Al convertir de estéreo a mono, las opciones Mezcla izquierda y Mezcla derecha le permiten controlar la cantidad de señal
del canal respectivo que se mezclará en la forma de onda mono final. El método de mezcla más común utiliza el 50% de
ambos canales.

Para las demás técnicas de conversión de canal, consulte los siguientes temas:

Extracción de canales de audio a archivos mono

Mezcla de datos de audio al pegar

Efecto Mezclador de canales

http://helpx.adobe.com/en/audition/using/saving-exporting-files.html#extract_audio_channels_to_mono_files
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La profundidad de bits de un archivo determina el intervalo dinámico del audio. (ConsulteConceptos básicos sobre la profundidad de bits.) Adobe
Audition admite una resolución de hasta 32 bits. Puede aumentar la profundidad de bits de un archivo para obtener un intervalo dinámico
superior, o puede disminuirla para reducir el tamaño del archivo.

Nota: Algunas reproductores de medios y aplicaciones comunes requieren audio de 16 bits o más bajo.
1. En el Editor de forma de onda, seleccione Editar > Convertir tipo de muestra.
2. Seleccione una profundidad de bits en el menú o introduzca una profundidad de bits personalizada en el cuadro de texto.
3. En la sección Avanzadas, establezca las siguientes opciones:

Tramado Activa o desactiva el tramado al convertir profundidades de bits más bajas. Si el tramado está desactivado, la
profundidad de bits se trunca repentinamente, lo que produce un efecto de chasquido en los pasajes de volumen bajo
mediante la distorsión de cuantificación.

Aunque el tramado introduce una pequeña cantidad de ruido, el resultado es mucho más preferible que el aumento de la
distorsión que oiría a niveles de señal bajos. El tramado también le permite oír sonidos que estarían enmascarados por los
límites de ruido y distorsión del audio en profundidades de bits más bajas.

Tipo de tramado Controla en modo en que el ruido se distribuye en relación con el valor de amplitud original. Generalmente,
Triangular proporciona el menor desplazamiento entre la proporción señal a sonido, distorsión y modulación de sonido.

Tipo de tramado Reduce la proporción de señal a
ruido.

Modulación del ruido

Triangular 4,8 dB No

Gaussiano 6,0 dB Insignificante

Nota: Las opciones Triangular (con forma) y Gaussiano (con forma) mueven ligeramente más ruido en frecuencias más
altas. Para un control adicional, defina las opciones de Forma de ruido.

Forma de ruido Determina qué frecuencias pueden incluir tramado de ruido. Al introducir la forma de ruido, puede que sea
posible utilizar profundidades de tramado más bajas sin introducir efectos no deseados audibles. La mejor forma depende del
audio de origen, la velocidad de muestreo final y la profundidad de bits.
Nota: Forma de ruido se desactiva para las velocidades de muestreo inferiores a 32 Khz, ya que todo el ruido permanecería
en frecuencias audibles.

Pase alto  Con una forma extendida establecida en 7,3 kHz, el ruido de tramado disminuye en -180 dB a 0 Hz y -162
dB a 100 Hz.

Pendiente ligera  Con una forma extendida establecida en 11 kHz, el ruido de tramado disminuye en -3 dB a 0 Hz y -
10 dB a 5 Hz.

Neutro El sonido ligero baja de tono a 14 kHz, las pendientes aumentan el tono hasta un máximo a 17 kHz y el tono
vuelve a bajarse en las frecuencias más altas. El ruido de fondo suena igual que lo hace sin forma de ruido pero es
11dB más bajo.

El sonido fuerte baja de tono hasta 15,5 kHz, situando todo el ruido de tramado en un nivel superior a 16 kHz (o
donde se especifique la forma extendida). Los oídos más sensibles pueden escuchar un tono alto si la forma
extendida es demasiado baja. Sin embargo, si se realiza una conversión de audio de 48 o 96 kHz, la forma extendida
se puede situar en un nivel superior a 20 kHz.

Seleccione una forma neutral para evitar desde el punto de vista sónico dar timbre al silbido de fondo. No
obstante, se debe tener en cuenta que el silbido sonará más fuerte que con otras formas.

Forma de U  El valor Superficial es principalmente plano o muy bajo desde 2 kHz hasta 14 kHz, pero aumenta
conforme el audio alcanza 0 Hz, ya que las frecuencias bajas son mucho menos audibles. El valor Medio aporta algo
más de ruido en los altos en un valor superior a 9 kHz, permitiendo un ruido más bajo en un valor inferior a esa
frecuencia. El valor Profundo aumenta el ruido en un valor superior a 9 kHz incluso más, pero también lo baja mucho
más en el rango 2-6 kHz.

Ponderado  El valor Ligero intenta igualar el modo en que el oído percibe los sonidos de nivel bajo, reduciendo más
el ruido en el rango 2-6 kHz y subiéndolo en el intervalo 10-14 kHz. Con los volúmenes altos, el silbido puede ser más
perceptible. El valor Fuerte reduce de modo más uniforme el rango 2-6 KHz más sensible a expensas de más ruido
en un nivel superior a 8 kHz.

Forma extendida Especifica la frecuencia sobre la cual se producirá la forma de ruido.

Intensidad Especifique la amplitud máxima de ruido añadido a cualquier frecuencia.
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Modo adaptativo Varía la distribución del ruido en las frecuencias.

Uso de ajustes preestablecidos de conversión de la velocidad de muestreo
Si debe realizar la misma conversión en varios archivos, puede ahorrar tiempo usando un ajuste preestablecido de conversión de la velocidad de
muestreo.

1. Elija Editar > Convertir tipo de muestra.
2. Ajuste los ajustes como desee.

3. Haga clic en el botón Nuevo ajuste preestablecido .

Después de crear un ajuste preestablecido, aparece en la lista de ajustes preestablecidos de la parte superior del cuadro de
diálogo. Si desea eliminar un ajuste preestablecido, elíjalo de la lista y haga clic en Eliminar .
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Inversión de una forma de onda
El efecto Invertir invierte la fase de audio en 180 grados. (Para entender los grados de fase, consulte Medidas de la forma de onda.)

La inversión no produce ningún cambio perceptible en una forma de onda individual aunque se puede escuchar una diferencia al combinar formas
de onda. Por ejemplo, puede invertir el audio pegado para alinearlo con el audio existente. O puede invertir un canal de un archivo estéreo para
corregir una grabación desfasada.

1. Si desea invertir parte de una forma de onda, seleccione el intervalo deseado. O, anule la selección de todos los datos de
audio para invertir toda la forma de onda.

2. Elija Efectos > Invertir.

Reversión de una onda de forma
El efecto Revertir revierte una forma de onda de derecha a izquierda, de forma que se reproduce hacia atrás. La reversión resulta útil para crear
efectos especiales.

1. Si desea revertir parte de una forma de onda, seleccione el intervalo deseado. O, anule la selección de todos los datos de
audio para revertir toda la forma de onda.

2. Elija Efectos > Revertir.

Creación de silencio
La creación de silencio resulta útil para insertar pausas y eliminar ruidos no esenciales de un archivo de audio. Adobe Audition ofrece dos formas
de crear silencio:

Para silenciar el audio existente en el Editor de forma de onda, seleccione el contenido deseado y elija Efectos > Silencio. A
diferencia de la eliminación o corte de una selección, que une el material envolvente, el silencio deja la duración de la
selección intacta.

Para añadir silencio en el Editor multipista o de forma de onda, sitúe el indicador de tiempo actual  o seleccione el audio
existente. A continuación, seleccione Editar > Insertar >Silencio e indique el número de segundos. Todo el audio a la derecha
se alarga, lo que prolonga a su vez la duración. Los clips multipista se dividen si es necesario.

Más temas de ayuda
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Selección de rangos de tiempo

1. En la barra de herramientas, elija la herramienta Selección de tiempo .
2. Realice cualquiera de las acciones siguientes:

Para seleccionar un intervalo, arrastre en el panel Editor.

Arrastre para seleccionar intervalos de tiempo

Para ampliar o acortar una selección, arrastre los bordes de la selección. (Presione Mayús y haga clic más allá de los
bordes para ampliar más rápido una selección en un lugar específico.)

Nota: Si lo prefiere, puede hacer clic con el botón derecho para ampliar o acortar una selección. Para habilitar esta
característica, seleccione Ampliar selección en la sección General del cuadro de diálogo Preferencias.

Selección de rangos espectrales
Al trabajar en una visualización espectral, puede usar la herramienta de Selección de pincel, Recuadro o Lazo para seleccionar datos de audio
dentro de unos rangos espectrales específicos. La herramienta Selección de recuadro permite seleccionar un área rectangular. Las herramientas
Selección de lazo y Selección de pincel permiten realizar selecciones de forma libre. Las tres herramientas permiten una edición y procesamiento
detallados, incluida una flexibilidad increíble en el trabajo de restauración de audio. Por ejemplo, si encuentra efectos de audio no deseados,
puede seleccionar y editar únicamente las frecuencias afectadas y obtener mejores resultados en menos tiempo de procesamiento.

La herramienta Selección de pincel crea selecciones exclusivas que determinan la intensidad de los efectos aplicados. Para ajustar la intensidad,
cualquier pincel de capa traza o cambia el ajuste Opacidad en la barra de herramientas. Cuanto más opaca sea el área blanca seleccionada, más
intensos serán los efectos aplicados.
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Tipos de selecciones espectrales
A.  Recuadro B.  Lazo C.  Pincel

1. En la barra de herramientas, seleccione la herramienta Recuadro , Lazo  o Selección de pincel .
2. En el panel Editor, arrastre en la visualización espectral para seleccionar los datos de audio deseados.

Nota: Cuando realice una selección en una forma de onda estéreo, la selección se aplica a ambos canales de forma
predeterminada. Para seleccionar datos de audio en canales específicos, selecciónelos en el menú Editar > Activar canales.

3. Para ajustar la selección, realice cualquiera de las acciones siguientes:

Para mover la selección, coloque el puntero en ella y arrástrela a la ubicación deseada.

Para redimensionar la selección, coloque el puntero en la esquina o el extremo de la selección y arrástrela hasta que
tenga el tamaño deseado. (Para las selecciones del pincel, también puede modificar el ajuste Tamaño de pincel en la
barra de herramientas.)

Para agregarla a una selección de lazo o de pincel, presione Mayús y arrastre. Para retirarla de la selección, presione Alt
y arrastre.

Para determinar la intensidad de efectos aplicados a las selecciones de pincel, modifique el ajuste Opacidad en la barra
de herramientas.

De forma predeterminada, Adobe Audition solo reproduce audio en la selección espectral. Para escuchar todo el audio en el mismo intervalo
de tiempo, haga clic con el botón derecho en el botón Reproducir y anule la selección de la opción Reproducir solo la selección espectral.

Selección y reparación automática de efectos no deseados
Para reparar con rapidez efectos de audio individuales y pequeños no deseados como chasquidos o detonaciones, utilice el Pincel de limpieza
puntual. Al seleccionar el audio con esta herramienta, se aplica automáticamente el comando Favoritos > Limpieza automática.

Nota: La limpieza automática se optimiza para pequeños efectos de audio y se limita a las selecciones de cuatro segundos o menos.

1. En la barra de herramientas, seleccione Pincel de limpieza puntual .
2. Para cambiar el diámetro de píxel, ajuste la configuración del Tamaño. O bien, presione las teclas de corchete.
3. En el panel Editor, haga clic o mantenga presionado o arrastre un efecto no deseado de audio en la visualización espectral.

Nota: Si hace clic sin mantener presionado el botón del ratón, Audition mueve el indicador de tiempo actual para que se
pueda previsualizar el audio, pero no lo repara. Para reparar el audio haciendo clic, seleccione Crear selección circular al
bajar el ratón en las preferencias generales.

Eliminación instantánea de un efecto no deseado con el Pincel de limpieza puntual.
A.  Antes B.  Después
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Selección de una forma de onda completa
 Realice una de las siguientes acciones:

Para seleccionar el rango visible de una forma de onda, haga doble clic en el panel Editor.

Para seleccionar toda la forma de onda, haga clic tres veces en el panel Editor.

Especificación de los canales que desea editar
De forma predeterminada, Adobe Audition aplica selecciones y ediciones a los dos canales de una forma de onda estéreo o envolvente. Sin
embargo, puede seleccionar y editar con facilidad los canales específicos.

 A la derecha del panel Editor, haga clic en los botones del canal en la regla de amplitud. Para un archivo estéreo, por ejemplo, haga clic en el
botón del canal izquierdo  o canal derecho .

Para seleccionar un canal estéreo simplemente arrastrándose en la parte superior o inferior del panel Editor, seleccione Permitir edición de
canal contextual en la sección General del cuadro de diálogo Preferencias.

Selección de canales específicos de un archivo envolvente 5.1

Ajuste de una selección a puntos de intersección cero
Para muchas tareas de edición como, por ejemplo, eliminación o inserción de audio, las intersecciones cero (puntos donde la amplitud es cero)
son los mejores lugares para realizar selecciones. Las selecciones que comienzan y terminan en intersecciones cero reducen la posibilidad de
que las ediciones creen chasquidos o detonaciones que puedan escucharse.

 Para ajustar una selección a los puntos de intersección cero más cercanos, seleccione Editar > Intersecciones cero. Después seleccione una
opción como, por ejemplo, Ajustar selección hacia dentro (que mueve ambos bordes a la siguiente intersección cero).

Para reducir más la posibilidad de detonaciones o chasquidos, todas las ediciones son de fundido cruzado. Es posible cambiar las duraciones
de fundido cruzado en la sección Datos del cuadro de diálogo Preferencias.

Ajuste a marcadores, reglas, fotogramas e intersecciones cero
Ajustando hace que los límites de la selección y el indicador de tiempo actual se desplacen hacia elementos como marcadores, marcas de regla,
puntos de intersección cero y fotogramas. Si habilita el ajuste, podrá realizar selecciones precisas; no obstante, si lo prefiere, puede deshabilitarlo
para elementos concretos.

1. Para activar el ajuste de los elementos seleccionados, haga clic en el icono Conmutar ajuste en la parte  superior del
panel Editor.

2. Para especificar los elementos que se van a ajustar, seleccione Editar > Ajuste y elija una de las siguientes opciones:
Ajustar a marcadores Ajusta a un punto de marcador. Para obtener información acerca de la definición de marcadores,
consulte Uso de marcadores.

Ajustar a la regla (aproximado) Solo se ajusta a las divisiones numéricas principales (como minutos y segundos) en la línea
de tiempo.
Nota: Puede habilitar solo un comando Ajustar a la regla cada vez.

http://helpx.adobe.com/en/audition/using/markers.html


 

Ajustar a la regla (fino) Se ajusta a las subdivisiones (como milisegundos) en la línea de tiempo. Acerque la selección (haga
clic con el botón derecho y arrastre en la línea de tiempo) para ver las subdivisiones con más exactitud y sitúe el cursor con
más precisión.

Ajustar a intersecciones cero Ajusta al lugar más cercano en el que el audio cruza la línea central (punto de amplitud cero).

Ajustar a fotogramas Ajusta a un límite de fotograma si el formato de tiempo se mide en fotogramas (como en un CD o en
SMPTE).

Puede obtener acceso a los comandos de ajuste si hace clic con el botón derecho en la línea de tiempo.

Más temas de ayuda
Acerca de la visualización espectral

Personalización de la visualización espectral

Ajuste a puntos finales de clip
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Cómo deshacer y rehacer el historial
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Operación de deshacer o rehacer cambios
Comparación de los estados de historial

Operación de deshacer o rehacer cambios
Cada vez que inicia Adobe Audition, realiza el seguimiento de las modificaciones que realiza. Las ediciones no se aplican de forma permanente
hasta que guarde y cierre un archivo, lo que proporciona una capacidad ilimitada para las opciones de deshacer y rehacer.

 Para deshacer o rehacer los cambios, realice cualquiera de las acciones siguientes:

Para deshacer un cambio, elija Edición > Deshacer [nombre del cambio].

Para rehacer un cambio, elija Editar > Rehacer [nombre del cambio].

Para repetir el último comando, en el Editor de forma de onda, elija Edición > Repetir último comando. Puede repetir la
mayoría de los comandos; sin embargo, existen algunas excepciones (como Eliminar).

Para repetir el último comando sin abrir su cuadro de diálogo, presione Ctrl+R (Windows) o Comando+R (Mac OS).

Comparación de los estados de historial
Los comandos Deshacer y Rehacer tienen como limitación el hecho de que los cambios se realizan en una secuencia incremental, mientras que
el panel Historia permite volver inmediatamente a cualquier cambio anterior. Use este panel para comparar rápidamente el audio procesado con el
original, o rechazar una serie de cambios que produjeron resultados insatisfactorios.

Nota: Los estados de historial desaparecen cuando se cierra un archivo.

Vuelta a un estado

Para volver a un estado histórico, haga clic en él.

Para desplazarse de forma incremental por los estados, presione las flechas arriba y abajo del teclado.

Eliminación de un estado
Al trabajar con archivos de audio muy grandes, elimine los estados históricos innecesarios para liberar espacio en el disco y mejorar el
rendimiento.

Para eliminar todos los estados, elija Borrar historia en el menú del panel .

Para eliminar un estado en particular, selecciónelo y, a continuación, haga clic en el icono de la papelera .

Nota: Al eliminar los estados de historia se eliminan también los comandos Deshacer.

  |  
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Fusión y cambio de amplitud visual
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Aparición o desaparición visual
Elevación o disminución visual de la amplitud
Posicionar u ocultar el control de amplitud visual

Con el uso de varios efectos puede cambiar la amplitud o producir transiciones, transición visual y controles de ganancia que hagan que esta tarea
sea rápida e intuitiva. Al arrastrar estos controles al panel Editor, una vista previa le ayuda a ajustar el audio con precisión.

Controles visuales en el panel Editor
A.  Controles de fusión B.  Control Ganancia (visualización frontal)

Para una transición rápida del audio seleccionado, seleccione Favoritos > Aparecer o Desaparecer.

Aparición o desaparición visual
Adobe Audition ofrece tres tipos de transiciones visuales:

Las fusiones lineales producen un cambio de volumen que funciona bien para muchos materiales. Si la transición suena
demasiado brusca, pruebe una de las demás opciones.

Las fusiones logarítmicas cambian con de forma uniforme el volumen de lento a rápido o viceversa.

Las fusiones de coseno tienen la forma de una curva en S, que cambia el volumen lentamente al principio, rápidamente en la
mayor parte de la fusión y lentamente al final.

Nota: En el Editor de forma de onda, las transiciones cambian datos de audio de forma permanente. Para aplicar transiciones, se puede realizar
un reajuste en el Editor multipista. Consulte Fundido o fundido cruzado de clips multipista.

Tipos de fusión
A.  Lineal B.  Logarítmica C.  Coseno

 En la forma de onda superior izquierda o derecha, arrastre el control Aparecer  o Desaparecer  hacia dentro y haga lo siguiente:

Para una fusión lineal, realice un arrastre perfectamente en horizontal.

Para una fusión logarítmica, realice el arrastre arriba o abajo.

Para un fundido de coseno (curva S), mantenga presionado Ctrl (Windows) o Comando (Mac OS).

Para crear transiciones de coseno de forma predeterminada y presionar las teclas anteriores para crear transiciones logarítmicas o lineales,
cambie la configuración de la transición predeterminada en las preferencias generales.

Elevación o disminución visual de la amplitud
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1. En el panel Editor, seleccione el audio específico o no elija nada para ajustar todo el archivo.
2. En el control de ganancia de que flota sobre el panel, arrastre el control o los números.

Los números indican cómo se compara la amplitud nueva con la existente. Cuando suelta el botón del ratón, los números
vuelven al valor 0 dB, de forma que puede realizar ajustes ulteriores.

Modificación del volumen de un área seleccionada

Posicionar u ocultar el control de amplitud visual
De forma predeterminada, el control de amplitud visual aparece en una pantalla de visualización frontal (HUD) que flota sobre todas las formas de
onda. Si le distrae la pantalla HUD, realice lo siguiente:

Para bloquear la pantalla HUD en un lugar, haga clic en el botón Posicionar .

Para mostrar la pantalla HUD solo sobre las selecciones resaltadas, seleccione Mostrar HUD solo para rangos de selección
en las preferencias generales.

Para ocultar totalmente la pantalla HUD, anule la sección de Ver > Mostrar HUD.

Más temas de ayuda

  |  
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Effects controls
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Effects Rack overview
Use effect presets
Control effect settings with graphs
About spline curves for graphs

Effects Rack overview
The Effects Rack lets you insert, edit, and reorder up to 16 effects, optimize mix levels, and store favorite presets. Most rack controls appear in
both the Waveform and Multitrack editors.

Controls shared by the Waveform and Multitrack editors 
A. Rack Preset controls B. Effect slots C. Level controls D. Main Power button 

Controls unique to the Waveform Editor
In the Waveform Editor, the Effects Rack provides a Process menu that that lets you modify a selection or the entire file, and an Apply button that
permanently applies effects.

Controls unique to the Waveform Editor 
A. Apply button permanently applies effects B. Process menu lets you modify selection or entire file 

Controls unique to the Multitrack Editor
The Effects Rack provides Pre-render Track and FX Pre/Post-Fader buttons that you use to optimize and route effects. Each clip and track has its
own Effects Rack, which is saved with the session.

Buses and the Master track lack a Pre-render option because processing effects from all source tracks would reduce performance.

Controls unique to the Multitrack Editor 
A. FX Pre/Post-Fader B. Pre-render 

Set input, output, and mix levels in racks
To optimize volume, adjust Input and Output levels so their meters peak without clipping.
To change the percentage of processed audio, drag the Mix slider. 100% (Wet) equals fully processed audio; 0% (Dry) equals
original, unprocessed audio.

Insert, bypass, reorder, or remove effects in racks
In the Effects Rack, you manage groups of effects by using individual effect slots.

In the Multitrack Editor, the fx section of the Editor panel or Mixer provides quick access to slots in the Effects Rack.
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Reordering and inserting effects in racks: 
A. Reorder by dragging B. Insert with the slot menu 

To insert an effect, choose it from a slot’s pop-up menu. Then adjust effect settings as desired.

To later reaccess effect settings, double-click the effect name in the rack.

To bypass an effect, click its Power button .

To bypass all effects, click the main Power button in the lower left corner of a rack, or the fx power button in the Editor panel or
Mixer.

To bypass a selected group of effects, choose Toggle Power State of Selected Effects from the panel menu .

Bypass effects to quickly compare processed and unprocessed audio.

To remove a single effect, choose Remove Effect from a slot’s pop-up menu. Or select the slot, and press Delete.

To remove all effects, choose Remove All Effects from the panel menu .

To reorder effects, drag them to different slots.

Reordering effects produces different sonic results. (For an example, place Reverb prior to Phaser, and vice versa.)

Use effect presets
Many effects provide presets that let you store and recall favorite settings. In addition to effect-specific presets, the Effects Rack provides rack
presets that store groups of effects and settings.

To apply a preset, choose it from the Presets menu.

1. To save current settings as a preset, click the New Preset button .

To delete a preset, select it, and click the Delete button .

To modify an existing preset, apply it, adjust settings as desired, and then save a new preset with the same name.

Control effect settings with graphs
Many Adobe Audition effects provide graphs where you can adjust parameters. By adding and moving control points on the graph, you can
precisely tailor effect settings.

Graph control points function together with related numerical settings. If you change or disable a numerical setting, the related graph control
follows suit.
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Moving a control point changes the related settings, and vice versa.

To move a point on a graph, drag it to a new location.

The following techniques don’t apply to the DeHummer, Mastering, Full Reverb, Parametric Equalizer, and Track EQ
graphs.

To add a control point to a graph, click in the grid at the location where you want to place the point.

To enter numeric values for a control point, right-click it, and choose Edit Point

To remove a point from a graph, drag it off the graph.

To return a graph to its default state, click the Reset button .

About spline curves for graphs
By default, graphs display straight lines between control points. However, some graphs provide a Spline Curves option that creates a curve
between control points for smoother transitions.

When you use spline curves, lines don’t travel directly through control points. Instead, the points control the shape of the curve. To move the
curve closer to a control point, click near it to create a cluster of control points.

Graph with straight lines compared to graph with spline curves

Apply groups of effects in the Waveform Editor

Favorites
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To the top

To the top

To the top

Apply effects to clips or tracks
Pre-render track effects to improve performance
Insert effects before or after sends and EQ

Apply effects to clips or tracks
In the Multitrack Editor, you can apply up to 16 effects to each clip, track, and bus and adjust them while a mix plays. (Apply clip effects if a track
contains multiple clips that you want to process independently.)

You can insert, reorder, and remove effects in the Editor, Mixer, or Effects Rack panel. Only in the Effects Rack, however, can you save favorite
settings as presets, which you can apply to multiple tracks.

In the Multitrack Editor, effects are nondestructive, so you can change them at any time. To readapt a session for different projects, for example,
simply reopen it and change effects to create new sonic textures.

Revealing effect slots in the Editor panel

1. Do any of the following:
Select a clip, and click Clip Effects at the top of the Effects Rack.

Select a track, and click Track Effects at the top of the Effects Rack.

Display the fx section of the Editor or Mixer. (In the Editor panel, click the button  in the upper-left corner.)

2. Choose effects for up to 16 slots in the list. (See Insert, bypass, reorder, or remove effects in racks.)
3. Press the spacebar to play the session, and then edit, reorder, or remove effects as needed.

To change effect settings over time, use envelopes. (See Automating mixes with envelopes.)

Pre-render track effects to improve performance
In the Multitrack Editor, pre-render track effects to address heavy CPU usage, improving performance for complex mixes or low-latency recording.
(Latency measures the delay between user input and sound output from a computer. If latency is high, it produces an audible echo during
recording, disrupting timing for musicians.)

You can continue to edit track settings normally; pre-rendering processes audio when pauses occur in playback or editing.

In the Editor panel, Effects Rack, or Mixer, click the Pre-Render Track button .

Insert effects before or after sends and EQ
On each track, you can insert effects either pre- or post-fader. Pre-fader effects process audio before sends and EQ. Post-fader effects process
audio after sends and EQ. For most mixes, the default, pre-fader setting works well. The post-fader setting offers signal-routing flexibility for
particularly complex mixes.

In the fx section of the Editor panel or Mixer, click the Pre-Fader/Post-Fader button to insert effects either before sends and
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EQ , or after .

If you’re editing effect settings in the Effects Rack, click the Pre-Fader/Post-Fader button in the lower-left corner.

Pre- and post-fader effect and send routing for each track: 
A. Input B. EQ C. Volume D. Mute E. Send F. Effects Rack 

Routing audio to buses, sends, and the Master track

Set up a send
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Adición de plugins de terceros

 

Los plugins de terceros permiten ampliar los ya potentes efectos que se suministran en Adobe Audition. La aplicación admite los plugins VST en
ambas plataformas y los plugins Audio Units en Mac OS.

La aplicación de efectos de plugins es idéntica a la de los efectos incorporados. Para obtener más información sobre las características de los
plugins, consulte la documentación suministrada por los fabricantes de plugins.

Activación de los plugin VST y Audio Units
Para acceder a plugins de terceros en Adobe Audition, en primer lugar debe habilitarlos. De forma predeterminada, todos los plugins se terceros
se encuentran desactivados. Para mejorar el rendimiento, habilite solo los plugins que va a utilizar en Adobe Audition.

Nota: Si se están utilizando efectos en una sesión multipista, cierre la sesión.

1. Seleccione Efectos > Administrador de plugins de audio.

2. En la sección Carpetas del plugin, haga clic en Agregar para especificar las carpetas personalizadas donde desee buscar los
plugins VST. Haga clic en Predeterminado para especificar la carpeta VST estándar para su sistema operativo.

3. En la sección Plugins disponibles, haga clic en Explorar plugins.

Si ha actualizado recientemente un plugin, seleccione Volver a explorar plugins existentes.

4. Seleccione los plugins a los que desee acceder en Adobe Audition y, a continuación, haga clic en Aceptar.

Nota: Si un efecto de terceros no es compatible, Adobe Audition lo agrega a un submenú de efectos no compatibles en los menús de efectos.

Más temas de ayuda
Aplicación de efectos en el Editor multipista

Automatización de los ajustes de pista
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Aplicación de grupos de efectos en el Editor de forma de onda
Aplicación de efectos individuales en el Editor de forma de onda
Acerca de los efectos del proceso

Mientras se previsualizan los efectos, se pueden ajustar las selecciones y el indicador de tiempo actual en el panel Editor. (Los efectos
Normalizar y Expansión son excepciones.)

Aplicación de grupos de efectos en el Editor de forma de onda
En el Editor de forma de onda, el Bastidor de efectos permite aplicar grupos de efectos. (No se incluyen efectos de proceso como, por ejemplo,
Reducción de ruido, que se debe aplicar individualmente.)

1. Seleccione Ventana > Bastidor de efectos.
2. En la lista numerada, seleccione efectos para 16 ranuras como máximo. (Consulte Inserción, omisión, reordenación o

eliminación de efectos de los bastidores.)
3. Inicie la reproducción para previsualizar los cambios y después edite, mezcle y reordene los efectos según sea necesario.

Para comparar el audio procesado con el original, seleccione y anule la selección del botón de potencia principal situado
en la esquina inferior izquierda del bastidor o en los botones de potencia de los efectos individuales.

4. Para aplicar los cambios a los datos de audio, haga clic en Aplicar.
Para almacenar los ajustes, guarde un ajuste preestablecido de bastidor. (Consulte Uso de los ajustes preestablecidos de
efectos.)

Aplicación de efectos individuales en el Editor de forma de onda
1. Elija un efecto en cualquier submenú del menú Efectos.

2. Haga clic en el botón Previsualización  y, a continuación, edite los ajustes según sea necesario.
A medida que edita los ajustes, observe el panel Niveles para optimizar la amplitud.

3. Para comparar el audio original con el audio procesado, seleccione y anule la selección del botón Potencia .
4. Para aplicar los cambios a los datos de audio, haga clic en Aplicar.

Acerca de los efectos del proceso
Puede identificar los efectos del proceso mediante la palabra proceso en los comandos de menú. Estos efectos intensivos de procesamiento solo
están disponibles sin conexión en el Editor de forma de onda. A diferencia de los efectos en tiempo real, los efectos de procesamiento se pueden
aplicar solo individualmente, por lo que no se podrá acceder a los mismos en el Bastidor de efectos.

Más temas de ayuda
Introducción al Bastidor de efectos

Utilización de ajustes preestablecidos de efectos

Control de ajustes de efectos con gráficos
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Efecto Amplificación
Efecto Mezclador de canales
Efecto DeEsser
Efecto Procesamiento dinámico
Efecto Limitador forzado
Efecto Compresor multibanda
Efecto Normalizar (solo Editor de forma de onda)
Efecto Compresor de una sola banda
Efecto Nivelador de volumen de voz
Efecto Compresor en forma de tubo
Efecto Envolvente de volumen (solo Editor de forma de onda en CS5.5)

Efecto Amplificación
El efecto Amplitud y compresión > Amplificación aumenta o atenúa una señal de audio. Debido a que el efecto funciona en tiempo real, se puede
combinar con otros efectos en el Bastidor de efectos.

Reguladores de ganancia Canales de audio individuales de amplificación o atenuación.
Vincular reguladores Desplaza los reguladores de canales de forma conjunta.

Efecto Mezclador de canales
El efecto Amplitud y compresión > Mezclador de canales altera el equilibrio de los canales envolvente o estéreo, permitiendo cambiar la posición
aparente de sonidos, corregir los niveles coincidentes o solucionar los problemas de ajuste de fase.

Fichas de canal Selecciona el canal de salida.
Reguladores del canal de entrada Determina el porcentaje de los canales actuales para mezclar en el canal de salida. Por ejemplo, para un
archivo estéreo, un valor I de 50 un valor D de 50 tienen como resultado un canal de salida que contiene un audio igual para los canales
izquierdo y derecho actuales.
Invertir Invierte la fase de un canal. Para obtener más información sobre este concepto clave de audio, consulte Cómo interactúan las ondas de
sonido.) Al invertir todos los canales no se produce ninguna diferencia de sonido apreciable. Sin embargo, la inversión de un solo canal puede
cambiar en gran medida el sonido.

Efecto DeEsser
El efecto Amplitud y compresión > DeEsser elimina la sibilancia, los sonidos de tipo “silbido” que se escuchan cuando se habla o se canta y que
pueden distorsionar las altas frecuencias.

El gráfico muestra las frecuencias procesadas. Haga clic en el botón Previsualizar  para ver la cantidad de contenido de audio que existe en
el intervalo procesado.

Modo Seleccione Banda ancha para comprimir de modo uniforme todas las frecuencias o Multibanda para comprimir únicamente el intervalo de
sibilancia. Multibanda es más adecuado para la mayor parte del contenido de audio, pero aumenta ligeramente el tiempo de procesamiento.
Umbral Establece la amplitud sobre la cual se produce la compresión.
Frecuencia central Especifica la frecuencia en la que la sibilancia es más intensa. Para realizar la comprobación, ajuste esta opción mientras se
reproduce el audio.
Ancho de banda Determina el rango de frecuencia que activa el compresor.

Para ajustar visualmente la Frecuencia central y el Ancho de banda, arrastre los bordes de la selección en el gráfico.

Solo sibilancia de sonido Permite escuchar la sibilancia detectada. Inicie la reproducción y ajuste las opciones anteriores.
Reducción de ganancia Muestra el nivel de compresión de las frecuencias procesadas.

Efecto Procesamiento dinámico
El efecto Amplitud y compensación > Procesamiento Dinámico se puede utilizar como compresor, limitador o expansor. Como compresor o
limitador, este efecto reduce el intervalo dinámico y produce niveles constantes de volumen. Como expansor, aumenta el intervalo dinámico y
reduce el nivel de las señales de bajo nivel. (Con los ajustes máximos del expansor, es posible crear un control de ruido que elimine totalmente



un ruido inferior a un límite de amplitud específico.)

El efecto Procesamiento dinámico puede generar ligeros cambios que solo se notan después de varias audiciones. Para aplicar este efecto en el
Editor de forma de onda, utilice una copia del archivo original para poder volver al audio original si fuera necesario.

Utilice el ajuste preestablecido Limitador de emisión para simular el sonido procesado de una emisora de radio contemporánea.

Ficha Dinámica
Gráfico Representa el nivel de entrada a lo largo de la línea horizontal (eje x) y el nuevo nivel de salida a lo largo de la línea vertical (eje y). El
gráfico predeterminado, con una línea recta desde la parte inferior izquierda a la superior derecha, representa una señal que no se ha modificado,
dado que cada valor de entrada tiene el mismo nivel de salida. El ajuste del gráfico cambia la relación entre los niveles de entrada y salida,
alterando el rango dinámico.
Por ejemplo, si un elemento sónico deseable se produce a unos 20 dB, es posible amplificar la señal de entrada a dicho nivel, pero dejar todo los
demás parámetros sin modificar. También se puede dibujar una línea inversa (desde la parte superior izquierda hasta la inferior derecha) que
aumentará en gran medida los sonidos bajos y suprimirá los altos.

Agregar punto Añade un punto de control en el gráfico utilizando los niveles de entrada y salida especificados. Este método es más preciso
que hacer clic en el gráfico para agregar puntos.

Para ajustar numéricamente un punto de control existente, haga clic con el botón derecho en el mismo y seleccione Editar punto.

Eliminar punto Elimina el punto seleccionado del gráfico.

Invertir Voltea el gráfico, convirtiendo la compresión en expansión o viceversa.
Nota: Solo puede invertir un gráfico si tiene puntos en las dos esquinas predeterminadas (-100, -100 y 0, 0) y si el nivel de salida aumenta de
izquierda a derecha (es decir, cada punto de control debe ser superior al que se encuentra a su izquierda).

Restablecer Restablece el gráfico a su estado predeterminado.
Curvas polinomiales crea transiciones curvadas y más suaves entre los puntos de control, en lugar de transiciones lineales más bruscas.
(Consulte Acerca de las curvas polinomiales para gráficos.)
Ganancia de nivel Amplifica la señal procesada.

Ficha Ajustes
Generales Proporciona los ajustes generales.

Tiempo de avance  Aborda los puntos transitorios que se pueden producir al principio de señales muy altas que superan los ajustes de
Tiempo de ataque del compresor. La ampliación del tiempo de avance hace que la compresión se produzca antes de que aumente el
audio, garantizando que dicha amplitud nunca supere un determinado nivel. Por el contrario, la reducción del tiempo de avance puede ser
conveniente para mejorar la música de percusión de impacto como la batería.
Control de ruidos  Silencia por completo las señales que se amplían por debajo de una proporción de 50 a 1.

Detector de nivel Determina la amplitud de entrada original.

Ganancia de entrada  Se aplica la ganancia a la señal antes de que introduzca el detector de nivel.
Tiempo de ataque  Determina los milisegundos que la señal de entrada tarda en registrar un nivel de amplitud modificado. Por ejemplo, si
el audio disminuye 30 dB de pronto, el tiempo de ataque especificado pasa antes de que la señal registre un cambio de amplitud. Esto
evita lecturas de amplitud erróneas debido a cambios temporales.
Tiempo de liberación  Determina cuántos milisegundos se mantiene el nivel de amplitud actual antes de que pueda registrarse otro
cambio de amplitud.

Utilice los ajustes de liberación y ataque rápido para el audio con transitorios rápidos y ajustes más lentos para el audio con menos
percusión.

Modo Pico  Determina los niveles en función de los picos de amplitud. Este modo es un poco más difícil de utilizar que RMS, ya que los
picos no se reflejan de forma precisa en el gráfico de dinámica. Sin embargo, puede resultar útil cuando el audio tiene picos transitorios
altos que se desean reducir.
Modo RMS  Determina los niveles en función de la fórmula de raíz cuadrada media, un método de promedio que coincide más con el
modo en que se percibe el volumen. Este modo refleja precisamente las amplitudes en el gráfico de dinámica. Por ejemplo, un limitador
(línea horizontal plana) a 10 dB refleja una amplitud RMS media de 10 dB.

Procesador de ganancia Amplifica o atenúa la señal dependiendo de la amplitud detectada.

Ganancia de salida  Aplica ganancia a la señal de salida tras todo el procesamiento dinámico.
Tiempo de ataque  Determina los milisegundos que la señal de salida tarda en alcanzar el nivel especificado. Por ejemplo, si el audio
disminuye de pronto 30 dB, el tiempo de ataque especificado pasa antes de que cambie el nivel de salida.
Tiempo de liberación  Determina los milisegundos que se mantiene el nivel de salida actual.
Nota: Si la suma de los tiempos de ataque y liberación es demasiado breve (menos de unos 30 milisegundos), los efectos sonoros se
podrán oír. Para ver buenos tiempos de ataque y liberación para diferentes tipos de contenido de audio, seleccione distintas opciones del
menú Ajustes preestablecidos.
Vincular canales  Procesa todos los canales por igual, conservando el equilibro envolvente o estéreo. Por ejemplo, un golpe comprimido
de tambor en el canal izquierdo causará la reducción de nivel del canal derecho en la misma cantidad.

Limitación de banda Restringe el procesamiento dinámico a un rango de frecuencia específico.
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Límite bajo  Frecuencia más baja a la que puede afectar el procesamiento dinámico.
Límite alto  Frecuencia más alta a la que puede afectar el procesamiento dinámico.

Efecto Limitador forzado
El efecto Amplitud y compresión > Limitador forzado atenúa el audio que aumenta un umbral especificado. La limitación suele aplicarse con una
amplificación de entrada, una técnica que aumenta el volumen general mientras se evita la distorsión.

Amplitud máxima Define la amplitud máxima de muestreo permitida.
Para evitar el recorte cuando se trabaja con audio de 16 bits, establezca esta opción en un valor que no supere 0,3 dB. Si se establece aún
más bajo, en 3 dB, se dispondrá de algo más de espacio para futuras ediciones.

Amplificación de entrada Preamplifica el audio antes de que lo limite y aumenta el volumen de una selección sin recortarla. A medida que se
aumenta este nivel, aumenta la compresión. Pruebe los ajustes máximos para lograr el audio alto de gran impacto que se oye en la música pop
contemporánea.
Tiempo de avance Define la cantidad de tiempo (en milisegundos) que se necesita generalmente para atenuar el audio antes de alcanzar el pico
más alto.
Nota: Asegúrese de que el valor es de 5 milisegundos como mínimo. Si este valor es demasiado bajo, es posible que se produzcan distorsiones
auditivas.
Tiempo de liberación Define el tiempo (en milisegundos) necesario para que la atenuación se reduzca 12 dB (o el tiempo aproximado necesario
para que el audio recupere el volumen normal si se ha encontrado un pico extremadamente alto). En general, un valor aproximado de 100 (el
valor predeterminado) funciona bien y evita frecuencias de graves muy bajas.
Nota: Si este valor es demasiado alto, el audio puede permanecer en un nivel sonoro muy bajo y no recobrar los niveles normales durante un
tiempo.
Vincular canales Vincula el volumen de todos los canales de forma conjunta, conservando el equilibro envolvente o estéreo.

Efecto Compresor multibanda
El efecto Amplitud y compresión > Compresor Multibanda permite comprimir cuatro bandas de frecuencia diferentes de forma independiente. Dado
que cada banda suele incluir contenido dinámico único, la compresión multibanda es una herramienta muy potente para crear originales de audio.

Los controles del Compresor multibanda permiten definir con precisión frecuencias de formas extendidas y aplicar ajustes de compresión
específicos de la banda. Haga clic en los botones Solo para previsualizar bandas aisladas o en los botones Omitir para pasar bandas sin
procesarlas. Después de ajustar las bandas individuales, seleccione Controles de banda de enlace para ajustarlas globalmente y, a continuación,
optimice el volumen global con el control de ganancia de salida y los ajustes del limitador.

Para cambiar los ajustes de compresión más adelante, utilice rutas de automatización en el Editor multipista. (Consulte Automatización de los
ajustes de pista.)

Ajuste de una frecuencia de forma extendida en el Compresor multibanda
A.  Bandas de frecuencia B.  Marcadores extendidos C.  Banda omitida (sin procesamiento) D.  Escala de amplitud E.  Escala de frecuencia

Forma extendida Define las frecuencias de forma extendida que determinan la anchura de cada banda. Puede introducir frecuencias bajas,
medias y altas específicas o arrastrar sobre el gráfico los marcadores de forma extendida.
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Controles específicos de la banda en el compresor multibanda
A.  Solo B.  Omitir C.  Control Umbral D.  Medidores de Nivel de entrada E.  Medidores de Reducción de ganancia

Botones Solo Permiten escuchar bandas de frecuencia específicas. Habilite un botón Solo cada vez para escuchar bandas aisladas o varios
botones para escuchar dos o más bandas al mismo tiempo.
Botones Omitir Omiten bandas individuales para que pasen sin procesarse.

Presione Alt (Windows) u Opción (Mac OS) y haga clic en los botones Solo u Omitir para aplicar rápidamente un ajuste único a una banda.

Controles de Umbral Definen el nivel de entrada en el que comienza la compresión. Los valores posibles están comprendidos entre -60 y 0 dB.
El ajuste óptimo depende del contenido de audio y el estilo musical. Para comprimir solo picos extremos y conservar un intervalo más dinámico,
utilice umbrales de alrededor de 5 dB por debajo del nivel de entrada pico; para comprimir el audio y reducir el intervalo dinámico
considerablemente, utilice ajustes de alrededor de 15 dB por debajo del nivel de entrada pico.
Medidores de Nivel de entrada Miden la amplitud de la entrada. Haga doble clic en los medidores para restablecer los indicadores de pico y
clip.
Medidores de Reducción de ganancia Miden la reducción de amplitud con medidores de color rojo que se extienden desde la parte superior
(reducción mínima) hasta la parte inferior (reducción máxima).
Ganancia Aumenta o corta la amplitud después de la compresión. Los valores posibles están comprendidos entre -18 y +18 dB, siendo 0 la
ganancia unitaria.
Proporción Define una proporción de compresión entre 1-a-1 y 30-a-1. Por ejemplo, un ajuste de 3.0 emite 1 dB por cada 3 dB de aumento
sobre el umbral de compresión. Los ajustes habituales van de 2,0 a 5,0; unos ajustes más elevados producen el sonido extremadamente
comprimido que se oye en la música pop.
Ataque Determina la rapidez con la que se aplica la compresión cuando el audio sobrepasa el umbral. Los valores posibles están comprendidos
entre 0 y 500 milisegundos. El valor predeterminado de 10 milisegundos funciona bien para un intervalo de audio muy amplio. Un ajuste más
rápido puede funcionar mejor para audio con transitorios rápidos, pero este tipo de ajustes suena poco natural con audio con menos percusión.
Liberar Determina la rapidez con la que se detiene la compresión cuando el audio cae por debajo del umbral. Los valores posibles están
comprendidos entre 0 y 5.000 milisegundos. El valor predeterminado de 100 milisegundos funciona bien para un intervalo de audio muy amplio.
Pruebe ajustes más rápidos para audio con transitorios rápidos, y más lentos para audio con menos percusión.
Ganancia de salida Aumenta o corta el nivel de salida global después de la compresión. Los valores posibles están comprendidos entre -18 y
+18 dB, siendo 0 la ganancia unitaria. Haga doble clic en los medidores para restablecer los indicadores de pico y clip.
Limitador Aplica límites después de la ganancia de salida y al final del trazado de la señal, con lo que se optimizan los niveles generales.
Especifique ajustes de Umbral, Ataque y Liberar, que son menos agresivos que los ajustes específicos de banda similares. A continuación,
especifique un ajuste Margen para determinar el techo absoluto relacionado con 0 dBFS.

Para crear audio muy comprimido, habilite el Limitador y, a continuación, experimente con ajustes de Ganancia de salida muy altos.

Espectro de entrada Muestra en el gráfico multibanda el espectro de frecuencia de la señal de entrada, en lugar del de la señal de salida. Para
comprobar rápidamente la cantidad de compresión aplicada a cada banda, active o desactive esta opción.
Limitador Brickwall Aplica limitación inmediata y forzada al ajuste Margen actual. (Anule la selección de esta opción para aplicar límites suaves
más lentos que suenan menos comprimidos pero que pueden superar el ajuste de Margen.)
Nota: El tiempo máximo de Ataque para los límites “brickwall” es de 5 ms.
Controles de banda de enlace Permiten definir globalmente los ajustes de compresión de todas las bandas pero mantienen diferencias relativas
entre bandas.

Para vincular controles de banda temporalmente, mantenga presionado Alt+Mayús (Windows) u Opción+Mayús(Mac OS). Para restablecer un
control en todas las bandas, mantenga presionado Ctrl+Alt+Mayús (Windows) o Comando+Opción+Mayús (Mac OS) y haga clic en el control.

Efecto Normalizar (solo Editor de forma de onda)
Nota: Este efecto requiere el procesamiento sin conexión. Mientras está abierto, no es posible editar la forma de onda, ajustar las selecciones ni
mover el indicador de tiempo actual.
El efecto Amplitud y compresión > Normalizar permite definir un nivel máximo para un archivo o selección. Al normalizar el audio al 100%, se
obtiene la máxima amplitud que permite el audio digital, 0 dBFS. Sin embargo, si va a enviar audio a un ingeniero de creación de originales,
normalice el audio entre –3 y –6 dBFS, con lo que tendrá un margen para próximos procesamientos.
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El efecto Normalizar amplifica por igual el archivo completo o la selección. Por ejemplo, si el audio original alcanza un pico alto de 80% y un pico
bajo de 20%, al normalizar al 100% el pico alto se amplifica al 100% y el bajo al 40%.

Para aplicar la normalización RMS, seleccione Efectos > Volumen de coincidencia. Si lo desea, puede aplicar este comando a un solo archivo.
(Consulte Coincidencia de volumen en varios archivos.)

Normalizar a Establece el porcentaje del pico más alto relativo a la amplitud máxima posible.
Seleccione dB para introducir el valor Normalizar en decibelios en lugar de un porcentaje.

Normalizar todos los canales por igual Utiliza todos los canales de una forma de onda envolvente o estéreo para calcular la cantidad de
amplificación. Si se anula la selección de esta opción, la cantidad se calcula por separado para los canales y es posible que uno se amplifique
mucho más que los demás.
Ajustar diferencia de DC Permite ajustar la posición de la forma de onda en la visualización de onda. Algunos tipos de hardware de grabación
pueden introducir un desplazamiento de DC, lo que hace que la forma de onda grabada aparezca por encima o por debajo de la línea central
normal en la visualización de la onda. Para centrar la forma de onda, ajuste el porcentaje en cero. Para desfasar toda la forma de onda
seleccionada por encima o por debajo de la línea central, especifique un porcentaje positivo o negativo.

Efecto Compresor de una sola banda
El efecto Amplitud y compresión > Compresor de una sola banda reduce el rango dinámico, produciendo niveles de volumen uniformes e
incrementa el volumen percibido. La compresión de una sola banda es especialmente efectiva para las voces en off porque ayuda a los
interlocutores a destacar por encima de la música y el audio de fondo.

Para obtener ejemplos de audio muy comprimido, escuche grabaciones de música pop moderna. Por el contrario, la mayoría de las
grabaciones de jazz están muy poco comprimidas, mientras que las grabaciones típicas de música clásica no tienen compresión alguna.

Umbral Define el nivel de entrada en el que comienza la compresión. El ajuste óptimo depende del contenido de audio y el estilo. Para comprimir
solo picos extremos y conservar un intervalo más dinámico, utilice umbrales de alrededor de 5 dB por debajo del nivel de entrada pico; para
comprimir el audio y reducir el intervalo dinámico considerablemente, utilice ajustes de alrededor de 15 dB por debajo del nivel de entrada pico.
Proporción Define una proporción de compresión entre 1-a-1 y 30-a-1. Por ejemplo, un ajuste de 3 emite 1 dB por cada 3 dB de aumento sobre
el umbral. Los ajustes habituales van de 2 a 5; unos ajustes más elevados producen el sonido extremadamente comprimido que se oye en la
música pop.
Ataque Determina la velocidad con la que se inicia la compresión después de que el audio exceda el ajuste Umbral. El valor predeterminado de
10 milisegundos funciona bien para una gama de material de origen muy amplia. Utilice ajustes más rápidos solo para audio con transitorios
rápidos, como las grabaciones de percusión.
Liberar Determina la rapidez con la que se detiene la compresión cuando el audio cae por debajo del ajuste Umbral. El valor predeterminado de
100 milisegundos funciona bien para un intervalo de audio muy amplio. Pruebe ajustes más rápidos para audio con transitorios rápidos, y más
lentos para audio con menos percusión.
Ganancia de salida Aumenta o corta la amplitud después de la compresión. Los valores posibles están comprendidos entre -30 dB y +30 dB,
siendo 0 la ganancia unitaria.

Efecto Nivelador de volumen de voz
Amplitud y Compresión > Nivelador de volumen de voz es un efecto de compresión que optimiza el diálogo, compensando los niveles y
eliminando el ruido de fondo.

Para obtener los mejores resultados, realice lo siguiente:

1. Seleccione el audio con el nivel más bajo. Establezca las opciones Nivel de volumen de destino y Equilibrar cantidad hacia la
izquierda. Comience la reproducción y aumente gradualmente Equilibrar cantidad hasta que la voz pueda escucharse bien sin
aumentar el ruido de fondo.

2. Seleccione el audio con el nivel más alto e inicie la reproducción. Ajuste el Nivel de volumen de destino hasta que el volumen
coincida con el del pasaje silencioso que se ha ajustado previamente.

3. Si es necesario, vuelva a ajustar la opción Equilibrar cantidad para evitar un sonido con excesiva compresión.

A continuación se incluyen los detalles adicionales sobre cada opción:

Nivel de volumen de destino Establece el nivel de salida deseado con relación a cero dBFS. (Consulte Medición de amplitud en dBFS.)
Equilibrar cantidad Con las opciones de configuración bajas, amplifica la voz ligeramente sin amplificar la base de ruido. Con las opciones de
configuración elevadas, amplifica más toda la señal conforme la señal desciende a la base de ruido.
Amplificar señales bajas Interpreta los pasajes más cortos de bajo volumen conforme se amplifica la voz. Para la mayor parte del contenido de
audio, anule la selección de esta opción para producir un sonido más suave.
Ajustes avanzados Haga clic sobre el triángulo para acceder a las siguientes opciones:

Compresor  Mantiene un nivel elevado si la señal procesada desciende a un nivel relativo a cero dBFS.
Control de ruido  Elimina el ruido de fondo al reducir en gran medida el nivel de salida cuando la señal desciende en un desplazamiento
especificado.
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Efecto Compresor en forma de tubo
El efecto Amplitud y compresión > Compresor en forma de tubo simula el calor de los compresores de hardware clásicos. Utilice este efecto para
agregar una sutil distorsión que colorea el audio de forma agradable.

Control Umbral Define el nivel de entrada en el que comienza la compresión. Los valores posibles están comprendidos entre -60 y 0 dB. El
ajuste óptimo depende del contenido de audio y el estilo musical. Para comprimir solo picos extremos y conservar un intervalo más dinámico,
utilice umbrales de alrededor de 5 dB por debajo del nivel de entrada pico; para comprimir el audio y reducir el intervalo dinámico
considerablemente, utilice ajustes de alrededor de 15 dB por debajo del nivel de entrada pico.
Medidores de Nivel de entrada A la izquierda del control deslizante, estos medidores miden la amplitud de entrada. Haga doble clic en los
medidores para restablecer los indicadores de pico y clip.
Medidores de Reducción de ganancia A la derecha del control deslizante, estos medidores miden la reducción de la amplitud con barras rojas
que se extienden desde la parte superior (reducción mínima) a la inferior (reducción máxima).
Ganancia Aumenta o corta la amplitud después de la compresión. Los valores posibles están comprendidos entre -18 y +18 dB, siendo 0 la
ganancia unitaria.
Proporción Define una proporción de compresión entre 1-a-1 y 30-a-1. Por ejemplo, un ajuste de 3.0 emite 1 dB por cada 3 dB de aumento
sobre el umbral de compresión. Los ajustes habituales van de 2,0 a 5,0; unos ajustes más elevados producen el sonido extremadamente
comprimido que se oye en la música pop.
Ataque Determina la rapidez con la que se aplica la compresión cuando el audio sobrepasa el umbral. Los valores posibles están comprendidos
entre 0 y 500 milisegundos. El valor predeterminado de 10 milisegundos funciona bien para un intervalo de audio muy amplio. Un ajuste más
rápido puede funcionar mejor para audio con transitorios rápidos, pero este tipo de ajustes suena poco natural con audio con menos percusión.
Liberar Determina la rapidez con la que se detiene la compresión cuando el audio cae por debajo del umbral. Los valores posibles están
comprendidos entre 0 y 5.000 milisegundos. El valor predeterminado de 100 milisegundos funciona bien para un intervalo de audio muy amplio.
Pruebe ajustes más rápidos para audio con transitorios rápidos, y más lentos para audio con menos percusión.

Efecto Envolvente de volumen (solo Editor de forma de onda en CS5.5)
El efecto Amplitud y compresión > Envolvente de volumen permite modificar el volumen progresivamente con amplificaciones y transiciones. En el
panel Editor, simplemente arrastre la línea amarilla. La parte superior del panel representa una amplificación del 100% (normal); la parte inferior
representa una atenuación del 100% (silencio).

Aunque el efecto Envolvente de volumen no está disponible en el Editor multipista, puede utilizar rutas de automatización para realizar la
misma tarea. (Consulte Automatización de ajustes de pista.)

Arrastre un punto de anclaje en el panel Editor

Línea envolvente amarilla en el panel Editor Arrastre para ajustar el porcentaje de amplitud y haga clic para añadir fotogramas clave para
amplificaciones y transiciones adicionales. Para seleccionar, volver a situar o eliminar rápidamente varios fotogramas clave, consulte
Automatización de ajustes con fotogramas clave.
Curvas polinomiales Aplica transiciones curvadas más suaves entre los fotogramas clave, en lugar de transiciones lineales. Consulte Acerca de
las curvas polinomiales para gráficos.
Más temas de ayuda
Aplicación de efectos en el Editor multipista

Utilización de ajustes preestablecidos de efectos

Mezcla de datos de audio al pegar

Control de ajustes de efectos con gráficos

Efecto Creación de originales
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Efectos Retardo y Eco
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Efecto Retardo analógico
Efecto Retardo
Efecto Eco

Retardos son copias por separado de una señal original que vuelve a producirse milisegundos los unos después de los otros. Los ecos son
sonidos que se retardan el tiempo suficiente como para que los escuche como una copia distinta del sonido original. Tanto los retardos como los
ecos son una forma magnífica de agregar matices a una pista en la que la reverberación o el coro podrían enturbiar la mezcla.

Para acceder a las opciones conocidas de los retardos de hardware, utilice el efecto Eco de Adobe Audition.

Efecto Retardo analógico
El efecto Retardo y eco > Retardo analógico simula el calor sónico de las unidades de retardo de hardware originales. Las opciones únicas
aplican una distorsión única y ajustan la extensión del estéreo. Para crear ecos discretos, especifique tiempos de retardo de 35 milisegundos o
más; para crear más efectos suaves, especifique tiempos más cortos.

Modo Especifica el tipo de emulación de hardware, con lo que determina las características de ecualización y distorsión. Cinta y Tubo reflejan el
carácter sonoro de las unidades de retardo clásicas, mientras que Análogo refleja líneas de retardo electrónicas posteriores.
Salida original Determina el nivel de audio original, no procesado.
Salida con efecto Determina el nivel de audio retardado, procesado.
Retardo Especifica la longitud de retardo en milisegundos.
Retroalimentación Crea ecos repetitivos reenviando el audio retardado a través de la línea de retardo. Por ejemplo, un ajuste del 20% envía
audio retardado a un quinto de su volumen original y crea ecos que se desvanecen suavemente. Un ajuste del 200% envía un audio retardado al
doble de su volumen original y crea ecos cuya intensidad aumenta rápidamente.
Nota: Cuando experimente con ajustes de Retroalimentación altos, baje el volumen del sistema.
Papelera Aumenta la distorsión y las frecuencias bajas, lo que agrega calidez.
Extensión Determina la anchura de estéreo de la señal retardada.

Efecto Retardo
El efecto Retardo y eco > Retardo se puede utilizar para crear ecos y otros efectos. Los retardos de 35 milisegundos o más crean ecos discretos,
mientras que los comprendidos entre 15 y 34 milisegundos pueden crear un efecto de coro o retardo simple. (Estos resultados no serán tan
efectivos como los efectos reales de coro o retardo de Adobe Audition, dado que los ajustes de retardo no se pueden modificar con el tiempo).

Para reducir un retardo hasta un rango entre 1 y 14 milisegundos, puede localizar espacialmente un sonido mono de manera que parezca que el
sonido proviene del lado izquierdo o derecho, aunque el nivel de volumen real de la izquierda y la derecha sea idéntico.

Tiempo de retardo Ajusta el retardo de los canales izquierdo y derecho entre -500 y +500 milisegundos. Si introduce un número negativo
significa que puede hacer avanzar un canal en lugar de retardarlo. Por ejemplo, si introduce 200 milisegundos para el canal izquierdo, la parte
retardada de la forma de onda correspondiente se escuchará antes que la parte original.
Mezcla Define la proporción de aspecto de la señal Húmeda procesada como original y la señal Seca que se mezclará en el resultado final. Un
valor de 50 mezcla las dos uniformemente.
Invertir Invierte la fase de la señal retrasada, creando efectos de cancelación de fase similares a filtros de peine. Para obtener más información
sobre la cancelación de fases, consulte Cómo interactúan las ondas de sonido.)

Efecto Eco
El efecto Retardo y eco > Eco agrega a un sonido una serie de ecos repetidos que van decayendo. (Para crear un solo eco, utilice el efecto
Retardo.) Puede crear efectos desde el tipo Gran Cañón “Hola-la-a” hasta sonidos metálicos de tubería hueca mediante la modificación de la
cantidad de retardo. Mediante la ecualización de los retardos se puede modificar el sonido característico de una sala, desde una con superficies
reflexivas (con ecos con sonidos brillantes) hasta una superficie prácticamente absorbente (con ecos con sonidos más oscuros).

Nota: Asegúrese de que la longitud del archivo de audio sea suficiente para permitir que el audio termine. Si el eco se corta de forma abrupta
antes de que decaiga completamente, deshaga el efecto Eco, agregue varios segundos de silencio seleccionando Generar > Silencio y, a
continuación, vuelva a aplicar el efecto.
Tiempo de retardo Especifica el número de milisegundos, pulsaciones o muestras entre ecos. Por ejemplo, un ajuste de 100 milisegundos
produce un retardo de una décima de segundo entre los ecos sucesivos.
Retroalimentación Determina la proporción de aspecto de decaimiento de un eco. Cada eco sucesivo se va debilitando en un porcentaje
determinado menos que el anterior. Un ajuste de decadencia del 0% no produce ningún eco, mientras que un ajuste del 100% produce un eco



 

que nunca se silencia.
Nivel de eco Define el porcentaje de señal con eco (húmeda) que se mezcla con la señal original (seca) en la salida final.

Puede crear efectos de eco estéreo sorprendentes mediante el ajuste de diferentes valores en la derecha y en la izquierda en los controles de
Tiempo de retardo, Retroalimentación y Nivel de eco.

Bloquear izquierda y derecha Vincula los reguladores para Decadencia, Retardo y Volumen de eco inicial, manteniendo los mismos ajustes para
cada canal.
Rebote de eco Crea un rebote de eco de un lado a otro entre los canales izquierdo y derecho. Si desea crear un eco que rebote de un lado a
otro, seleccione un volumen de eco inicial del 100% para un canal y de 0% para el otro. De lo contrario, los ajustes para cada canal rebotarán
con el otro y crearán dos grupos de ecos en cada canal.
Ecualización sucesiva del eco Transmite todo el eco sucesivo mediante un ecualizador de ocho bandas, lo que permite simular la absorción de
sonido natural de una habitación. Un ajuste de 0 no modifica la banda de frecuencia, mientras que el ajuste máximo de -15 reduce esta frecuencia
en 15 dB. Y, dado que -15 dB es la diferencia de cada eco sucesivo, algunas frecuencias finalizan mucho antes que otras.
Unidades de tiempo de retardo Especifica milisegundos, pulsaciones o muestras del ajuste Tiempo de retardo.
Más temas de ayuda
Aplicación de efectos en el Editor multipista

Utilización de ajustes preestablecidos de efectos
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Efectos de diagnóstico (solo Editor de forma de onda)
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Diagnóstico, reparación, eliminación o marcación de audio
Opciones de DeClicker
Opciones de DeClipper
Opciones Eliminar silencio y Marcar audio

El diagnóstico está disponible mediante el menú Efectos o directamente en el panel Diagnóstico (Ventana > Diagnóstico). Estas herramientas
permiten rápidamente eliminar chasquidos, distorsión o silencio del audio, así como añadir marcadores donde se produce el silencio.

Para obtener un control de restauración de audio máximo, utilice el diagnóstico junto con las herramientas de visualización espectral y los
efectos de reducción de ruido. Consulte Técnicas de restauración de audio.

Adobe recomienda ¿Desea compartir un tutorial?

Restauración del audio
recortado de cámaras DSLR
Jason Levine
Recuperación del rango dinámico perdido con el
efecto DeClipper.

Diagnóstico, reparación, eliminación o marcación de audio
A diferencia de los efectos de reducción de ruido convencionales, que procesa todo el audio seleccionado, los diagnósticos analizan áreas
problemáticas o en silencio y permiten seleccionar qué problema abordar.

1. En el panel Diagnóstico, seleccione una opción en el menú Efecto.

2. Haga clic en Explorar.

3. En la parte inferior del panel Archivos realice una de las siguientes acciones:

Seleccione uno o varios elementos detectados en la lista y haga clic en Reparar, Eliminar o Marcar. (Las opciones
disponibles dependen del efecto de diagnóstico seleccionado.)

Para marcar el recorte o los chasquidos detectados, haga clic con el botón derecho en los elementos seleccionados en
la lista y elija Crear marcadores en el menú desplegable. (Consulte Uso de marcadores.)

Haga clic en Reparar todo, Eliminar todo o Marcar todo para abordar todos los elementos detectados.

Haga clic en la lupa  para acercarse a un problema seleccionado en el panel Editor. Haga clic de nuevo en el icono
para alejarse.

Haga clic en Borrar reparado, Eliminado o Marcado para eliminar los elementos abordados previamente de la lista.

Opciones de DeClicker
El efecto Diagnóstico > DeClicker detecta y elimina los chasquidos y detonaciones de los micrófonos inalámbricos, disco de vinilo y otros recursos.

Las opciones DeClicker coinciden con las de Eliminador de chasquidos automático, que se pueden combinar con otros efectos en el Bastidor de
efectos y aplicar en el Editor multipista. (Consulte Efecto Eliminador de chasquidos automático.) Este efecto también aplica varios pases de
reparación y búsqueda automáticamente; para lograr el mismo nivel de reducción de chasquidos con DeClicker, se debe aplicar manualmente
varias veces. Sin embargo, DeClicker permite evaluar los chasquidos detectados y seleccionar cuál de ellos solucionar.

En el panel Diagnóstico, haga clic en Ajustes para acceder a estas opciones:

Umbral Determina la sensibilidad al ruido. Los ajustes más bajos detectan más chasquidos y detonaciones pero pueden incluir audio que desee
conservar. Los ajustes están comprendidos entre 30 y 100; el valor predeterminado es 1.
Complejidad Indica la complejidad del ruido. Los ajustes más altos aplican más procesamiento pero pueden reducir la calidad de audio. Los
ajustes están comprendidos entre 16 y 100; el valor predeterminado es 1.

Para identificar los chasquidos visualmente, aplique zoom para acercarse y utilice la Visualización de frecuencia espectral con una resolución
de 256 bandas. (Puede acceder a estos ajustes en la ficha Visualización espectral del cuadro de diálogo Preferencias.) La mayoría de los
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chasquidos aparecen como barras verticales brillantes que se extienden desde la parte superior a la inferior de la visualización.

Opciones de DeClipper
El efecto Diagnóstico > DeClipper repara formas de onda recortadas, rellenando las secciones recortadas con datos de audio nuevos. El recorte
se produce cuando la amplitud de audio sobrepasa el nivel máximo para la profundidad de bits actual. Generalmente, el recorte se produce
cuando los niveles de grabación son demasiado altos. El recorte se puede supervisar durante la grabación o la reproducción mediante la
observación de los limnímetros; cuando se produce el recorte, las casillas situadas en el extremo derecho de los medidores se vuelven rojas.

Visualmente, el audio recortado aparece como una amplia área plana en la parte superior de la forma de onda. Sónicamente, el audio recortado
es una distorsión de tipo estático.

Nota: Si necesita ajustar el desplazamiento de DC del audio recortado, utilice antes el efecto DeClipper. Si, por el contrario, ajusta antes el
desplazamiento de DC, el efecto DeClipper no identificará las áreas recortadas inferiores a 0 dBFS.
En el panel Diagnóstico, haga clic en Ajustes para acceder a estas opciones:

Ganancia Especifica la cantidad de atenuación que se produce antes del procesado. Haga clic en Auto para basar el ajuste de ganancia en la
amplitud de entrada media.
Tolerancia Especifica la variación de amplitud de las áreas recortadas. Un valor de 0% detecta el recorte solo en las líneas totalmente
horizontales con una amplitud máxima; el valor de 1% detecta el recorte comenzando en un 1% por debajo de la amplitud máxima, etc. (Un valor
del 1% detecta la mayoría del recorte.)
Tamaño del clip mínimo Especifica la longitud del recorrido más corto de las muestras recortadas que se van a reparar. Los valores más bajos
reparan un porcentaje más alto de muestras recortadas; los valores más altos reparan las muestras recortadas solo si preceden o siguen otras
muestras recortadas.
Interpolación La opción Cubic utiliza curvas polinomiales para volver a crear el contenido de frecuencia del audio recortado. Este enfoque resulta
más rápido en la mayoría de las situaciones, pero puede introducir nuevas falsas frecuencias. La opción FFT utiliza transformaciones Fast Fourier
para volver a crear audio recortado. Este enfoque suele ser más lento pero mejor para el recorte severo. En el menú Tamaño FFT, seleccione el
número de bandas de frecuencia para evaluar y reemplazar. (Si hay más bandas, habrá una mayor precisión pero un procesamiento más largo.)

Para conservar la amplitud al restaurar el audio recortado, aplique el efecto DeClipper con un ajuste de Ganancia de cero, más el efecto
Límites forzados con un valor de amplificación de cero y un valor de límite de -0,2 dB.

Opciones Eliminar silencio y Marcar audio
Los efectos Diagnóstico > Eliminar silencio y marcar audio identifican las partes en silencio de audio y las eliminan o las marcan. (Consulte Uso
de marcadores.) La eliminación automática de silencio ayuda a reforzar las pistas sin que el audio de fondo se vea afectado. El marcado
automático de silencio ayuda a desplazarse automáticamente a las pistas de audio para edición.

En el panel Diagnóstico, haga clic en Ajustes para acceder a estas opciones:

Definir silencio como Especifica la amplitud y la duración identificadas como silencio.
Definir audio como Especifica la amplitud y la duración identificadas como contenido de audio.
Buscar niveles Calcula automáticamente los niveles de señal y el audio en función del contenido del archivo.
Método de reparación (eliminar solo silencio) Seleccione Reducción de silencio para reducir las partes en silencio al número especificado de
milisegundos. Seleccione la eliminación de silencio para silenciar las partes en silencio pero conservar la longitud del archivo. (La eliminación del
silencio ayuda a mantener la sincronización de vídeo con los clips de audio en las aplicaciones de edición de vídeo.)

Para dividir las secciones de sonido o voz separadas con silencio en diferentes archivos, aplique el efecto Marcar audio y haga clic en Marcar
todo. A continuación, consulte Almacenamiento de audio entre marcadores en archivos nuevos.

Más temas de ayuda
Utilización de ajustes preestablecidos de efectos
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Efecto de reverberación por circunvolución
Efecto Reverberación completa
Efecto Reverberación
Efecto Reverberación de estudio
Efecto Reverberación envolvente

En una habitación el sonido rebota en las paredes, el techo y el suelo hasta llegar a los oídos. Todos estos sonidos reflejados llegan a los oídos
tan unidos que no los percibe como ecos separados, sino como un ambiente sonoro que crea una sensación de espacio. Este sonido reflejado se
denomina reverberación o reverb. Con Adobe Audition, puede utilizar efectos de reverberación para simular salas con distintos entornos.

Para un uso más flexible y eficaz de la reverberación en el Editor multipista, agregue efectos de reverberación a buses y defina niveles de
salida de reverberación al 100% Húmeda. A continuación, encamine pistas hacia estos buses y utilice envíos para controlar la proporción de
aspecto de seco del sonido reverberante.

Efecto de reverberación por circunvolución
El efecto Reverberación > Reverberación por circunvolución reproduce salas que abarcan desde un armario a salas de conciertos. La
reverberación basada en circunvolución utiliza archivos de impulso para simular espacios acústicos. Los resultados son increíblemente realistas.

Los orígenes de los archivos de impulso incluyen audio grabado de un espacio ambiente o conjuntos de impulsos disponibles en línea. Para
obtener los mejores resultados, los archivos de impulso se deben descomprimir, archivos de 16 o 32 bits que coinciden con la velocidad de
muestreo del archivo de audio actual. La longitud del impulso no debe superar los 30 segundos. Para el diseño de sonido, pruebe una variedad
de audio de origen para producir efectos exclusivos y basados en la circunvolución.

Nota: Debido a que la Reverberación por circunvolución requiere que exista un procesamiento importante, puede oír chasquidos o detonaciones
al previsualizar en sistemas más lentos. Estos efectos no deseados desaparecen tras aplicar el efecto.
Impulso Especifica un archivo que simula un espacio acústico. Haga clic en Cargar para añadir un archivo de impulso personalizado en formato
WAV o AIFF.
Mezcla Controla la proporción de sonido original a reverberante.
Tamaño de la sala Especifica un porcentaje de la sala completa definida por el archivo de impulsos. Conforme mayor sea el porcentaje, más
durará la reverberación.
Atenuación LF Reduce los componentes de baja frecuencia y graves en la reverberación, evitando así los sonidos turbios y proporcionando un
sonido más claro y articulado.
Atenuación HF Reduce los componentes de frecuencia alta y transitorios en la reverberación, evitando así sonidos abruptos y produciendo un
sonido más cálido y exuberante.
Pre-retardo Determina cuántos milisegundos tarda la reverberación en conseguir la amplitud máxima. Para producir un sonido completamente
natural, especifique un pre-retardo corto, de entre 0 y 10 milisegundos. Para producir efectos especiales interesantes, especifique un pre-retardo
largo de 50 milisegundos o más.
Ancho Controla la extensión estéreo. Un ajuste de 0 produce una señal de reverberación mono.
Ganancia Aumenta o atenúa la amplitud después del procesamiento.

Efecto Reverberación completa
El efecto Reverberación > Reverberación completa se basa en circunvoluciones, con lo que se evitan defectos de timbres, sonidos metálicos y
otros efectos sonoros artificiales.

Este efecto ofrece algunas opciones únicas, como la Percepción, que simula irregularidades en la sala, Ubicación izquierda/derecha, que
descentra la fuente del sonido y Tamaño de la sala y Dimensión, que ayudan a simular salas más reales que se pueden personalizar. Para
simular las paredes y la resonancia, puede cambiar la absorción de frecuencias de la reverberación mediante un EC paramétrico de 3 bandas de
la sección Coloración.

Al cambiar los ajustes de reverberación, este efecto crea un archivo temporal de impulsos, que simula el ambiente acústico que se especifique. El
tamaño de este archivo puede ser de varios megabytes, con lo que se requieren algunos segundos para procesarlo y para poder escuchar una
previsualización, deberá esperar unos instantes. Sin embargo, los resultados son muy reales y fáciles de personalizar.

Importante: El efecto Reverberación completa requiere considerable procesamiento; para utilizarlo en tiempo real y en multipista, preprocese
este efecto o sustitúyalo por Reverberación de estudio. (Consulte Preprocesamiento de efectos de pista para mejorar el rendimiento.)

Ajustes de reverberación
Tiempo de decadencia Especifica los milisegundos que tarda la reverberación en decaer 60 dB. Sin embargo, dependiendo de los parámetros de
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Coloración, algunas frecuencias pueden tardar más en decaer a 60 dB mientras que otras pueden decaer mucho más rápido. Los valores más
largos generan colas de reverberación más amplias, pero también requieren más procesamiento. El límite eficaz es de unos 6000 milisegundos
(una cola de 6 segundos), pero la cola real generada es mucho más larga para que permita la eliminación en el nivel de ruido de fondo.
Tiempo de pre-retardo Especifica cuántos milisegundos tarda la reverberación en conseguir la amplitud máxima. Generalmente, las
reverberaciones aumentan rápidamente y después decaen a una velocidad mucho más lenta. Con tiempos de pre-decadencia muy largos (como
400 milisegundos o más) se pueden escuchar efectos muy interesantes.
Difusión Controla la velocidad del aumento de eco. Los valores altos de difusión (superiores a 900 milisegundos) proporcionan reverberaciones
muy suaves, sin que escuchen “ecos” diferenciados. Los valores inferiores generan ecos más diferenciados dado que la densidad del eco inicial
es más ligera, pero la densidad se genera a lo largo de la duración de la cola de reverberación.

Se pueden obtener efectos de “rebote” de eco mediante el uso de valores bajos de Difusión y valores altos de Percepción. Con las colas de
reverberación largas, el uso de valores de difusión y de valores de baja percepción generan el efecto de un estadio de fútbol o recinto similar.

Percepción Simula irregularidades en el entorno (objetos, paredes, salas comunicadas, etc.). Los valores bajos crean una reverberación que
decae suavemente sin ningún adorno. Loa valores más altos proporcionan ecos diferenciados (que provienen de diferentes ubicaciones).

Si la reverberación es demasiado suave, es posible que no suene natural. Los valores de percepción de hasta 40 proporcionan variaciones de
espacios típicos de simulación.

Tamaño de la sala Define el volumen de la sala virtual medido en metros cúbicos. Cuanto mayor sea el espacio, más durará la reverberación.
Utilice este control para crear espacios virtuales solo unos cuantos metros hasta coliseos gigantescos.
Dimensión Especifica la proporción entre la anchura de la sala (izquierda a derecha) y la profundidad (desde la parte delantera hacia atrás). Una
altura adecuada desde el punto de vista sónico se calcula y se indica como Dimensiones reales de la sala en la parte inferior del cuadro de
diálogo. Generalmente, las salas cuya proporción entre anchura y altura está comprendida entre 0,25 y 4 ofrece la mejor reverberación de
sonido.
Ubicación izquierda/derecha (solo audio estéreo) Permite situar reflexiones previas fuera del centro. Seleccione Incluir directo en la sección
Nivel de salida para situar la señal original en la misma ubicación. Es posible obtener efectos muy buenos con cantantes levemente fuera del
centro, de un 5-10% a la izquierda o derecha.
Límite de paso alto Evita la pérdida de sonidos de baja frecuencia (100 Hz o menos), como los bajos o los tambores. Si las reflexiones previas
se mezclan con la señal original, estos sonidos pueden desaparecer cuando se utilizan salas pequeñas. Especifique una frecuencia superior a la
del sonido que desea conservar. Los ajustes entre 80 Hz y 150 Hz suelen proporcionar buenos resultados. Si el ajuste de límite es demasiado
alto, es posible que no obtenga una imagen realista del tamaño de la sala.
Definir la reverberación en función del tamaño de sala Establece tiempos de decadencia y retardo previo para coincidir con el tamaño
especificado de la sala, produciendo una reverberación más convincente. Si lo desea, puede afinar los tiempos de decadencia y retardo previo.

Opciones de Coloración
Para ajustar visualmente las opciones de coloración, arrastre directamente en el gráfico.

Frecuencia Especifica la frecuencia de esquina para las elevaciones de agudos y graves o la frecuencia central para la banda media. Por
ejemplo, para aumentar la calidez de la reverberación, reduzca la frecuencia de realce de agudos y disminuya su ganancia.
Ganancia Amplifica o atenúa la reverberación en diferentes rangos de frecuencia.

Para mejorar sutilmente el audio, amplifique las frecuencias de reverberación en la frecuencia natural de un elemento sónico clave. Por
ejemplo, para la voz de un cantante, amplifique las frecuencias de 200 Hz a 800 Hz para mejorar la resonancia en dicho rango.

Q Define la anchura de la banda media. Los valores más altos afectan a un intervalo de frecuencias más estrecho y los valores más bajos a un
rango más amplio.

Para obtener una resonancia diferenciada, utilice valores de 10 o superiores. Para amplificar o cortar un rango amplio de frecuencias, utilice
valores más bajos como 2 o 3.

Decadencia Especifica los milisegundos que decae la reverberación antes de que se aplique la curva de coloración. Los valores hasta 700 tienen
buenos resultados. Para obtener reverberaciones más coloreadas, utilice ajustes inferiores (entre 100 y 250).

Opciones de Nivel de salida
Seco Controla el nivel de la señal original incluida con la reverberación. Utilice un nivel bajo para crear un sonido distante. Para crear la
sensación de proximidad al origen, utilice un nivel alto (aproximadamente 100%) junto con niveles bajos de reverberación y reflexiones.
Reverberación Controla el nivel de la capa densa de sonido de reverberación. El equilibrio entre los sonidos secos y con reverberación cambia la
percepción de la distancia.
Reflexiones previas Controla el nivel de los primeros ecos que llegan al oído, dando la sensación del tamaño global de la sala. Un valor
demasiado alto puede generar un sonido artificial, mientras que un valor demasiado bajo puede eliminar las pistas sonoras del tamaño de la sala.
Un buen punto de partida sería la mitad del volumen de la señal Seco.
Incluir directo Desplaza la fase levemente de los canales izquierdo y derecho de la señal original para coincidir con la ubicación de las
reflexiones previas (establecidas mediante Ubicación izquierda/derecha en la ficha Reflexiones previas).
Sumar entradas Combina los canales de una forma de onda estéreo o envolvente antes de que se produzca el procesamiento. Seleccione esta
opción para un procesamiento más rápido, pero anule su selección para obtener una reverberación más amplia y pronunciada.

Efecto Reverberación
El efecto Reverberación > Reverberación simula espacios acústicos con procesamientos basados en circunvoluciones. Puede reproducir entornos
acústicos o ambientales como a armario, una ducha alicatada, una sala de conciertos y un gran anfiteatro. Los ecos se pueden espaciar de forma
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tan cercana de forma que una cola con reverberación de la señal decaiga suavemente progresivamente, creando un sonido cálido y natural.
Como alternativa, el tiempo de retardo previo se puede ajustar para dar una sensación de tamaño del espacio.

En relación con el efecto Reverberación, el efecto Reverberación completa proporciona más opciones y un procesamiento del audio mejorado.
Para ajustes rápidos, sin embargo, se recomienda que utilice el conjunto de opciones reducidas del efecto Reverberación.

Importante: El efecto Reverberación requiere considerable procesamiento; para utilizarlo en tiempo real y en multipista, preprocese este efecto
o sustitúyalo por Reverberación de estudio. (Consulte Preprocesamiento de efectos de pista para mejorar el rendimiento.)
Tiempo de decadencia Establece los milisegundos que la reverberación tarda en disminuir hasta el infinito (unos -96 dB). Utilice valores
inferiores a 400 para espacios pequeños, valores entre 400 y 800 para espacios de tamaño medio y valores superiores a 800 para espacios muy
amplios como, por ejemplo, salas de conciertos. Por ejemplo, introduzca 3.000 para crear colas de reverberación para un gran anfiteatro.

Para simular salas en las que se produzcan ecos y reverberaciones, utilice el efecto Eco en primer lugar para establecer el tamaño de la sala
y, a continuación, utilice el efecto Reverberación para hacer que parezca más natural. Un tiempo de decadencia de solamente 300
milisegundos puede agregar sensación de espacio a un sonido seco.

Tiempo de pre-retardo Especifica cuántos milisegundos tarda la reverberación en conseguir la amplitud máxima. Para un tiempo de decadencia
corto, el valor de tiempo de retardo previo también debe ser menor. Sin embargo, un valor de un 10% similar a un tiempo de decadencia suena
más realista. No obstante, es posible crear efectos interesantes utilizando un tiempo de retardo previo más largo con un tiempo de decadencia
más corto.
Difusión Simula la absorción natural, reduciendo las altas frecuencias conforme disminuye la reverberación. Los tiempos de absorción más
rápidos simulan espacios llenos de gente, amueblados y alfombrados como, por ejemplo, clubes nocturnos y teatros. Los tiempos más lentos
(superiores a 1000 milisegundos) simulan espacios vacíos como, por ejemplo, auditorios, donde las reflexiones de alta frecuencia son más
frecuentes.
Percepción Cambia las características de las reflexiones en un espacio. Los valores más bajos crean una reverberación más suave sin tantos
ecos diferenciados. Los valores más altos simulan salas más grandes, causan más variaciones en las amplitudes de reverberación y agrega
sensación de espacio mediante al creación de reflexiones diferenciadas a lo largo del tiempo.

Con un ajuste de percepción de 100 y un tiempo de retardo de 2.000 milisegundos o más se crean efectos de cañón interesantes.

Seco Define el porcentaje de audio de origen que se obtiene. En la mayoría de los casos, un valor del 90% tiene buenos resultados. Para añadir
una sensación de espacio leve, establezca de forma más elevada el porcentaje del valor de vacío (Seco); para obtener un efecto especial, defina
de forma más baja el porcentaje del valor de vacío (Seco).
Húmedo Define el porcentaje de reverberación que se obtiene. Para añadir una sensación de espacio leve a una pista, mantenga el porcentaje
del valor Húmedo en un nivel más bajo que el porcentaje del valor Seco. Aumente el porcentaje del valor Húmedo para simular una distancia
mayor desde el origen de audio.
Sumar entradas Combina los canales de una forma de onda estéreo o envolvente antes de que se produzca el procesamiento. Seleccione esta
opción para un procesamiento más rápido, pero anúlela para obtener una reverberación más amplia y completa.

Efecto Reverberación de estudio
Como el resto de efectos de reverberación, el efecto Reverberación > Reverberación de estudio simula espacios acústicos. Es más rápido e
implica menos procesamiento que otros efectos de reverberación porque no está basado en circunvoluciones. Como resultado, puede realizar
cambios en tiempo real con más rapidez y eficacia en el Editor multipista sin que sea necesario preprocesar los efectos en una pista.

Tamaño de la sala Define el tamaño de la sala.
Decadencia Ajusta la cantidad de decadencia de la reverberación en milisegundos.
Reflexiones previas Controla el porcentaje de ecos que llega al oído en primer lugar y proporciona la sensación del tamaño global de la sala. Un
valor demasiado alto puede generar un sonido artificial, mientras que un valor demasiado bajo se pueden perder las pistas sonoras del tamaño de
la sala. Un buen punto de partida sería la mitad del volumen de la señal original.
Anchura de estéreo Controla la expansión en los canales estéreo. 0% produce una señal de reverberación mono; 100% produce una separación
de estéreo máxima.
Corte de alta frecuencia Especifica la frecuencia más alta a la que se puede producir reverberación.
Corte de baja frecuencia Especifica la frecuencia más baja a la que se puede producir reverberación.
Atenuación Ajusta la cantidad de atenuación aplicada a las frecuencias altas de la señal de reverberación a lo largo del tiempo. Los porcentajes
más altos crean más atenuación para un tono de reverberación más vivo.
Difusión Simula la absorción de la señal reverberada tal y como se refleja en todas las superficies, como alfombras y cortinas. Con ajustes más
bajos se crean más ecos y con ajustes más altos se produce una reverberación más suave con menos ecos.
Seco Define el porcentaje de audio de origen que se obtiene con el efecto.
Húmedo Define el porcentaje de reverberación que se obtiene.

Efecto Reverberación envolvente
El efecto Reverberación > Reverberación envolvente se destina principalmente a las fuentes 5.1, pero también puede proporcionar un ambiente
envolvente para orígenes mono o estéreo. En el Editor de forma de onda, puede seleccionar Editar > Convertir tipo de muestra para convertir un
archivo mono o estéreo a 5.1 y después aplicar la Reverberación envolvente. En el Editor multipista, puede enviar pistas mono o estéreo a un bus
5.1 o crear originales con Reverberación envolvente.

Entrada, Centro Determina el porcentaje del canal central incluido en la señal procesada.
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Entrada, LFE Determina el porcentaje del canal Mejora de frecuencia baja utilizado para provocar la reverberación para otros canales. (La propia
señal LFE no se reverbera.)
Nota: El efecto siempre introduce un 100% de los canales envolventes posteriores, izquierdo y derecho.
Impulso Especifica un archivo que simula un espacio acústico. Haga clic en Cargar para añadir un archivo de impulso personalizado de 6
canales en formato WAV o AIFF.
Tamaño de la sala Especifica un porcentaje de la sala completa definida por el archivo de impulsos. Conforme mayor sea el porcentaje, más
durará la reverberación.
Atenuación LF Reduce los componentes de baja frecuencia y graves en la reverberación, evitando así los sonidos turbios y proporcionando un
sonido más claro y articulado.
Atenuación HF Reduce los componentes de frecuencia alta y transitorios en la reverberación, evitando así sonidos abruptos y produciendo un
sonido más cálido y exuberante.
Pre-retardo Determina cuántos milisegundos tarda la reverberación en conseguir la amplitud máxima. Para producir un sonido completamente
natural, especifique un pre-retardo corto, de entre 0 y 10 milisegundos. Para producir efectos especiales interesantes, especifique un pre-retardo
largo de 50 milisegundos o más.
Anchura frontal Controla la expansión estéreo en los tres canales frontales.
Un ajuste de anchura de 0 produce una señal de reverberación mono.

Anchura envolvente Controla la difusión estéreo en los canales envolventes posteriores (Is y Ds).
Niv. hum. ctr Controla la cantidad de reverberación añadida al canal central. (Debido a que este canal suele contener diálogo, la reverberación
debe ser más baja.)
Equ. iz/der Controla el equilibrio izquierda-derecha para los altavoces frontales y traseros. 100 genera la reverberación solo a la izquierda, -100
solo a la derecha.
Equ. pos/fr Controla el equilibrio frontal-trasero para los altavoces izquierdo y derecho. 100 genera la reverberación solo hacia el frente, -100 solo
a la parte trasera.
Mezcla húmeda/seca Controla la proporción de sonido original a reverberante. Un ajuste de reverberación única con un valor de 100.
Ganancia Aumenta o atenúa la amplitud después del procesamiento.
Más temas de ayuda
Aplicación de efectos en el Editor multipista

Utilización de ajustes preestablecidos de efectos

Control de ajustes de efectos con gráficos
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Efecto Extractor de canal central

Algunos efectos permiten cambiar la ubicación aparente, o las imágenes estéreo, de los sonidos que proceden de los altavoces.

Efecto Extractor de canal central
El efecto Imágenes estéreo > Extractor de canal central conserva o elimina frecuencias que son comunes a los canales izquierdo y derecho; es
decir, sonidos que realizan una panorámica en el centro. Con frecuencia la voz, el bajo y los instrumentos de cuerda se graban de esta forma.
Como resultado, puede utilizar este efecto para visualizar el volumen de las voces, el bajo o el bombo, o eliminarlos para crear una mezcla de
karaoke.

Ficha Extracción Limita la extracción al audio que se ajusta a determinadas propiedades.

Extraer  Seleccione audio en el canal envolvente, derecho, izquierdo o central o elija la opción Personalizado e indique el grado de fase
preciso, el porcentaje de panorámica y el tiempo de retardo para el audio que se desea extraer o eliminar. (La opción Envolvente extrae
audio que esté totalmente desfasado entre los canales izquierdo y derecho.)
Rango de frecuencias  Define el rango que desea extraer o eliminar. Entre los rangos predefinidos se incluyen Voz masculina, Voz
femenina, Bajo, Espectro completo. Seleccione Personalizado para definir un rango de frecuencia.

Ficha Discriminación Incluye los ajustes que ayudan a identificar el canal central.

Sangrado de forma extendida  Desplace el regulador hacia la izquierda para incrementar la penetración y obtener un sonido menos
artificial. Desplace el regulador hacia la derecha para separar más el material del canal central de la mezcla.
Discriminación de fase  En general, los valores más altos funcionan mejor para extraer el canal central, mientras que los valores más
bajos para eliminar el canal central. Los valores más bajos permiten más penetración y es posible que no separen las voces de una
mezcla con eficacia, pero pueden ser más eficaces para capturar todo el material central. En general, un rango comprendido entre 2 y 7
ofrece buenos resultados.
Discriminación de amplitud y Ancho de banda de amplitud Suma los canales izquierdo y derecho y crea un tercer canal totalmente
desfasado que Audition utiliza para eliminar frecuencias similares. Si la amplitud es similar en cada frecuencia, también se considerará el
audio en fase común a ambos canales. Los valores más bajos para Discriminación de amplitud y Ancho de banda de amplitud cortan más
material de la mezcla pero también cortan voces. Con valores más altos la extracción depende más de la fase del material y menos de la
amplitud del canal. Un ajuste de Discriminación de amplitud entre 0,5 y 10 y un ajuste de Ancho de banda de amplitud entre 1 y 20 tiene
buenos resultados.
Velocidad de decadencia espectral  Se debe mantener en un 0% para un procesamiento más rápido. Se establece entre el 80% y el
98% para suavizar las distorsiones de fondo.

Niveles del canal lateral y central Especifica la cantidad de señal seleccionada que desea extraer o eliminar. Mueve los reguladores hacia arriba
para incluir material adicional.
Opciones avanzadas Haga clic en el triángulo para acceder a estos ajustes:

Tamaño FFT  Especifica el tamaño FFT (Transformación rápida de Fourier), con ajustes bajos que mejoran la velocidad de procesamiento
y ajustes elevados que mejoran la calidad. En general, un ajuste entre 4.096 y 8192 es el que ofrece los mejores resultados.
Superposiciones  Define el número de ventanas FFT que se superponen. Los valores más altos pueden ofrecer resultados más suaves o
un efecto de coro, pero tardan más tiempo en procesarse. Los valores más bajos pueden generar sonidos de fondo de burbujeo. Los
valores comprendidos entre 3 y 9 tienen buenos resultados.
Anchura de ventana  Especifica el porcentaje de cada ventana FFT. Los valores comprendidos entre 30% y 100% tienen buenos
resultados.

Más temas de ayuda
Aplicación de efectos en el Editor multipista

Utilización de ajustes preestablecidos de efectos
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Special effects
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Distortion effect
Guitar Suite effect
Mastering effect
Vocal Enhancer effect

Special effects require mono or stereo audio; they do not support 5.1 surround.

Distortion effect
Use the Special > Distortion effect to simulate blown car speakers, muffled microphones, or overdriven amplifiers.

Creates identical curves in the Positive and Negative graphs.

Specify separate distortion curves for positive and negative sample values. The horizontal ruler (x-axis) indicates
input level in decibels; the vertical ruler (y-axis) indicates output level. The default diagonal line depicts an undistorted signal, with a one-to-one
relationship between input and output values.
Click and drag to create and adjust points on the graphs. Drag points off a graph to remove them.

To copy one graph to another, click the arrow buttons between them.

Returns a graph to its default, undistorted state.

Creates curved transitions between control points, sometimes producing a more natural distortion than the default linear
transitions.

Determines how quickly distortion reacts to changes in input levels. Level measurements are based on low-frequency content,
creating softer, more musical distortion.

Changes the amplitude range of the graphs, limiting distortion to that range.

Changes the amplitude scales of the graphs from logarithmic decibels to normalized values.

Compensates for any sample offset introduced by distortion processing. To understand this concept, see Correct DC offset.
Such offsets can cause audible pops and clicks when edited.

Guitar Suite effect
The Special > Guitar Suite effect applies a series of processors that optimize and alter the sound of guitar tracks. The Compressor stage reduces
dynamic range, producing a tighter sound with greater impact. Filter, Distortion, and Box Modeler stages simulate common effects that guitarists
use to create expressive, artistic performances.

Apply the Guitar Suite to vocals, drums, or other audio to create textured effects.

Reduces dynamic range to maintain consistent amplitude and help guitar tracks stand out in a mix.

Simulates guitar filters ranging from resonators to talk boxes. Choose an option from this menu, and then set options below:

Determines which frequencies are filtered. Specify Lowpass to filter high frequencies, Highpass to filter low frequencies, or
Bandpass to filter frequencies above and below a center frequency.

Determines the cutoff frequency for Lowpass and Highpass filtering, or the center frequency for Bandpass filtering.

Feeds back frequencies near the cutoff frequency, adding crispness with low settings and whistling harmonics with high
settings.

Adds a sonic edge often heard in guitar solos. To change the distortion character, choose an option from the Type menu.

Simulates various amplifier and speaker combinations that guitarists use to create unique tones.
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Controls the ratio of original to processed audio.

Mastering effect
Mastering describes the complete process of optimizing audio files for a particular medium, such as radio, video, CD, or the web. In Adobe
Audition, you can quickly master audio with the Special > Mastering effect.

Before mastering audio, consider the requirements of the destination medium. If the destination is the web, for example, the file will likely be
played over computer speakers that poorly reproduce bass sounds. To compensate, you can boost bass frequencies during the equalization stage
of the mastering process.

Adjusts the overall tonal balance.

Shows frequency along the horizontal ruler (x-axis) and amplitude along the vertical ruler (y-axis), with the curve representing the
amplitude change at specific frequencies. Frequencies in the graph range from lowest to highest in a logarithmic fashion (evenly spaced by
octaves).

Drag control points in the graph to visually adjust the settings below.

Activate shelving filters at either end of the frequency spectrum.

Activates a peaking filter in the center of the frequency spectrum.

Indicates the center frequency of each frequency band.

Indicates the level of each frequency band.

Controls the width of the affected frequency band. Low Q values (up to 3) affect a larger range of frequencies and are best for overall
audio enhancement. High Q values (6–12) affect a very narrow band and are ideal for removing a particular, problematic frequency, like
60-Hz hum.

Adds ambience. Drag the Amount slider to change the ratio of original to reverberant sound.

Exaggerates high-frequency harmonics, adding crispness and clarity. Mode options include Retro for light distortion, Tape for bright tone,
and Tube for quick, dynamic response. Drag the Amount slider to adjust the level of processing.

Adjusts the stereo image (disabled for mono audio). Drag the Width slider to the left to narrow the image and increase central focus.
Drag the slider to the right to expand the image and enhance spatial placement of individual sounds.

Applies a limiter that reduces dynamic range, boosting perceived levels. A setting of 0% reflects original levels; 100%
applies maximum limiting.

Determines output levels after processing. For example, to compensate for EQ adjustments that reduce overall level, boost the
output gain.

Vocal Enhancer effect
The Special > Vocal Enhancer effect quickly improves the quality of voice-over recordings. The Male and Female modes automatically reduce
sibilance and plosives, as well as microphone handling noise such as low rumbles. Those modes also apply microphone modeling and
compression to give vocals a characteristic radio sound. The Music mode optimizes soundtracks so they better complement a voice-over.

Optimizes audio for a man’s voice.

Optimizes audio for a woman’s voice.

Applies compression and equalization to music or background audio.
Applying effects in the Waveform Editor

Techniques for restoring audio

Match volume across multiple files
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Chorus effect
Chorus/Flanger effect
Flanger effect
Phaser effect

Chorus effect
The Modulation > Chorus effect simulates several voices or instruments played at once by adding multiple short delays with a small amount of
feedback. The result is lush, rich sound. You can use Chorus to enhance a vocal track or add stereo spaciousness to mono audio.

Adobe Audition uses a direct-simulation method to achieve a chorus effect, making each voice sound distinct from the original by slightly varying
timing, intonation, and vibrato. The Feedback setting lets you add extra detail to the result.

To achieve the best results with mono files, convert them to stereo before applying the Chorus effect.

Represent the characteristics of each voice in the chorus.

Determines the number of simulated voices.
Note: As you add more voices, the sound becomes richer and richer —but processing time also increases.

Specifies the maximum amount of delay allowed. Chorusing introduces short delays (often in the 15-35 millisecond range)
that vary in duration over time. If the setting is very small, all the voices start merging into the original, and an unnatural flanging effect
might occur. If the setting is too high, a warbled effect might occur, like a tape being eaten by a cassette deck.

Determines how quickly the delay cycles from zero to the maximum delay setting. Because the delay varies over time, the
pitch of the sample increases or decreases over time, giving the effect of separate, slightly out of tune voices. For example, a rate of 2 Hz
would vary the delay from zero to the maximum and back twice per second (simulating a pitch vibrato at twice per second). If this setting is
too low, the individual voices don’t vary much in pitch. If it is set too high, the voices may vary so quickly that a warbled effect might occur.

Adds a percentage of processed voices back into the effect input. Feedback can give a waveform an extra echo or reverb
effect. A little feedback (less than 10%) can provide extra richness, depending on the delay and vibrato settings. Higher settings produce
more traditional feedback, a loud ringing which can get loud enough to clip the signal.

Gives an added delay to each voice, separating them in time by as much as 200 milliseconds (1/5th of a second). High values
cause the separate voices to start at different times—the higher the value, the farther apart the onset of each voice may be. In contrast,
low values cause all voices to be in unison. Depending on other settings, low values can also produce flanging effects, which may be
undesirable if your goal is a realistic chorus effect.

Determines the maximum variation in amplitude that occurs. For example, you can alter the amplitude of a chorused
voice so that it is 5 dB louder or quieter than the original. At extremely high settings, the sound may cut in and out, creating an
objectionable warble. At extremely low settings (less than 1 dB), the depth may be unnoticeable unless the Modulation Rate is set
extremely high. Natural vibratos occur around 2 dB to 5 dB.
Note that this setting is a maximum only; the vibrato volume might not always go as low as the setting indicates. This limitation is
intentional, as it creates a more natural sound.

Determines the maximum rate at which amplitude changes occur. With very low values, the resulting voice slowly gets
louder and quieter, like a singer that cannot keep his or her breath steady. With very high settings, the result can be jittery and unnatural.

Ensures the best quality results. Increasing the quality, however, increases the processing time for previewing and
applying the effect.

Determines where the individual voices are placed in the stereo field and how the original stereo signal is interpreted. These
options are active only when you work with stereo files:

Combines the original left and right channels. If deselected, the channels are kept separate to
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Initial Delay Time

preserve the stereo image. Leave this option deselected if the stereo source audio was originally monophonic—it won’t have any effect
other than increasing processing time.

Adds separate delays to the left and right outputs of each voice. This delay can make each voice seem to come from
a different direction when you listen through headphones. For greater stereo separation, deselect this option for audio that will be played
through standard speakers .

Specifies where chorused voices are placed across the left and right stereo image. At lower settings, voices are closer to
the center of the stereo image. At a setting of 50%, voices are spaced evenly from left to right. At higher settings, voices move to the outer
edges. If you use an odd number of voices, one is always directly in the center.

Sets the ratio of original (Dry) signal to chorused (Wet) signal. Extremely high settings may cause clipping.

In the Multitrack Editor, you can vary the Wet level over time with automation lanes. (See Automating track settings.)This technique is handy for
emphasizing vocal or instrumental solos.

Chorus/Flanger effect
The Modulation > Chorus/Flanger effect combines two popular delay-based effects. The Chorus option simulates several voices or instruments
played at once by adding multiple short delays with a small amount of feedback. The result is lush, rich sound. Use this effect to enhance vocal
tracks or add stereo spaciousness to mono audio.

The Flanger option creates a psychedelic, phase-shifted sound by mixing a varying, short delay with the original signal. This effect was originally
created by sending an identical audio signal to two reel-to-reel tape recorders, and periodically pressing the flange of one reel to slow it down.

Simulates several voices or instruments playing at once.

Simulates the delayed, phase-shifted sound originally heard in psychedelic music.

Controls the rate at which the delay time cycles from zero to the maximum setting.

Specifies the maximum amount of delay.

Controls the ratio of original to processed audio.

Emphasizes transients, giving them a sharper, more distinct sound.

Flanger effect
Flanging is an audio effect caused by mixing a varying, short delay in roughly equal proportion to the original signal. It was originally achieved by
sending an identical audio signal to two reel-to-reel tape recorders, and then pressing the flange of one reel to slow it down. Combining the two
resulting recordings produced a phase-shifted, time-delay effect, characteristic of psychedelic music of the 1960s and 1970s. The Modulation >
Flanger effect lets you create a similar result by slightly delaying and phasing a signal at specific or random intervals.

Sets the point in milliseconds at which flanging starts behind the original signal. The flanging effect occurs by cycling over time
from an initial delay setting to a second (or final) delay setting.
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Sets the point in milliseconds at which flanging ends behind the original signal.

Sets the left and right delays at separate values, measured in degrees. For example, 180° sets the initial delay of the right
channel to occur at the same time as the final delay of the left channel. You can set this option to reverse the initial/final delay settings for the left
and right channels, creating a circular, psychedelic effect.

Determines the percentage of the flanged signal that is fed back into the flanger. With no feedback, the effect uses only the original
signal. With feedback added, the effect uses a percentage of the affected signal from before the current point of playback.

Determines how quickly the delay cycles from the initial to final delay times, measured either in cycles per second (Hz) or beats
per minute (beats). Small setting adjustments produce widely varying effects.

Provides three ways of flanging:

Inverts the delayed signal, cancelling out audio periodically instead of reinforcing the signal. If the Original - Expanded mix
settings are set at 50/50, the waves cancel out to silence whenever the delay is at zero.

Mixes the normal and inverted flanging effects. The delayed signal is added to the effect while the leading signal is
subtracted.

Makes the transition from initial delay to final delay and back follow a sine curve. Otherwise, the transition is linear, and the
delays from the initial setting to the final setting are at a constant rate. If Sinusoidal is selected, the signal is at the initial and final delays
more often than it is between delays.

Adjusts the mix of original (Dry) and flanged (Wet) signal. You need some of both signals to achieve the characteristic cancellation and
reinforcement that occurs during flanging. With Original at 100%, no flanging occurs at all. With Delayed at 100%, the result is a wavering sound,
like a bad tape player.

Phaser effect
Similar to flanging, phasing shifts the phase of an audio signal and recombines it with the original, creating psychedelic effects first popularized by
musicians of the 1960s. But unlike the Flanger effect, which uses variable delays, the Modulation > Phaser effect sweeps a series of phase-
shifting filters to and from an upper frequency. Phasing can dramatically alter the stereo image, creating unearthly sounds.

Specifies the number of phase-shifting filters. A higher setting produces denser phasing effects.

Determines the amount of phase-shifting applied to the signal.

Determines how far the filters travel below the upper frequency. Larger settings produce a wider tremolo effect; 100% sweeps from the
upper frequency to zero Hz.

Modulation rate controls how fast the filters travel to and from the upper frequency. Specify a value in Hz (cycles per second).

Determines the phase difference between stereo channels. Positive values start phase shifts in the left channel, negative values in the
right. The maximum values of +180 and -180 degrees produce a complete difference and are sonically identical.

Sets the upper-most frequency from which the filters sweep. To produce the most dramatic results, select a frequency near the
middle of the selected audio’s range.

Feeds a percentage of the phaser output back to the input, intensifying the effect. Negative values invert phase before feeding audio
back.

Controls the ratio of original to processed audio.

Adjusts the output level after processing.
Applying effects in the Waveform Editor
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Efecto Generar tonos
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Con audio seleccionado

Elija Efectos > Generar tonos para crear una forma de onda sencilla usando varios ajustes relacionados con la amplitud y la frecuencia. Los tonos
generados son excelentes puntos de partida para crear efectos de sonido.

Cambia los tonos desde los ajustes de la ficha Inicio a los de la ficha Fin. (La forma de onda permanece constante.)

Especifica la frecuencia principal que se debe utilizar para generar tonos. 

Modula el tono de la frecuencia base en un intervalo definido por el usuario. Por ejemplo, un ajuste de 100 Hz
modula la frecuencia original desde 50 Hz por debajo a 50 Hz por encima.

Especifica el número de veces por segundo que la frecuencia se modula, lo que produce un efecto de vibrato o
gorjeo.

Elija una de las siguientes opciones:
Seno y Seno inverso producen la frecuencia fundamental. Un ajuste de Tipo de 1,00 produce tonos puros; los ajustes más
bajos producen ondas más cuadradas; los más altos, más triangulares.
Triángulo/Dientes de sierra produce una forma de onda real de triángulo solo con armónicos impares, con un ajuste de Tipo
del 50%. Los valores por encima y por debajo de ese porcentaje producen formas de onda de diente de sierra con pares e
impares armónicos.
Cuadrado solo produce armónicos impares. Una verdadera onda cuadrada se produce con un ajuste de tipo del 50%. Los
valores por encima y por debajo ajustan el ciclo de trabajo de la forma de onda entre un pico plano al 100% y un valle plano a
0%. (Los extremos exteriores solo producen un chasquido audible.)

Agrega hasta cinco matices a la frecuencia fundamental (frecuencia base). Por debajo de los controles deslizantes,
introduzca una frecuencia determinada para cada armónico o especifique un multiplicador de la frecuencia fundamental. A continuación, utilice los
reguladores de Amplitud para mezclar los armónicos de forma proporcionada. 

Especifica el resultado total del efecto.

Especifica la duración del tono generado en el formato especificado para la regla de tiempo. Haga clic con el botón derecho del ratón
en los números para elegir un formato de tiempo independiente para Generar tonos.

Para acceder a las siguientes opciones, haga clic en Avanzadas:

Especifica la ubicación inicial en el ciclo de forma de onda. Si se establece en 0°, las ondas empezarán en el punto de
intersección cero. Si se establece en 90°, la onda empezará con una amplitud completa (generando un chasquido perceptible).

Ajusta la fase relativa de los canales estéreo. Un valor de cero sitúa los canales completamente dentro de
la fase y 180 los coloca completamente fuera de la fase.

Cambia de forma dinámica la fase relativa entre los dos canales de un archivo de audio estéreo a lo largo del tiempo. Por
ejemplo, si indica 1 Hz, la diferencia de fase será de 360° cada segundo.

Agrega un desplazamiento de corriente directa y desplaza el centro de la forma de onda hacia arriba o hacia abajo en el
porcentaje especificado. Utilice este ajuste para calibrar el hardware de audio o simular el desplazamiento provocado por el hardware.

Elija entre las siguientes opciones:
Reemplazar: intercambia el audio existente con tonos generados.
Modular: modula el timbre o multiplica el audio existente con los ajustes de tono actuales. Esta opción resulta excelente para
agregar efectos especiales.
Desmodular: desmodula el timbre del audio existente con los ajustes de tonos actuales. Utilice esta opción para crear efectos
únicos o descartar los cambios del audio previamente procesados con la opción Modular y volver al estado original.

Superponer: mezcla los tonos generados con el audio existente.
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Ultrasilencioso

Reparar atenuaciones a

El efecto Filtro y EC > Filtro de rechazo de banda elimina hasta seis bandas de frecuencia definidas por el usuario. Utilice este efecto para
eliminar bandas de frecuencia muy estrechas como, por ejemplo, zumbido de 60 Hz, y dejar todas las demás frecuencias inalteradas.

Para quitar los sonidos sibilantes estridentes, utilice el ajuste preestablecido Suavizador de sibilancia. O bien utilice los ajustes preestablecidos
de DTMF para quitar los tonos estándar para los sistemas telefónicos analógicos.

Especifica la frecuencia central de cada banda rechazada.

Especifica la amplitud de cada banda rechazada.

Determina el intervalo de frecuencias de todas las bandas rechazadas. Las tres opciones oscilan entre Estrecho
para filtro de segundo orden, que elimina algunas frecuencias adyacentes, y Súper estrecho para filtro de sexto orden, que es muy específico. 

Por lo general, no utilice más de 30 dB de atenuación para Estrecha, 60 dB para Muy estrecha y 90 dB para Súper estrecha. Una atenuación
superior puede eliminar un amplio intervalo de frecuencias próximas.

Prácticamente elimina el ruido y los defectos, pero requiere más procesamiento. Esta opción se puede escuchar solo en
auriculares de gama alta.

Determina si las bandas rechazadas tienen niveles de atenuación iguales o individuales. 
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Gráfico de desplazamiento de fase

Escala de frecuencia

Rango

Canal

Nota:

Tamaño FFT

El efecto Imágenes estéreo > Desfasador de fase gráfico permite añadir puntos de control a un gráfico para ajustar la fase de una forma de onda.

Haga clic con el botón derecho del ratón en los puntos para acceder al cuadro de diálogo Editar punto y obtener un control numérico preciso.

La regla horizontal (eje x) mide la frecuencia, mientras que la regla vertical (eje y) muestra hasta qué punto
se desplazará la fase; cero es sin desplazamiento de fase. Puede crear estéreo simulado si crea un patrón en zigzag que se vuelve más extremo
en la parte superior de un canal.

Define los valores de la regla horizontal (eje x) en una escala lineal o logarítmica. Seleccione Logarítmica para trabajar
con mayor detalle en las frecuencias más bajas. (La escala logarítmica refleja mejor los énfasis de frecuencia del oído humano.) Seleccione
Lineal para trabajar con mayor detalle en las frecuencias más altas.

Define los valores de la regla vertical (eje y) en una escala de 360° o 180°.

Especifica los canales a los que se aplicará el desplazamiento de fase.

Para obtener el mejor resultado, procese un único canal. Si aplica un desplazamiento de fase idéntico a dos canales estéreo, el archivo
resultante sonará exactamente igual.

Especifica el tamaño de transformación de Fourier rápida (FFT). Con tamaños mayores se obtienen resultados más precisos pero
se tarda más tiempo en procesarlos.
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Canal de referencia

Curvas polinomiales

Resolución de curva de tono

El efecto Corrección de tono manual permite ajustar el tono visualmente con la Visualización de tono espectral. La Visualización de tono espectral
muestra el tono fundamental como una línea azul brillante y los tonos armónicos en matices del amarillo al rojo. El tono corregido aparece como
una línea verde brillante.

Puede controlar el tono visualmente en cualquier momento, sin utilizar el efecto Corrección de tono manual. Tan solo tiene que hacer clic en el
icono Visualización de tono espectral <<ICON>> de la barra de opciones. Si desea personalizar la resolución, el rango de decibelios y las
líneas de cuadrícula, ajuste la configuración de Visualización de tono en las preferencias de Visualización espectral.

1. Elija Efectos > Tiempo y tono > Corrección de tono manual.

2. En la ventana Corrección de tono manual, establezca las opciones siguientes:

Seleccione un canal de origen en el que los cambios de tono estén bien claros. El efecto solo analizará
el canal que elija, pero aplicará la corrección de tono a todos los canales por igual.

Cree transiciones más suaves con los fotogramas clave envolventes para aplicar una corrección de
tono diferente en el tiempo.

Define el tamaño de transformación rápida de Fourier de cada fragmento de datos procesado
por el efecto. En general, utilice valores más bajos para corregir frecuencias más altas. Para voces, un ajuste de 2.048 o
4.096 suena más natural y un ajuste de 1.024 crea efectos robóticos.

3. En el panel Editor, realice una de las acciones siguientes:

Para cambiar el tono de forma uniforme, arrastre el control Ajustar tono <<ICON>> en la pantalla de visualización frontal.
Para cambiar el tono en el tiempo, añada fotogramas clave a la línea envolvente amarilla situada en el centro de la
visualización de la forma de onda.

Para acercar determinados rangos de tono, haga clic con el botón derecho del ratón y arrastre la regla vertical a la
derecha de la Visualización de tono espectral. Para restablecer el nivel de zoom o personalizar la escala visualizada, haga
clic con el botón derecho del ratón en la regla y seleccione las opciones en el menú emergente.

Cambio de tono en el panel Editor 
A. El control Ajustar tono cambia el tono de forma uniforme B. Los fotogramas clave en la línea envolvente cambian el tono en el tiempo
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Los efectos Amplitud y compresión > Envolvente de transición y Envolvente de ganancia funcionan de manera similar pero modifican el audio de
formas diferentes:

Seleccione Envolvente de transición para reducir la amplitud en cantidades variables con el tiempo.
Seleccione Envolvente de ganancia para aumentar o reducir la amplitud con el tiempo.

En el panel Editor, haga clic en la línea de envolvente amarilla para añadir fotogramas clave y arrástrelos hacia arriba o hacia abajo para cambiar
la amplitud. Para seleccionar, volver a situar o eliminar con rapidez varios fotogramas clave, consulte Automatización de ajuste con fotogramas
claves.

Seleccione la opción Curvas polinomiales para crear transiciones con curvas más suaves entre fotogramas clave, en lugar de transiciones
lineales. Consulte Acerca de las curvas de polinomiales para gráficos.
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Filter and equalizer effects

To the top

Scale

Spline Curves

Reset 

Advanced options

FFT Size

Window

To the top

Gain sliders

Range

FFT Filter effect
Graphic Equalizer effect
Parametric Equalizer effect

FFT Filter effect
The graphic nature of the Filter And EQ > FFT Filter effect makes it easy to draw curves or notches that reject or boost specific frequencies. FFT
stands for Fast Fourier Transform, an algorithm that quickly analyzes frequency and amplitude.

This effect can produce broad high- or low-pass filters (to maintain high or low frequencies), narrow band-pass filters (to simulate the sound of a
telephone call), or notch filters (to eliminate small, precise frequency bands).

Determines how frequencies are arranged along the horizontal x-axis:

For finer control over low frequencies, select Logarithmic. A logarithmic scale more closely resembles how people hear sound.

For detailed, high-frequency work with evenly spaced intervals in frequency, select Linear.

Creates smoother, curved transitions between control points, rather than more abrupt, linear transitions. (See About spline curves
for graphs.)

Reverts the graph to the default state, removing filtering.

Click the triangle to access these settings:

Specifies the Fast Fourier Transform size, determining the tradeoff between frequency and time accuracy. For steep, precise
frequency filters, choose higher values. For reduced transient artifacts in percussive audio, choose lower values. Values between 1024 and
8192 work well for most material.

Determines the Fast Fourier transform shape, with each option resulting in a different frequency response curve.
These functions are listed in order from narrowest to widest. Narrower functions include fewer surrounding, or sidelobe, frequencies but
less precisely reflect center frequencies. Wider functions include more surrounding frequencies but more precisely reflect center
frequencies. The Hamming and Blackman options provide excellent overall results.

Graphic Equalizer effect

The Filter And EQ > Graphic Equalizer effect boosts or cuts specific frequency bands and provides a visual representation of the resulting EQ
curve. Unlike the Parametric Equalizer, the Graphic Equalizer uses preset frequency bands for quick and easy equalization.

You can space frequency bands at the following intervals:

One octave (10 bands)

One-half octave (20 bands)

One-third octave (30 bands)

Graphic equalizers with fewer bands provide quicker adjustment; more bands provide greater precision.

Sets the exact boost or attenuation (measured in decibels) for the chosen band.

Defines the range of the slider controls. Enter any value between 1.5 and 120 dB. (By comparison, standard hardware equalizers have a
range of about 12 to 30 dB.)
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Accuracy

Master Gain

Note:

To the top

Master Gain

Graph

Frequency

Gain

Q / Width

Band

Constant Q, Constant Width

Sets the accuracy level for equalization. Higher accuracy levels give better frequency response in the lower ranges, but they require
more processing time. If you equalize only higher frequencies, you can use lower accuracy levels.

If you equalize extremely low frequencies, set Accuracy to between 500 and 5000 points.

Compensates for an overall volume level that is too soft or too loud after the EQ settings are adjusted. The default value of 0 dB
represents no master gain adjustment.

The Graphic Equalizer is an FIR (Finite Impulse Response) filter. FIR filters better maintain phase accuracy but have slightly less frequency
accuracy than IIR (Infinite Impulse Response) filters like the Parametric Equalizer.

Parametric Equalizer effect
The Filter And EQ > Parametric Equalizer effect provides maximum control over tonal equalization. Unlike the Graphic Equalizer, which provides a
fixed number of frequencies and Q bandwidths, the Parametric Equalizer gives you total control over frequency, Q, and gain settings. For example,
you can simultaneously reduce a small range of frequencies centered around 1000 Hz, boost a broad low-frequency shelf centered around 80 Hz,
and insert a 60 Hz notch filter.

The Parametric Equalizer uses second-order IIR (Infinite Impulse Response) filters, which are very fast and provide very accurate frequency
resolution. For example, you can precisely boost a range of 40 to 45 Hz. FIR (Finite Impulse Response) filters like the Graphic Equalizer provide
slightly improved phase accuracy, however.

Compensates for an overall volume level that’s too loud or too soft after you adjust the EQ settings.

Shows frequency along the horizontal ruler (x-axis) and amplitude along the vertical ruler (y-axis). Frequencies in the graph range from
lowest to highest in a logarithmic fashion (evenly spaced by octaves).

Identifying band-pass and shelving filters in the Parametric Equalizer: 
A. High- and low-pass filters B. High and low shelving filters 

Sets the center frequency for bands 1-5, and the corner frequencies for the band-pass and shelving filters.

Use the low shelving filter to reduce low-end rumble, hum, or other unwanted low-frequency sounds. Use the high shelving filter to reduce hiss,
amplifier noise, and the like.

Sets the boost or attenuation for frequency bands, and the per-octave slope of the band-pass filters.

Controls the width of the affected frequency band. Low Q values affect a larger range of frequencies. Very high Q values (close to 100)
affect a very narrow band and are ideal for notch filters removing particular frequencies, like 60 Hz hum.

When a very narrow band is boosted, audio tends to ring or resonate at that frequency. Q values of 1-10 are best for general equalization.

Enables up to five intermediate bands, as well as high-pass, low-pass, and shelving filters, giving you very fine control over the equalization
curve. Click the band button to activate the corresponding settings above.

The low and high shelving filters provide slope buttons ( ,  ) that adjust the low and high shelves by 12 dB per octave, rather than the
default 6 dB per octave.

To visually adjust enabled bands in the graph, drag the related control points.

Describes a frequency band’s width as either a Q value (which is a ratio of width to center frequency) or an
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Ultra-Quiet

Range

absolute width value in Hz. Constant Q is the most common setting.

Virtually eliminates noise and artifacts, but requires more processing. This option is audible only on high-end headphones and
monitoring systems.

Sets the graph to a 30 dB range for more precise adjustments, or a 96 dB range for more extreme adjustments.
About process effects

Apply individual effects in the Waveform Editor

Applying effects in the Waveform Editor
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Nota:

Tipo de trazado

Ajustar el volumen según la distancia o la dirección

Nivel de calidad

El efecto Especial > Desfasador Doppler genera un incremento y una reducción del tono que se aprecian cuando un objeto se aproxima y, a
continuación, se aleja del oyente, como cuando pasa un coche de policía con la sirena encendida. Cuando el coche se aproxima, el sonido llega a
sus oídos como una frecuencia superior porque el coche, al moverse hacia adelante, comprime cada onda sonora. Pasa lo contrario cuando el
coche pasa por delante; las ondas se amplían y el tono de sonido es más bajo.

A diferencia de muchos de los gráficos de los efectos de Adobe Audition, el gráfico de Desfasador Doppler no es interactivo: el usuario no
puede manipular el gráfico directamente. En su lugar, el gráfico cambia a medida que ajusta los parámetros de efectos.

Define el trazado que sigue aparentemente el origen de sonido. Dependiendo del tipo de trazado, estará disponible un conjunto
de opciones diferente. 

Opciones de Línea recta:

Distancia hasta el comienzo define el punto de inicio virtual (en metros) del efecto.
Velocidad define la velocidad virtual (en metros por segundo) a la que se desplaza el efecto.
Procedente de define la dirección virtual (en grados) desde la que parece que proviene el efecto.
Pasa por delante especifica a qué distancia (en metros) el efecto parece pasar por delante del oyente.
Pasa a la derecha especifica a qué distancia (en metros) el efecto parece pasar a la derecha del oyente.

Opciones de Circular:

Radio define las dimensiones circulares (en metros) del efecto.
Velocidad define la velocidad virtual (en metros por segundo) a la que se desplaza el efecto.
Ángulo inicial define el ángulo virtual de inicio (en grados) del efecto.
Centrar en frente especifica a qué distancia (en metros) se encuentra la fuente de sonido por delante del oyente.
Centrar a la derecha especifica a qué distancia (en metros) se encuentra la fuente de sonido de la derecha del oyente.

Ajusta el volumen del efecto automáticamente en función de los valores especificados.

Proporciona seis niveles diferentes de calidad de procesamiento. Los niveles de calidad más bajos requieren menos tiempo de
procesamiento, pero unos niveles de calidad más altos normalmente generan mejores resultados de sonido. 
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Escala

Clave

Atacar

Sensibilidad

Canal de referencia

Tamaño FFT

Calibración

Medidor de corrección

Efecto Corrección automática de tono
El efecto Corrección automática de tono está disponible en los editores Forma de onda y Multipista. En el segundo caso, sus parámetros pueden
automatizarse en el tiempo mediante el uso de fotogramas clave y superficies de control externas.

Elija Efectos > Tiempo y tono > Corrección automática de tonoy establezca las opciones siguientes:

Especifica el tipo de escala que se adapta mejor al material: Mayor, Menor, o Cromática. Mayor y Menor permiten realizar mayores
correcciones, en las que la diferencia de tono del audio de origen supera el medio paso. Cromática funciona mejor cuando solo se necesita una
ligera corrección para arrastrar el tono hasta la nota cromática más próxima.

Define la clave deseada del material corregido. Esta opción solo está disponible si Escala se define como Mayor o Menor (dado que la
escala Cromática incluye los 12 tonos y no depende de la clave).

Controla la rapidez con la que Adobe Audition corrige el tono con relación al tono de la escala. Generalmente, los ajustes más rápidos son
óptimos para el audio formado por notas breves, como un fragmento rápido ejecutado por una trompeta. No obstante, un ataque muy rápido
puede resultar en una calidad robótica. Los ajustes más lentos generan una corrección de sonido más natural en notas sostenidas más largas,
como una línea vocal en la que el cantante mantiene notas y agrega vibrato. Dado que el material de origen puede cambiar a lo largo de una
interpretación musical, obtendrá resultados más naturales si corrige frases musicales breves por separado.

Define el umbral por encima del cual no se corrigen las notas. La Sensibilidad se mide en céntimos y hay 100 céntimos por
semitono. Por ejemplo, un valor de Sensibilidad de 50 céntimos significa que una nota debe estar a una distancia máxima de 50 céntimos (medio
semitono) de la escala de destino antes de corregirse automáticamente.

Seleccione un canal de origen en el que los cambios de tono estén bien claros. El efecto solo analizará el canal que elija,
pero aplicará la corrección de tono a todos los canales por igual.

Define el tamaño de transformación rápida de Fourier de cada fragmento de datos procesado por el efecto. En general, utilice
valores más bajos para corregir frecuencias más altas. Para voces, un ajuste de 2.048 o 4.096 suena más natural y un ajuste de 1.024 crea
efectos robóticos.

Especifica el estándar de entonación para el audio de origen. En la música occidental, el estándar es A4 a 440 Hz. No obstante, el
audio de origen puede haberse grabado con otro estándar, por lo que se pueden especificar valores A4 de 410 a 470 Hz.

Al previsualizar audio, muestra la cantidad de corrección de los tonos bemoles y sostenidos.
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Efecto Corrección de tono manual (solo en el Editor de forma de
onda)

 

Canal de referencia

Curvas polinomiales

Resolución de curva de tono

El efecto Corrección de tono manual permite ajustar el tono visualmente con la Visualización de tono espectral. La Visualización de tono espectral
muestra el tono fundamental como una línea azul brillante y los tonos armónicos en matices del amarillo al rojo. El tono corregido aparece como
una línea verde brillante.

Puede controlar el tono visualmente en cualquier momento, sin utilizar el efecto Corrección de tono manual. Tan solo tiene que hacer clic en el
icono Visualización de tono espectral <<ICON>> de la barra de opciones. Si desea personalizar la resolución, el rango de decibelios y las
líneas de cuadrícula, ajuste la configuración de Visualización de tono en las preferencias de Visualización espectral.

1. Elija Efectos > Tiempo y tono > Corrección de tono manual.

2. En la ventana Corrección de tono manual, establezca las opciones siguientes:

Seleccione un canal de origen en el que los cambios de tono estén bien claros. El efecto solo analizará
el canal que elija, pero aplicará la corrección de tono a todos los canales por igual.

Cree transiciones más suaves con los fotogramas clave envolventes para aplicar una corrección de
tono diferente en el tiempo.

Define el tamaño de transformación rápida de Fourier de cada fragmento de datos procesado
por el efecto. En general, utilice valores más bajos para corregir frecuencias más altas. Para voces, un ajuste de 2.048 o
4.096 suena más natural y un ajuste de 1.024 crea efectos robóticos.

3. En el panel Editor, realice una de las acciones siguientes:

Para cambiar el tono de forma uniforme, arrastre el control Ajustar tono <<ICON>> en la pantalla de visualización frontal.
Para cambiar el tono en el tiempo, añada fotogramas clave a la línea envolvente amarilla situada en el centro de la
visualización de la forma de onda.

Para acercar determinados rangos de tono, haga clic con el botón derecho del ratón y arrastre la regla vertical a la
derecha de la Visualización de tono espectral. Para restablecer el nivel de zoom o personalizar la escala visualizada, haga
clic con el botón derecho del ratón en la regla y seleccione las opciones en el menú emergente.

Cambio de tono en el panel Editor 
A. El control Ajustar tono cambia el tono de forma uniforme B. Los fotogramas clave en la línea envolvente cambian el tono en el tiempo
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Efectos de manipulación de tiempo y tono

Volver al principio

Efecto Expansión y tono (solo Editor de forma de onda)

Efecto Expansión y tono (solo Editor de forma de onda)
El Efecto Tiempo y tono > Expansión y tono permite modificar el tono de una señal de audio, el tiempo, o ambos. Por ejemplo, puede utilizar este
efecto para transponer una canción a una clave superior sin cambiar el tempo o para reducir la velocidad de un fragmento hablado sin cambiar el
tono.

Nota: Este efecto requiere el procesamiento sin conexión. Mientras está abierto, no es posible editar la forma de onda, ajustar las selecciones ni
mover el indicador de tiempo actual.

Algoritmo Seleccione Radio IZotope si desea ampliar el audio y cambiar el tono simultáneamente, o bien, Audition si desea modificar los ajustes
de expansión o tono progresivamente. El algoritmo Radio IZotope requiere un procesamiento más largo pero introduce menos efectos no
deseados.
Precisión Los ajustes más elevados producen una mejor calidad, pero requieren más tiempo de procesamiento.
Nueva duración Indica cuál será la duración del audio tras la expansión de tiempo. Es posible ajustar el valor Nueva duración directamente o
indirectamente, modificando el porcentaje de expansión.

Si se suelen ampliar los archivos hasta una duración determinada, haga clic en el icono Favorito para guardar ese ajuste para un uso
posterior. Para aplicar un favorito a varios archivos, consulte Proceso por lotes de archivos.

Bloquear los ajustes de ampliación en la nueva duración Omite los ajustes de ampliación personalizados o preestablecidos, en lugar de
calcularlos a partir de los ajustes de duración.

Seleccione la opción anterior para crear spots de radio de 30 o 60 segundos.

Expansión Acorta o amplía el audio procesado relativo al audio existente. Por ejemplo, para reducir el audio a la mitad de su duración actual,
especifique un valor de expansión del 50%.
Deformación de tono Desplaza tonalmente el audio hacia arriba y hacia abajo. Cada semitono es igual a un semitono de un teclado.
Expansión final o Deformación de tono (algoritmo de Audition) Cambia el ajuste inicial de Expansión o Deformación de tono
progresivamente, logrando el ajuste final en la última muestra de audio seleccionada.
Bloquear expansión y deformación de tono (algoritmo de IZotope) Expande el audio para reflejar cambios de tono o viceversa.
Bloquear expansión inicial y deformación de tono (algoritmo de Audition) Expande el audio para reflejar cambios de tono o viceversa. Los
ajustes de Expansión final o Deformación de tono no se ven afectados.
Ajustes avanzados (algoritmo de Radio IZotope) Haga clic en el triángulo para acceder a las siguientes opciones:

Instrumento o voz solista  Procesa los solos con más rapidez.
Conservar las características de voz  Mantiene el realismo de un discurso.
Desplazamiento de componentes  Determina cómo los componentes se ajustan a los cambios de tono. El valor predeterminado cero
ajusta componentes con cambios de tono, manteniendo el timbre y el realismo. Los valores por encima de cero producen timbres más
altos (lo que hace que una voz masculina suene como femenina, por ejemplo). Los valores por debajo de cero hacen lo contrario.
Coherencia de tono  Mantiene el timbre de las voces o instrumentos solistas. Los valores más altos reducen los efectos no deseados de
fase pero introducen más modulación de tono.

Ajustes avanzados (algoritmo de Audition) Haga clic en el triángulo para acceder a las siguientes opciones:

Frecuencia de empalme  Determina el tamaño de cada fragmento de datos de audio cuando se conserva el tono o el tempo mientras se
expande una forma de onda. Mientras más alto es el valor, más precisa es la colocación de audio ampliado a lo largo del tiempo. Sin
embargo, los efectos son más notables conforme aumentan las velocidades; el sonido puede llegar a ser más metálico o tener una
calidad "de túnel". Con ajustes de mayor precisión, las frecuencias de empalme más bajas puede agregar inestabilidad o eco.
Superposición  Determina el tamaño del fragmento de datos de audio que se superpone a los anteriores y a los siguientes. Esta
expansión produce un efecto de coro y disminuye el porcentaje de Superposición, sin que la ralentización produzca un sonido desigual. La
superposición puede llegar al 400% pero debe utilizar este valor solo para obtener un gran aumento de velocidad (200% o más).
Seleccione ajustes predeterminados apropiados  Aplica valores predeterminados correctos para la frecuencia de empalme y la
superposición. Esta opción es muy útil mantener el tono o el tempo.
Vocales constantes  Mantiene el sonido de las vocales en voces ampliadas. Esta opción requiere mucho procesamiento; pruebe con una
pequeña selección antes de aplicarla a una más grande.

Más temas de ayuda
Utilización de ajustes preestablecidos de efectos
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Mezcla de sesiones multipista

Parte del contenido vinculado a esta página puede estar solo en inglés.



-->

Automatización de mezclas con envolventes (CS6)

Volver al principio

Nota:

Automatización de los ajustes de clip
Automatización de los ajustes de pista
Automatización de ajuste con fotogramas clave

Al automatizar mezclas, puede cambiar los ajustes de mezcla más adelante. Por ejemplo, puede incrementar automáticamente el volumen durante
un pasaje musical crítico y reducir el volumen más tarde con una atenuación gradual. Consulte este tutorial de vídeo para ver la automatización
de mezcla en acción.

Las envolventes de automatización indican los ajustes visualmente en puntos específicos en el tiempo y se pueden editar arrastrando los
fotogramas clave sobre las líneas de envolvente. Las envolventes son no destructivas, por lo que no varían en absoluto los archivos de audio. Por
ejemplo, si abre un archivo en el Editor de forma de onda, no se escuchan los efectos de las envolventes aplicados en el editor.

Envolventes de clip y de pista en el panel Editor 
A. Envolvente de clip B. Envolvente de pista 

Automatización de los ajustes de clip
Con las envolventes de clip, se pueden automatizar los ajustes de volumen y panorámica del clip.

En las pistas estéreo, el volumen del clip y los envolventes de panorámica aparecen de forma predeterminada; es posible identificarlos por color y
posición inicial. Los envolventes de volumen son líneas amarillas que se sitúan al inicio en la parte media superior de los clips. Las envolventes
panorámicas son líneas azules que inicialmente se sitúan en el centro. (En el caso de las envolventes panorámicas, la parte superior del clip
representa la izquierda máxima y la parte inferior la derecha máxima.)

En las pistas envolventes 5.1 y mono, los clips no disponen de envolventes de panorámica.

Dos envolventes de clip 
A. Envolvente panorámico B. Envolvente de volumen 

Mostrar u ocultar envolventes de clip
Los envolventes del clip se pueden ver de forma predeterminada, pero si interfieren con la edición o suponen una distracción visual, se pueden
ocultar.

En el menú Vista, seleccione una de las siguientes opciones:
Mostrar envolventes de volumen de clip

Mostrar envolventes panorámicas de clip

Mostrar envolventes de efecto de clip

Cómo mostrar u ocultar los parámetros de automatización independientes

Muestra de un parámetro para un efecto

En la esquina superior derecha de un clip, haga clic en el menú del parámetro y seleccione la opción de mezcla del Bastidor o
un parámetro de efecto. (En el menú, los parámetros visibles aparecen seleccionados. Vuelva a seleccionar un parámetro para
ocultarlo.)

Tras editar los fotogramas clave de un parámetro, aparecerá un asterisco (*) en el menú.

La opción Potencia de bastidor permite activar y desactivar el bastidor de efectos de un clip.

Desactivación de la edición de fotogramas clave

http://tv.adobe.com/watch/adobe-evangelists-jason-levine/multitrack-mixing-automation-in-adobe-audition-cs55-/
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Desactivado

Leer

Escribir

Enclavar

Tocar

Para evitar la creación o el movimiento de fotogramas claves por error, desactive la edición del fotograma clave.

En el menú Multipista, anule la selección de Activar edición de fotograma clave de clip.

Automatización de los ajustes de pista
Puede cambiar los ajustes de volumen, panorámica y efecto de las envolventes de pistas más adelante. Adobe Audition muestra las envolventes
de pista en rutas de automatización situadas debajo de cada pista. Cada parámetro automatizado tiene su propio envolvente, que se edita del
mismo modo que los envolventes de clip.

Automatización de los ajustes de pista en el panel Editor 
A. Ruta de automatización B. Envolvente para parámetro 

Creación de envolventes de pista
Los envolventes de pista permiten cambiar de forma precisa los ajustes de la pista en puntos de tiempo concretos.

Visualización de las rutas de automatización en el panel Editor

1. En el panel Editor, haga clic en el triángulo situado a la izquierda del menú Modo de automatización de pista para la pista
que desee automatizar. (De forma predeterminada, el menú está ajustado en Leer.)

2. En el menú Mostrar envolventes, seleccione un parámetro para automatizar.
3. En la línea de envolvente, haga clic y arrastre para añadir y ajustar fotogramas clave.

Grabación de la automatización de pistas
Mientras se reproduce una sesión, se pueden grabar los cambios realizados a los ajustes de volumen, panorámica y efectos de la pista, y crear
así una mezcla que evoluciona con el tiempo. Adobe Audition convierte automáticamente los ajustes en envolventes de pista que se pueden editar
con precisión.

Con un controlador externo con el control Mackie, se pueden modificar varios ajustes simultáneamente. Consulte Compatibilidad con diferentes
superficies de control.

1. En el panel Principal, sitúe el indicador de tiempo actual en el punto en el que desee que comience la grabación de la
automatización.

2. Seleccione una opción en el menú Modo de automatización de pista.
3. Para comenzar a grabar la automatización, inicie la reproducción. Mientras se reproduce el audio, modifique los ajustes de la

pista o los efectos en los paneles Editor, Mezclador o Bastidor de efectos.
4. Para detener la grabación de la automatización, detenga la reproducción.

Si los fotogramas clave grabados son muy numerosos o irregulares, consulte Optimización de la automatización grabada.

Opciones del Modo de automatización de pista
En el panel Editor o Mezclador, puede seleccionar uno de los siguientes modos para cada pista:

Ignora los envolventes de pista durante la mezcla y la grabación pero continúa mostrándolos para poder agregar o ajustar
fotogramas clave de forma manual.

Aplica las envolventes de pista durante la mezcla o reproducción pero no graba los cambios que se realizan. (Se pueden previsualizar los
cambios, pero los fotogramas clave vuelven a los ajustes grabados.)

Cuando se inicia la reproducción, se sobrescriben los fotogramas clave existentes con la configuración actual. Continúa grabando los
nuevos ajustes hasta que se detenga la reproducción.

Comienza a grabar fotogramas clave cuando se modifica un ajuste por primera vez y continúa grabando los nuevos ajustes hasta que
se detiene la reproducción.

Similar a Enclavar, pero cuando se dejan de modificar los ajustes vuelve gradualmente a los valores grabados previamente. Use Tocar
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Correspondencia automática de hora

Reducción de punto de edición clave linear

Reducción de intervalo de tiempo mínimo

Volver al principio

para sobrescribir secciones específicas de la automatización y dejar el resto intacto.

Protección de ajustes al grabar automatización
Durante la grabación de la automatización, es posible que desee proteger determinados parámetros contra cambios inesperados, mientras ajusta
otros parámetros.

1. En la parte izquierda del panel Editor, desplácese a los controles de la pista específica.
2. Haga clic en el icono Mostrar/Ocultar rutas de automatización [ICON].
3. En el menú Mostrar envolventes, seleccione el parámetro.
4. Haga clic en el icono Proteger el parámetro [ICON].

Optimización de los fotogramas clave de automatización grabados
Para evitar que la automatización grabada cree fotogramas clave excesivos o irregulares, optimice los siguientes ajustes en la sección Multipista
del cuadro de diálogo Preferencias.

Determina la rapidez con la que los parámetros vuelven a sus valores originales en el modo Tocar.
Puede definir valores desde 0,00 a 5,00 segundos, siendo el valor predeterminado de 1,00 segundo.

Elimina los fotogramas clave que representan ajustes de parámetros estáticos sin modificar.

Crea fotogramas clave en intervalos de tiempo mayores que el valor especificado. Introduzca un
intervalo entre 1 y 2000 milisegundos en el campo Tiempo mínimo.

Automatización de ajuste con fotogramas clave
Los fotogramas clave de las líneas de envolventes cambian los parámetros de la pista y el clip con el tiempo. Adobe Audition calcula
automáticamente, o bien, interpola, todos los valores intermedios entre fotogramas clave utilizando uno de estos dos métodos de transición:

Las transiciones de mantenimiento  crean un cambio brusco en el valor de cada fotograma clave nuevo.

Las transacciones lineales  crean un cambio uniforme y gradual entre fotogramas clave.

También puede aplicar curvas polinomiales en un envolvente completo, omitiendo el ajuste específico del fotograma clave para crear transiciones
de sonido natural que cambien la velocidad junto a los fotogramas clave. (Consulte Acerca de las curvas polinomiales para gráficos.)

Transiciones entre fotogramas clave 
A. Congelar B. Lineal (valor predeterminado) C. Curvas polinomiales 

Adición de un fotograma clave

Realice una de las siguientes acciones:

Sitúe el puntero sobre una línea de envolvente. Cuando aparezca el signo más , haga clic.

Coloque el cabezal de reproducción donde le gustaría que cambiara el parámetro de pista. A continuación, haga clic en el
icono Agregar fotograma clave  en los controles de la pista.

Desplazamiento entre los fotogramas clave de la pista

1. En el panel Editor, seleccione un parámetro en el menú Seleccionar situado junto a la parte inferior de los controles de pista.

2. Haga clic en Fotograma clave anterior  o en el icono Siguiente fotograma clave .

Selección de varios fotogramas clave para un parámetro

Haga clic con el botón derecho en cualquier fotograma clave y elija Seleccionar todos los fotogramas clave.

Mantenga presionada la tecla Ctrl (Windows) o Comando (Mac OS) y haga clic en los fotogramas clave específicos.

Mantenga presionada la tecla Mayús y seleccione una serie de fotogramas clave.

Nueva posición de fotogramas clave o línea envolvente

Para reposicionar fotogramas clave seleccionados, arrástrelos. (Para mantener la posición de tiempo o el valor del parámetro,
mantenga presionada Mayús y arrastre.)

Para reposicionar un segmento de un envolvente sin crear un fotograma clave, mantenga presionada la tecla Ctrl (Windows) o
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Comando (Mac OS) y arrastre.

Modificación de la transición entre dos fotogramas clave

Haga clic con el botón derecho del ratón en el primer fotograma clave y seleccione Mantener fotograma clave para cambiar
radicalmente los valores, o bien, anule la sección de la opción para pasar gradualmente de un valor al siguiente.

Aplicación de curvas polinomiales a un envolvente completo

Haga clic con el botón derecho en una línea envolvente y seleccione Curvas polinomiales.

Eliminación de fotogramas clave

Haga clic con el botón derecho en una línea envolvente y seleccione Eliminar fotogramas clave. O bien, arrastre un fotograma
clave independiente fuera de un clip o pista.

Desactivación de la edición de fotogramas clave de clip

Para evitar la creación o el movimiento de fotogramas claves por error, desactive la edición del fotograma clave.

En el menú Multipista, anule la selección de Activar edición de fotograma clave de clip.

Edición de sesiones multipista en el panel Editor y el Mezclador
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Automating mixes with envelopes (CS5.5)

Note:

To the top

Note:

Automating clip settings
Automating track settings
Adjust automation with keyframes

Some features in the Windows version of Adobe Audition 3.0 are not available in CS5.5. Examples include control surface support, CD
burning, MIDI, some file formats and effects, clip grouping and time stretching, and the metronome. For a complete list, see Adobe Audition 3.0
features replaced or not implemented in CS5.5.

By automating mixes, you can change mix settings over time. For example, you can automatically increase volume during a critical musical
passage and later reduce the volume in a gradual fade out. See this video tutorial to watch mix automation in action.

Automation envelopes visually indicate settings at specific points in time, and you can edit them by dragging keyframes on envelope lines.
Envelopes are nondestructive, so they don’t change audio files in any way. If you open a file in the Waveform Editor, for example, you don’t hear
the effect of any envelopes applied in the Multitrack Editor.

Clip and track envelopes in the Editor panel 
A. Clip envelope B. Track envelope 

Automating clip settings
With clip envelopes, you can automate clip volume, pan, and effect settings.

On stereo tracks, clip volume and pan envelopes appear by default; you can identify them by color and initial position. Volume envelopes are
yellow lines initially placed across the upper half of clips. Pan envelopes are blue lines initially placed in the center. (With pan envelopes, the top of
a clip represents full left, while the bottom represents full right.)

On mono and 5.1 surround tracks, clips lack pan envelopes.

Two clip envelopes 
A. Pan envelope B. Volume envelope 

Show or hide clip envelopes
Clip envelopes are visible by default, but if they interfere with editing or are visually distracting, you can hide them.

From the View menu, choose any of the following:
Show Clip Volume Envelopes 

Show Clip Pan Envelopes

Show Clip Effect Envelopes

Show or hide individual automation parameters
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Showing a parameter for an effect

In the upper-right corner of a clip, click the parameter menu, and select a Rack mixing option or an effect parameter.

The Rack Power option lets you turn clip effects on and off over time.

Automating track settings
With track envelopes, you can change volume, pan, and effect settings over time. Adobe Audition displays track envelopes in an automation lane
below each track. Each automated parameter has its own envelope, which you edit just like clip envelopes.

Automating track settings in the Editor panel 
A. Automation lane B. Envelope for parameter 

Create track envelopes
Track envelopes let you precisely change track settings at specific points in time.

Showing automation lanes in Editor panel

1. In Editor panel, click the triangle to the left of the Read menu for the track you want to automate.
2. From the Show Envelopes menu, select a parameter to automate.
3. On the envelope line, click and drag to add and adjust keyframes.

Track Automation Mode options
In the Editor panel or Mixer, you can choose one of the following modes for each track:



Off

Read
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Track Automation Mode menu

Ignores track envelopes during playback and mixdown, but continues to display envelopes so you can manually add or adjust edit points.

Applies track envelopes during playback and mixdown.

Adjust automation with keyframes
Keyframes on envelope lines change clip and track parameters over time. Adobe Audition automatically calculates, or interpolates, all the
intermediate values between keyframes using one of two transition methods:

Hold  transitions create an abrupt change in value at each new keyframe.

Linear  transitions create a gradual, even change between keyframes.

You can also apply spline curves to an entire envelope, overriding the keyframe-specific setting above to create natural-sounding transitions that
change in speed near keyframes. (See About spline curves for graphs.)

Transitions between keyframes 
A. Hold B. Linear (the default) C. Spline curves 

Add a keyframe

Do either of the following:

Position the pointer over an envelope line. When a plus sign  appears, click.

Position the current-time indicator where you’d like a track parameter to change. Then click the Add Keyframe icon  in the
track controls.

Navigate between track keyframes

1. In the Editor panel, choose a parameter from the Select menu near the bottom of the track controls.

2. Click the Previous Keyframe  or Next Keyframe  icon.

Select multiple keyframes for a parameter

Right-click any keyframe, and choose Select All Keyframes.

Hold down Ctrl (Windows) or Command (Mac OS), and click specific keyframes.

Hold down Shift, and click to select a series of keyframes.

Reposition keyframes or the envelope line

To reposition selected keyframes, drag them. (To maintain time position or parameter value, hold down Shift and drag.)

To reposition a segment of an envelope without creating a keyframe, hold down Ctrl (Windows) or Command (Mac OS), and
drag.

Change the transition between two keyframes

Right-click the first keyframe, and select Hold Keyframe to abruptly change values, or deselect it to gradually transition from
one value to the next.

http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/es-es/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
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Apply spline curves to an entire envelope

Right-click an envelope line, and choose Spline Curves.

Delete keyframes

Right-click an envelope line, and choose Delete Selected Keyframes. Or, drag an individual keyframe off a clip or track.

Disable keyframe editing

To avoid inadvertently creating or moving keyframes, disable keyframe editing.

From the Multitrack menu, deselect Enable Clip Keyframe Editing.

Editing multitrack sessions in the Editor panel and Mixer
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Arranging and editing multitrack clips
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Select and move clips
Snap to clip endpoints
Copy a clip
Trimming and extending clips
Split clips
Set audio clip properties

When you insert an audio file in the Multitrack Editor, the file becomes a clip on the selected track. You can easily move clips to different tracks or
timeline positions. You can also edit clips nondestructively, trimming their start and end points, crossfading them with other clips, and more.

To arrange clips in the Editor panel, you use the Move  or Time Selection  tools.

Select and move clips
Do any of the following:

To select an individual clip, click it in the Editor panel.

To select all clips in selected tracks, choose Edit > Select > All Clips In Selected Track.

To select all clips in a session, choose Edit >Select > Select All.

To move selected clips, select the Move tool  in the toolbar, and then drag the clips. Or choose Clip > Nudge Right or
Nudge Left to move clips one pixel at a time. (If you zoom in to see individual samples, nudging moves clips one sample at
a time.)

To move clips with the Time Selection tool , right-click and drag (similar to the Hybrid tool technique in previous versions).
You can also drag the clip header with any tool.

Snap to clip endpoints
Snapping lets you quickly align clips with other clips. If snapping is enabled, both dragged clips and the current-time indicator snap to selected
items. While you drag a clip, a white line appears in the Editor panel when snapping points meet.

1. To enable snapping for selected items, click the Toggle Snapping icon  at the top of the Editor panel.
2. Choose Edit > Snapping > Snap To Clips.

For more information, see Snap to loop beats and Snap to markers, rulers, frames, and zero crossings.

Copy a clip
You can create two types of copied audio clips: reference copies that share source files and unique copies that have independent source files.
The type of copy you choose depends upon the amount of available disk space and the nature of destructive editing you plan to perform in the
Waveform Editor.

Reference copies consume no additional disk space, letting you simultaneously edit all instances by editing the original source file. (For example,
you can add the Flanger effect to a source file in the Waveform Editor and automatically apply the effect to all 30 referenced copies in a session.)

Unique copies have a separate audio file on disk, allowing for separate editing of each version in the Waveform Editor. (For example, you can add
destructive effects to the version in an introduction while leaving the version in a verse dry.)

To quickly copy a reference, press Ctrl + C (Windows) or Cmd + C (Mac OS). Alternatively, Alt-drag (Windows) or Option-drag (Mac OS) the
clip header.

1. Click the Move tool  in the toolbar. Then right-click and drag the clip.

To copy with the Time Selection tool , right-click and drag the clip header (similar to the Hybrid tool technique in previous
versions).

2. Release the mouse button, and choose one of the following from the pop-up menu:
Copy Here (to copy a reference)
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Copy Unique Here

Trimming and extending clips
You can trim or extend audio clips to suit the needs of a mix. Because the Multitrack Editor is nondestructive, clip edits are impermanent; you can
return to the original, unedited clip at any time. If you want to permanently edit an audio clip, however, you can quickly open the source file in the
Waveform Editor. (See Comparing the Waveform and Multitrack editors.)

Remove a selected range from clips

1. In the toolbar, click the Time Selection tool .
2. Drag across one or more clips to select them and a range.
3. Do one of the following:

To remove the range from clips and leave a gap in the timeline, choose Edit > Delete.

To remove the range and collapse the gap in the timeline, choose Edit > Ripple Delete, and select one of the following
options:

Selected Clips

Removes selected clips, shifting remaining clips on the same tracks.

Time Selection in Selected Clips

Removes the range from selected clips, splitting them if necessary.

Time Selection in All Tracks

Removes the range from all clips in the session.

Time Selection in Selected Track

Removes the range only from the currently highlighted track in the Editor panel.

Collapse a gap between clips on a track
Right-click the empty area between the clips, and choose Ripple Delete > Gap.

Trim or extend clips
1. If you want to repeat a clip, right-click it and select Loop. (See Looping clips.)

2. In the Editor panel, position the cursor over the left or right edge of the clip. The edge-dragging icon  appears.
3. Drag clip edges.

Shift the contents of a trimmed or looped clip
You can slip edit a trimmed or looped clip to shift its contents within clip edges.

Shift clip contents within clip edges

1. In the toolbar, click the Slip tool .
2. Drag across the clip.

Permanently edit a clip’s source file in the Waveform Editor
Double-click the clip header.

Split clips
Split audio clips to break them into separate clips that you can independently move or edit.

Split clips with the Razor tool
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Razor Selected Clips

Razor All Clips
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Clip Color

Clip Gain

Lock in Time

Loop

Mute

1. In the toolbar, hold down the Razor tool , and choose one of the following from the pop-up menu:

Splits only clips you click.

Splits all clips at the time point you click.

Tip: To switch between these modes in the Editor panel, press Shift.

2. In the Editor panel, click where you want the split to occur.

Split all clips at the current-time indicator

1. Position the current-time indicator where one or more audio clips exist.

2. Choose Clip > Split.

Set audio clip properties
In the Properties panel, you can quickly change multiple settings for selected audio clips. Clip settings for gain and mute are independent from
similar track controls.

1. Select an audio clip, and choose Window > Properties.

You can access individual properties from the Clip menu.

2. Set the following options:

To change the clip name, type in the text box at the top of the panel.

Click the swatch to customize. A swatch with a red slash indicates that the clip is using the default color for the
current Appearance preset. (See Change interface colors, brightness, and performance.)

Compensates for a low or high volume clip that is difficult to mix.

Allows only up or down moves to other tracks, with a fixed timeline position. A lock icon  appears on the clip.

Enables clip looping. For more information, see Looping clips.

Silences the clip.

Select ranges in the Multitrack Editor
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Modo

Tipo

Duración, Ampliación y Tono

Ajustes avanzados

1. Elija Clip > Ampliación > Activar ampliación del clip global.

2. En el panel Editor, arrastre los triángulos blancos de la esquina superior derecha o izquierda de los clips.

Seleccione varios clips para ampliarlos proporcionalmente.

Para personalizar los ajustes de ampliación de los clips seleccionados, ajuste las opciones de Ampliación siguientes en el panel Propiedades:

Elija entre las siguientes opciones:
Desactivado desactiva la ampliación y devuelve el clip a su longitud original.
Tiempo real le permite oír los resultados de la ampliación a medida que arrastra los clips. Este modo es una buena opción
durante el proceso de edición.
Procesado (alta calidad) requiere un mayor procesamiento pero puede evitar las irregularidades de audio. Elija este modo si la
reproducción o el rendimiento son lentos en el modo de tiempo real.

Elija entre las siguientes opciones:
Monofónica es la mejor opción para instrumentos musicales solistas o diálogos.
Polifónica es la mejor opción para música con varios instrumentos o sonidos ambientales complejos.
Velocidad variable cambia el tono además de la duración, de forma similar a disminuir la velocidad o acelerar las máquinas
con cintas analógicas.

Para aplicar el mismo modo a todos los clips con rapidez, elija Clip > Ampliación > Todos los clips ampliados en tiempo real o Procesar todos
los clips ampliados.

Si se introducen entradas numéricas, los ajustes serán más precisos que los permitidos cuando se arrastran clips
en el panel Editor.

Establezca las siguientes opciones:
Sensibilidad transitoria (disponible en el modoPolifónica) establece la sensibilidad de las transiciones como la batería y los
principios de notas, que se utilizan como puntos de anclaje para la ampliación. Auméntelo si las transiciones no suenan
naturales.
Tamaño de ventana define el tamaño, en milisegundos, de cada fragmento de audio procesado. Ajústelo solo si se producen
ecos o irregularidades en el sonido.
Los ajustes Precisión (disponibles en el modo Procesado) determinan el equilibrio entre la calidad y la velocidad de
procesamiento.
Conservar componentes (disponible al seleccionar Procesado y Monofónica) ajusta el timbre de los instrumentos y las voces, y
mantiene el realismo en los cambios de tono.

Para que las voces masculinas suenen femeninas y viceversa, seleccione Conservar componentes y cambie el tono drásticamente.
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Controles básicos multipista
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Pistas maestras, de bus, audio y vídeo
Selección entre pistas 5.1, mono y estéreo
Incorporación o eliminación de pistas
Asignación de un nombre a una pista o moverla
Aplicación de zoom vertical a pistas
Silenciar pistas y convertirlas a solo
Aplicación del mismo ajuste a todas las pistas
Definición del volumen de salida de una pista
Panorámica de pistas en estéreo
Duplicación de pistas

Pistas maestras, de bus, audio y vídeo
Las sesiones multipista pueden incluir cuatro tipos de pistas distintos:

Las pistas de vídeo  contiene un clip de vídeo importado. Una sesión puede incluir un clip y una pista de vídeo al mismo
tiempo. Puede ver una previsualización en el panel Vídeo (Ventana > Vídeo).

Pistas de audio  contienen audio importado o clips guardados en la sesión actual. Estas pistas ofrecen el rango de
controles más amplio, lo que le permite especificar salidas y entradas, aplicar efectos y ecualización, enrutar el audio a envíos
y bus y automatizar las mezclas.

Las pistas de bus  le permiten combinar las salidas de varias pistas de audio o envíos y controlarlas de forma colectiva.

La pista Maestra , que es la última en cada sesión, le permite combinar fácilmente las salidas de múltiples pistas y bus y
controlarlos con un único atenuador.

Para obtener más información, consulte Enrutamiento de audio a buses, envíos y pista Maestra.

Selección entre pistas 5.1, mono y estéreo
Las sesiones multipista admiten un número ilimitado de pistas de bus y audio 5.1, mono y estéreo. Al añadir pistas, seleccione una configuración
de canal en función de la configuración de la pista maestra:

Para los originales mono, añada pistas de bus y audio mono.

Para los originales estéreo, añada pistas de bus y audio estéreo; excepto las pistas de audio con orígenes mono (como un
solo micrófono).

Para las pistas maestras 5.1, añada pistas de audio estéreo y las pistas de bus 5.1 (para mantener las fases de ganancia
adecuadas). Sin embargo, si dispone de algún clip de audio 5.1, añada pistas de audio 5.1 para incluirlas.

Para identificar canales de pista, observe los medidores del panel Editor o Mezclador:
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A.  Mono B.  Estéreo C.  5.1

Incorporación o eliminación de pistas
Nota: Una sesión multipista solo admite una pista de vídeo, que Adobe Audition siempre inserta en la parte superior del panel Editor.

 En el panel Editor o el Mezclador, realice una de las siguientes acciones:

Para insertar una pista, seleccione la pista que desea que la preceda y, a continuación, seleccione Insertar > Pista > Agregar
[tipo de] pista.

Para eliminar una pista, selecciónela y, a continuación, seleccione Multipista > Pista > Eliminar pista seleccionada.

Para obtener más información, consulte lo siguiente:

Inserción de un archivo de audio en una sesión multipista

Asignación de un nombre a una pista o moverla
Puede asignar un nombre a las pistas para identificarlas mejor o moverlas para ver todas las pistas relacionadas.

En el panel Editor o el Mezclador, escriba el nombre en el cuadro de texto correspondiente.

Cuadro de texto Nombre del panel Editor

Coloque el puntero a la izquierda del nombre de pista y a continuación, arrastre hacia arriba o hacia abajo en el panel Editor o
hacia la derecha o izquierda del Mezclador.

Desplazamiento de una pista en el panel Editor

Aplicación de zoom vertical a pistas
Cuando se utilizan las opciones de Zoom vertical en la parte inferior derecha del panel Editor, a todas las pistas se aplica el zoom de forma
simultánea. Si una sesión contiene muchas pistas, sin embargo, puede ser preferible ampliarlas individualmente.

 En los controles de pista, arrastre el borde superior o inferior de la pista hacia arriba o hacia abajo.
Para aplicar el zoom rápidamente en todas las pistas, desplace la rueda del ratón sobre los controles de pista. Para redimensionar todos los
controles de pista horizontalmente, arrastre el borde derecho.

http://helpx.adobe.com/en/audition/using/creating-opening-files.html#insert_an_audio_file_into_a_multitrack_session
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Ampliación vertical de una pista individual

Para ver otras técnicas, consulte Acercamiento de audio en el panel Editor.

Silenciar pistas y convertirlas a solo
Es posible convertir pistas a solo para escucharlas aparte, independientemente del resto de una mezcla. A la inversa, es posible silenciar pistas
para silenciarlas en una mezcla.

Para silenciar una pista, haga clic en el botón Silenciar , en el panel Editor o el Mezclador.

Para convertir una pista a solo, haga clic en el botón Solo , en el panel Editor o el Mezclador. Para eliminar
automáticamente otras pistas del modo Solo, presione Ctr (Windows) o Comando (Mac OS) y haga clic.

Para eliminar otras pistas del modo Solo de forma predeterminada, seleccione Pista solo: Exclusivo en la sesión Multipista
del cuadro de diálogo Preferencias. (Independientemente de este ajuste, cuando se aplica un solo a bus, las pistas
asignadas siempre se sitúan en modo Solo.)

Aplicación del mismo ajuste a todas las pistas
Para una mayor eficacia, es posible aplicar varios ajustes de forma rápida a una sesión completa.

 Mantenga presionada la tecla Ctrl (Windows) o Comando (Mac OS) y presione Mayús. A continuación, seleccione Entrada, Salida, Silencio,
Solo, Preparar para grabar o Controlar entrada para cualquier pista.
Para obtener más información, consulte lo siguiente:

Definición del volumen de salida de una pista
 Realice cualquiera de las acciones siguientes:

En el panel Editor, arrastre el control Volumen . Mantenga pulsada la tecla Mayús para cambiar los ajustes en grandes
incrementos. Mantenga presionada la tecla Ctrl (Windows) o Comando (Mac OS) para cambiar los ajustes en incrementos
muy pequeños.

En el Mezclador, arrastre el atenuador de pista o haga clic arriba o abajo para moverse de forma gradual a la siguiente marca
de graduación. Para mover un punto específico, presione Alt (Windows) u Opción (Mac OS) y haga clic sobre o bajo el
atenuador.

Para que los controles y reguladores vuelvan a cero (ganancia de unidad), presione Alt (Windows) u Opción (Mac OS) y haga clic directamente
en los mismos.

Panorámica de pistas en estéreo

 Arrastre el control Panorámica  en el panel Editor o el Mezclador.
Mantenga pulsada la tecla Mayús para cambiar los ajustes en grandes incrementos. Mantenga presionada la tecla Ctrl (Windows) o Comando
(Mac OS) para cambiar los ajustes en incrementos muy pequeños.

De forma predeterminada, el Editor multipista realiza una panorámica utilizando un método de la misma potencia, lo que mantiene el volumen
uniforme percibido potenciando ligeramente un canal sobre el otro. Para cambiar la cantidad de amplificación o cambiar a la panorámica
logarítmica (que simplemente atenúa un canal), cambie el Modo panorámico en las preferencias de Multipista.

http://helpx.adobe.com/en/audition/using/viewing-zooming-navigating-audio.html#zoom_audio_in_the_editor_panel


 

Duplicación de pistas
Para copiar perfectamente todos los clips, efectos, ecualizaciones y envolventes, duplíquelos. La duplicación de pistas supone un buen punto de
partida para los nuevos ajustes, lo que le ayudará a comparar diferentes procesos y ajustes de automatización.

1. En el panel Editor o Mezclador, seleccione una pista.
2. Seleccione Multipista > Pista > Duplicar pista seleccionada.

Más temas de ayuda
Automatización de los ajustes de pista

Aplicación de efectos en el Editor multipista

  |  
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Mezcla, transición y coincidencia de volumen del clip
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Coincidencia del volumen de clip multipista
Fundido o fundido cruzado de clips multipista
Creación de un único clip de audio para varios clips
Creación de un clip de audio a partir de una pista maestra o de bus

Para la transición de archivos de audio individuales, consulte Fusión y cambio de amplitud visual. (Los temas siguientes tratan los clips
multipista.)

Coincidencia del volumen de clip multipista
Si los clips multipista tienen un volumen muy diferente, dificultando la mezcla, puede hacer coincidir sus volúmenes. Debido a que el Editor
multipista no es destructivo, este ajuste es completamente reversible. Para cambiar de forma permanente el volumen de los archivos de origen,
consulte Coincidencia de volumen en varios archivos.

1. Con el uso de la herramienta Mover  o Selección de tiempo , presione Ctrl (Windows) o Comando (Mac OS) y haga clic
para seleccionar varios clips.

2. Seleccione Clip > Hacer coincidir el volumen de clip.

3. En el menú desplegable, seleccione una de estas opciones:

Volumen Coincide con un volumen de amplitud medio especificado.

Volumen percibido Coincide con la amplitud percibida especificada, teniendo en cuenta las frecuencias medias a las que es
más sensible el oído. Esta opción funciona bien a menos que el énfasis de la frecuencia varíe significativamente (por ejemplo,
si se pronuncian frecuencias medias en un fragmento corto, pero todas las demás frecuencias son bajas).

Volumen máximo Coincide con la amplitud máxima especificada, normalizando los clips. Como esta opción conserva el
rango dinámico, resulta ideal para clips para los que tiene previsto un procesamiento posterior o para audio muy dinámico,
como la música clásica.

Amplitud RMS total Hace coincidir toda la amplitud de raíz cuadrada media general especificada. Por ejemplo, si la mayor
parte de dos archivos es -50 dBFS, los valores de raíz cuadrada media (RMS) podrían reflejarlo, aunque un archivo contenga
pasajes más altos.

4. Introduzca un volumen de destino.

Fundido o fundido cruzado de clips multipista
Los controles de fundido en clip y fundido cruzado le permiten ajustar visualmente curvas y duraciones. Los controles para la aparición y
desaparición siempre aparecen en las esquinas superiores izquierda y derecha de los clips. Los controles para el fundido cruzado aparecen solo
cuando se superponen clips.

Controles en clip
A.  Arrastre los controles en las esquinas de clip para que aparezcan y desaparezcan. B.  Superposición de clips en fundido cruzado

A
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Aparición y desaparición de un clip
 En la esquina superior izquierda o derecha del clip, arrastre el icono de fundido  hacia adentro para determinar la longitud del fundido y

arrastre hacia arriba o hacia abajo para ajustar la curva de fundido.

Clips superpuestos cruzados
Con se realiza un fundido cruzado de clips en la misma pista, estos se superponen para determinar el tamaño de la región de transición (cuanto
más grande sea el área superpuesta, más larga será la transición).

1. Sitúe dos clips en la misma pista y muévalos para que se superpongan. (Consulte Selección y desplazamiento de clips.)
2. En la parte superior del área superpuesta, arrastre el icono de fundido izquierdo  o derecho  para ajustar las curvas de

fundido.

Opciones de fundido
Para acceder a las siguientes opciones de transición, seleccione un clip y después haga clic con el botón derecho en un icono de transición o
seleccione Clip > Aparecer o Desaparecer.

Sin fundido Elimina el fundido o el fundido cruzado.
Aparecer, Desaparecer o Fundido cruzado Si los clips se superponen, se podrá seleccionar el tipo de transición.
Simétrica o asimétrica (solo fundidos cruzados) Determina cómo las curvas de fundido izquierda y derecha interactúan al arrastrarlas arriba y
abajo. El valor simétrico ajusta ambas transiciones de forma idéntica, mientras que el asimétrico permite ajustar las transiciones de forma
independiente.
Lineal o de coseno Aplica un fundido lineal y uniforme o un fundido en forma de S que se inicia lentamente y, a continuación, cambia
rápidamente la amplitud y termina lentamente.

Para cambiar entre los modos Lineal y Coseno mientras se arrastran los iconos de transición, mantenga presionada la tecla Ctrl (Windows) o
Comando (Mac OS).

Fundidos cruzados automáticos activados Clips superpuestos de fundido cruzado. Anule la selección de esta opción si los fundidos cruzados
automáticos interfieren con otras tareas, como el recorte de clips.

Creación de un único clip de audio para varios clips
Puede combinar los contenidos de varios clips en el mismo rango de tiempo y crear un solo clip que se pueda editar rápidamente en el Editor
multipista o de forma de onda.

Creación de un solo clip desde clips múltiples en el Editor multipista

1. En el panel Editor, realice una de las acciones siguientes:

Seleccione un intervalo de tiempo específico. (Consulte Selección de rangos en el Editor multipista.)

Seleccione clips específicos si se produce un desplazamiento a una nueva pista.

No seleccione nada para mezclar una sesión completa.

2. Para combinar el contenido de clips originales, haga lo siguiente:

Para crear una pista y un clip en el Editor multipista, seleccione Multipista > Rebotar a nueva pista.

Para crear un archivo en el Editor de forma de onda, seleccione Multipista > Mezcla en nuevo archivo.

Para mezclar toda la sesión, consulte Exportación de archivos de mezcla multipista.
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Volver al principioCreación de un clip de audio a partir de una pista maestra o de bus
Si desea editar audio en una pista maestra o de bus, cree un clip en la pista.

1. En el panel Editor, seleccione un rango de tiempo para el nuevo clip. (Consulte Selección de rangos en el Editor multipista.)
2. En la línea de tiempo, haga clic con el botón derecho en una pista maestra o de bus y seleccione Rebotar [tipo de pista] a

nueva pista.

Adobe Audition crea una pista nueva con un clip que refleja la mezcla de pista maestra y de bus.

Más temas de ayuda
Exportación de archivos de mezcla multipista

  |  
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Bucle en clips
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Acceso a bucles gratuitos de Resource Central
Ajuste a pulsaciones de bucle
Activación de un clip con bucle y cambio de su longitud

Nota: Algunas de las funciones de la versión para Windows de Adobe Audition 3.0 no están disponibles en CS5.5. Por ejemplo, el tempo del
bucle y ajuste de claves, la expansión de tiempo de clip, MIDI, el metrónomo, la grabación de CDs y algunos formatos de archivo y efectos. Para
obtener una lista completa, consulte Funciones de Adobe Audition 3.0 reemplazadas o no implementadas en CS5.5.
En muchos estilos musicales, encontrará bucles utilizados para todo, desde pistas de ritmo básicas hasta composiciones completas. Con Adobe
Audition, puede crear sus propios bucles o seleccionar entre los miles que se proporcionan de forma gratuita a través del panel Resource Central.

Los bucles permiten crear sesiones multipista extremadamente flexibles. Si bien los bucles normalmente contienen solo una o dos barras de
música (de cuatro a ocho pulsaciones), es posible ampliarlas y repetirlas simplemente arrastrando con el ratón.

Identificación de bucles en la visualización de pistas
A.  Sin bucle B.  Bucle individual C.  Bucle ampliado (repetido)

Acceso a bucles gratuitos de Resource Central
Resource Central ofrece una amplia biblioteca en línea de bucles, efectos de sonido y bases musicales, a los que se puede acceder directamente
desde Adobe Audition.

1. Seleccione Ventana > Resource Central.
2. En la parte superior del panel Resource Central, haga clic en Bucles, Efectos de sonido o Bases musicales.
3. En el menú que aparece bajo el cuadro de búsqueda, seleccione un género.
4. En la lista de resultados, haga clic en el botón de reproducción para escuchar una muestra o en la flecha hacia abajo para

descargar el archivo en Audition. (Las marcas en la lista indican los elementos ya descargados.)

Ajuste a pulsaciones de bucle
Para sincronizar mejor una sesión basada en bucles, utilice el formato de tiempo Barras y pulsaciones, y habilite el ajuste. A continuación,
agregue bucles para crear una base rítmica mediante la grabación nuevos clips de audio. Incluso puede agregar clips de audio existentes, pero
solo sus puntos de inicio y fin se alinearán con las pulsaciones del bucle.

1. Seleccione Ver > Visualización de la hora > Barras y pulsaciones. Este formato de regla simplifica la alineación visual de
bucles con pulsaciones musicales.

2. En el submenú Edición > Ajustando, elija cualquiera de las opciones siguientes:
Ajustar a la regla (aproximado) Se ajusta a las pulsaciones con barras. Utilice esta opción si trabaja con archivos de bucles
de un cuarto o media barra.
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Ajustar a clips Se ajusta al inicio y final de los clips de audio.

Ajustar a bucles Se ajusta al inicio y al final de los bucles en los clips.

Activación de un clip con bucle y cambio de su longitud
1. En el Editor multipista, haga clic con el botón derecho en el clip de audio y seleccione Bucle en el menú contextual.

2. Sitúe el puntero sobre el borde izquierdo o derecho del clip; aparecerá el icono de edición de bucle .
3. Arrastre para ampliar o acortar el bucle.

En función de la longitud que arrastre, puede hacer que el bucle se repita total o parcialmente. Por ejemplo, podría arrastrar
un bucle con una longitud de una barra de forma que se extienda 3 barras y media, terminando en una pulsación en el bucle.
A medida que cruce cada barra, aparecerá una línea vertical blanca en el clip. Se trata de la línea de ajuste, que indica una
alineación perfecta a pulsaciones de otras pistas.

Ampliación de un bucle

Más temas de ayuda
Ajuste a puntos finales de clip

Cambio del formato de visualización de tiempo
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Descripción general del Editor multipista
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Acerca de las sesiones multipista
Edición de sesiones multipista en el panel Editor y el Mezclador
Selección de rangos en el Editor multipista
Personalización del desplazamiento de inicio y visualización del tiempo para las sesiones multipista

Acerca de las sesiones multipista
En el Editor multipista, se pueden mezclar varias pistas de audio para crear bandas sonoras en capas y elaborar composiciones musicales.
Puede grabar y mezclar infinitas pistas y cada una de ellas puede incluir tantos clips como necesite, el único límite es el espacio del disco duro y
la potencia de procesamiento. Si le gusta el resultado, puede exportar un archivo de mezcla para utilizarlo en un CD, en la Web o en otros
soportes.

El Editor multipista es un entorno de edición en tiempo real extremadamente flexible, que permite cambiar los ajustes durante la reproducción y
escuchar inmediatamente los resultados. Por ejemplo, mientras escucha una sesión, puede ajustar el volumen de la pista para fusionar las pistas
de forma correcta. Los cambios realizados son temporales o no destructivos. Si el sonido de una mezcla no le gusta transcurrida una semana o
incluso después de un año, puede simplemente volver a mezclar los archivos originales y aplicar y eliminar los efectos para crear texturas sonoras
diferentes.

Adobe Audition guarda la información de los archivos de origen y mezcla los ajustes en los archivos de sesión (.sesx). Los archivos de sesión son
relativamente pequeños, ya que solo contienen los nombres de ruta de los archivos de origen y las referencias a los parámetros de mezcla (como
el volumen, la panorámica y los ajustes de efectos). Para trabajar de forma más sencilla con los archivos de sesión, guárdelos en una única
carpeta junto a los archivos de origen que tengan como referencia. Si más tarde necesita mover una sesión a otro equipo, puede mover
solamente la carpeta de la sesión en cuestión.

Edición de sesiones multipista en el panel Editor y el Mezclador
En el Editor multipista, el panel Editor proporciona varios elementos que le ayudarán a mezclar y editar sesiones. En los controles de pista
situados a la izquierda, puede modificar los ajustes de una pista específica, como el volumen y la panorámica. En la línea de tiempo, a la derecha,
se editan los clips y las envolventes de automatización de cada pista.

Panel Editor en el Editor multipista
A.  Controles de pista B.  Navegador de zoom C.  Barra de desplazamiento vertical D.  Pista

El Mezclador (Ventana > Mezclador) proporciona una vista alternativa de la sesión, mostrando un número mayor de pistas y controles de forma
simultánea, sin mostrar los clips. El Mezclador es ideal para mezclar sesiones largas que contengan muchas pistas.
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Controles del Mezclador:
A.  Entradas B.  Efectos C.  Envíos D.  Ecualización E.  Volumen F.  Salidas

Selección de rangos en el Editor multipista

Selección simultánea de un rango y clips en el panel Editor

1. En la barra de herramientas, elija la herramienta Selección de tiempo .
2. En el panel Editor, realice una de las siguientes operaciones:

Seleccione un único rango, haga clic en el área vacía de la visualización de pista y arrastre hacia la derecha o la
izquierda.

Para seleccionar un rango de clips, haga clic en el centro de un clip y arrastre un recuadro.

Personalización del desplazamiento de inicio y visualización del tiempo para las sesiones
multipista



 

1. En el panel Editor, haga clic en el área vacía de la visualización de la pista para asegurarse de que no haya clips
seleccionados.

2. Seleccione Ventana > Propiedades.

3. En el panel Propiedades, ajuste las siguientes opciones:

Hora de inicio Establece un desplazamiento de tiempo de inicio, ayudando a hacer coincidir el audio en Adobe Audition con
el tiempo mostrado en las aplicaciones de vídeo.

Ajustes avanzados Para personalizar los ajustes de Visualización de la hora para la sesión activa, defina los ajustes de
Formato de tiempo y Velocidad de fotogramas personalizada. Para obtener más información, consulte Cambio del formato de
visualización de tiempo.

Más temas de ayuda
Comparación de los editores Forma de onda y Multipista

Creación de una nueva sesión multipista

Guardar sesiones multipista

Organización y edición de clips multipista

Automatización de mezclas con envolventes
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Controles de direccionamiento multipista y EC
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Mostrar u ocultar los controles de direccionamiento de pistas y EC
Asignación de entradas y salidas de audio a pistas
Enrutamiento de audio a buses, envíos y pista Maestra
Configuración de un envío
Ecualización de pistas

Mostrar u ocultar los controles de direccionamiento de pistas y EC
Aunque la gran variedad de controles de direccionamiento y EC puede resultar intimidante al principio, los controles son idénticos para cada pista,
así que una vez que conozca unos, los conocerá todos.

Visualización y ocultación de grupos de controles de pistas de audio
A.  Panel Editor B.  Mezclador

 Realice una de las siguientes acciones:

En la parte izquierda del Mezclador, haga clic en el triángulo Mostrar/Ocultar para uno o más grupos de controles.

En la esquina superior izquierda del panel Editor, haga clic en el botón para Entradas/salidas , Efectos , Envíos  o

Ecualización .

En el panel Editor, arrastre el borde derecho o inferior de los controles de pista para mostrarlos con mayor o menor detalle.

Arrastre el borde derecho de los controles de pista para mostrarlos con mayor o menor detalle.

Para obtener más información, consulte Aplicación de zoom vertical a pistas.

Asignación de entradas y salidas de audio a pistas

 En el área Entradas/salidas  del panel Editor o el Mezclador, realice una de las acciones siguientes:

En el menú Entrada, seleccione una entrada de hardware.

En el menú Salida, seleccione un bus, la pista Maestra o una salida de hardware.

La lista de puertos de hardware disponibles se determina a través de los ajustes realizados en el cuadro de diálogo de preferencias de
hardware de audio. (Consulte Configuración de entradas y salidas de audio.)
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Para obtener más información, consulte lo siguiente:

Inversión de la polaridad de una salida
Si un par de entradas estéreo, como los micrófonos para batería, están desfasadas, se escuchará un sonido más apagado y una imagen estéreo
más estrecha. Para corregir este problema, invierta la polaridad de una de las entradas.

 En el área de Controles de entrada  del Mezclador, haga clic en el botón Inversión de polaridad .
Para obtener más información sobre la fase de audio, consulte Cómo interactúan las ondas de sonido.)

Enrutamiento de audio a buses, envíos y pista Maestra
Los bus, los envíos y la pista Maestra permiten enrutar múltiples salidas de pista de a un grupo de controles. Con estos controles combinados, se
puede organizar y mezclar una sesión eficazmente.

Para guardar la salida de un audio, bus o pista maestra en un archivo, consulte Exportación de archivos de mezcla multipista.

Ejemplo de enrutamiento de audio para pistas
A.  Vocal B.  Bus de reverberación recibiendo envíos vocales y de guitarra C.  Guitarra D.  Bus de batería combinando salidas de
percusión E.  Salida de graves directa al hardware F.  Pista Maestra G.  Salidas de hardware

Comprensión de las pistas de bus
Con las pistas de bus se pueden combinar las salidas de varias pistas de audio o envíos y controlarlas de forma colectiva. Por ejemplo, para
controlar el volumen de varias pistas de batería con un solo atenuador, defina la salida de todas las pistas en un bus. O, para optimizar el
rendimiento del sistema, aplique un único efecto de reverberación a una pista de bus y defina los envíos de salida de varias pistas en dicho bus.
(La aplicación individual de la misma reverberación a varias pistas produciría la utilización ineficaz de los recursos de la CPU.)

Excepto la entrada de hardware, las pistas de bus tienen todas las características de las pistas de audio. Puede aplicar efectos, ecualización y
automatizar los cambios con el tiempo. En la mayoría de las mezclas, la salida de los bus se definirá en los puertos de hardware o la pista
Maestra. Sin embargo, si necesita combinar bus, también puede definir su salida en otros bus.
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Ejemplo de enrutamiento de bus:
A.  Bus de kit de batería B.  Bus de tambor de mano C.  Bus de batería combinados con salida a hardware o a la pista Maestra

Información sobre los envíos
Los envíos permiten enrutar audio desde una pista a múltiples bus, creando un gran flexibilidad de enrutamiento de la señal. Cada pista
proporciona hasta 16 envíos, que se configuran independientemente de la salida de pista. Por ejemplo, se puede definir la salida de una pista no
procesada directamente en un puerto de hardware y definir la salida Enviar 1 en un bus de reverberación y la salida Enviar 2 en un bus de
auriculares. (El bus de auriculares permite a los intérpretes escuchar una sola mezcla durante la grabación. Los percusionistas, por ejemplo,
pueden preferir una pista de graves más alta.)

Envío de pistas a varios bus
A.  Enviar 1 define la salida al bus de retardo B.  Enviar 2 define la salida al bus de reverberación C.  La pista Maestra combina salidas vocales,
de guitarra, de retardo y de reverberación.

Información sobre la pista Maestra
Una sesión siempre contiene una pista Maestra, para que se puedan combinar fácilmente las salidas de varias pistas y bus, y controlarlas con un
solo atenuador. Debido a que la pista Maestra se encuentra justo al final del trazado de la señal, ofrece menos opciones de enrutamiento que las
pistas de audio y bus. La pista Maestra no puede conectarse directamente a las entradas de audio, ni se puede definir su salida en envíos o bus;
solo se puede definir directamente a los puertos de hardware.
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La pista Maestra siempre se encuentra al final del trazado de la señal.
A.  Panel Editor B.  Mezclador

Configuración de un envío
Cuando se configura un envío, se determina el volumen y la panorámica estéreo que envía a un bus asignado. Coloque también el envío
preatenuador y postatenuador. El volumen de pista no afecta a los envíos preatenuador mientras que sí afecta a los envíos postatenuador. (Por
ejemplo, si define la salida de un envío preatenuador a un bus de reverberación, la reverberación continúa tras haber atenuado el audio original.
Si en su lugar define la salida a un envío postatenuador, la reverberación se atenúa al unísono del audio original.)

Efecto preatenuador y postatenuador y envío de enrutamiento para cada pista
A.  Entrada B.  EC C.  Volumen de pista D.  Silenciar pista E.  Enviar F.  bastidor de efectos

1. En el área de Envíos  del Mezclador, haga clic en el botón Enviar potencia .

2. Haga clic en el botón Preatenuador/Postatenuador para colocar el envío delante del volumen de pista  o después de .

3. Establezca el Volumen y la  Panorámica  del envío.
4. En el menú desplegable Enviar, seleccione un bus.

Para obtener más información, consulte Inserción de efectos antes o después de los envíos y EC.

Ecualización de pistas
Para cada pista, el Editor multipista proporciona un ecualizador paramétrico.

 En el área de ecualización  del panel Editor o Mezclador, realice lo siguiente:
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Haga doble clic en el gráfico para acceder a los controles detallados en la ventana EC de pista. (Consulte Efecto Ecualizador
paramétrico.)

Haga clic en el botón Activación EQ  para comparar el audio con o sin ecualización.

Más temas de ayuda
Utilización de ajustes preestablecidos de efectos
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Sonido envolvente y de vídeo

Parte del contenido vinculado a esta página puede estar solo en inglés.



sonido envolvente 5.1
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Control de sonido envolvente 5.1
Edición de archivos envolventes 5.1
Panoramización de pistas en una mezcla envolvente 5.1
Envíos de panorámica a una pista de bus 5.1

Control de sonido envolvente 5.1
Adobe Audition admite el sonido envolvente 5.1, que requiere cinco altavoces, además de un subwoofer de baja frecuencia (BF). Para controlar
adecuadamente el sonido envolvente 5.1, su equipo debe contar con tarjeta de sonido con 6 entradas como mínimo y dichas entradas se deben
asignar a los canales correctos en Audition.

1. Seleccione Editar > Preferencias > Asignación de canal de audio (Windows) o Audition > Preferencias > Asignación de canal
de audio (Mac OS).

2. Asigne cada canal 5.1 a una salida de la tarjeta de sonido:

I: Altavoz frontal izquierdo.

D: Altavoz frontal derecho.

C: Altavoz frontal central.

LFE: Subwoofer

Is: altavoz envolvente izquierdo.

Ds: altavoz envolvente derecho.

Si desea obtener más información, consulte Configuración de entradas y salidas de audio.

Edición de archivos envolventes 5.1
En el Editor de forma de onda, puede editar los archivos envolventes 5.1 con las mismas herramientas utilizadas para los archivos mono y
estéreo. Consulte Edición de archivos de audio.

Para limitar la edición a un subconjunto de canales 5.1, consulte Especificación de los canales que desea editar.

Panoramización de pistas en una mezcla envolvente 5.1
1. Abra o cree una sesión multipista 5.1. (Consulte Creación de una nueva sesión multipista.)

2. Para abrir el Panoramizador de pista, realice lo siguiente:

Seleccione Ventana > Panoramizador de pista. Después seleccione una pista mono o estéreo en el panel Editor.

En el panel Editor o Mezclador, haga doble clic en un trazo envolvente para una pista mono o estéreo

Nota: Solo se pueden panoramizar las pistas mono y estéreo, no las pistas 5.1. Para ajustar el volumen relativo de los
canales de una archivo 5.1, ábralo en el Editor de forma de onda.

Haga doble clic en un trazado envolvente para abrir el Panoramizador de pista.

3. En el Panoramizador de pista, realice una de las acciones siguientes:
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Para activar o desactivar canales, haga clic en los botones I, C, D, Is y Ds. O bien, haga clic en Solo LFE para enviar
audio solo al subwoofer.

En el trazado envolvente grande, arrastre para cambiar la posición de la señal.

Conforme arrastre, las líneas blancas cambian en longitud desde los altavoces, reflejando la potencia de señal en cada
uno de ellos. En el fondo, las áreas verdes y moradas reflejan la ubicación de la imagen estéreo izquierda y derecha; las
áreas azules indican el lugar en que se superpone la imagen.

Bajo el trazo envolvente, defina las siguientes opciones:

Ángulo Muestra el lugar en que el campo envolvente parece originarse. Por ejemplo, -90° es directamente a la izquierda,
mientras 90° es directamente a la derecha.

Difusión estéreo Determina la separación entre las pistas de audio estéreo, con cero y -180° que genera una separación
mínima y -90° que produce la separación máxima.

Radio Determina el nivel de ampliación del sonido alrededor del campo envolvente. Por ejemplo, 100% produce un
sonido centrado que se origina desde muy pocos altavoces, mientras que 0% produce un sonido no centrado que se
origina desde todos los altavoces.

Centro Para las pistas panoramizadas en la parte frontal del campo envolvente, determina el porcentaje del nivel de canal
central en relación con el nivel izquierdo y derecho.

LFE Controla el nivel de la señal enviada al subwoofer.

4. Para panoramizar las pistas adicionales, simplemente selecciónelas en el panel Editor. El Panoramizador de pista muestra
automáticamente los ajustes exclusivos de cada pista.

Para panoramizar dinámicamente las pistas envolventes en el tiempo, consulte Automatización de ajustes de pista.

Envíos de panorámica a una pista de bus 5.1
1. En el Editor multipista, cree una pista de bus 5.1. (Consulte Incorporación o eliminación de pistas.)

2. En el menú de salida de envío para una pista de audio, seleccione la pista de bus 5.1. (Consulte Configuración de un envío.)

En el área Envíos  de los paneles Editor y Mezclador, aparece un trazo envolvente. Haga doble clic en el mismo para
acceder al Panoramizador de pista para el envío.

Más temas de ayuda
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Importación de vídeo y uso de clips de vídeo
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Inserción de un archivo de vídeo en una sesión multipista
Ajuste a fotogramas en un clip de vídeo
Personalización del panel Vídeo

Inserción de un archivo de vídeo en una sesión multipista
En el Editor multipista, puede insertar archivos de vídeo para sincronizar con precisión una sesión con una vista previa del vídeo. Cuando se
inserta un archivo de vídeo, el clip de vídeo aparece en la parte superior de la visualización de pista y el clip de audio aparece en la pista de la
parte inferior.

Puede mover un clip de vídeo independientemente del clip de audio que contiene la banda sonora original. Para que los clips estén sincronizados,
antes de moverlos, seleccione ambos: presione Ctrl (Windows) o Comando (Mac OS) y haga clic.

Nota: Una sesión solo puede contener un clip de vídeo a la vez.

Clips de audio y vídeo relacionados (seleccione ambos para que estén sincronizados)

1. En el Editor multipista, sitúe el indicador de tiempo actual en el punto que desee insertar.
2. Seleccione Multipista > Insertar archivo y elija un archivo de vídeo en un formato admitido. (Consulte Formatos de archivo de

vídeo.)
3. Cuando termine de mezclar audio para vídeo, exporte una mezcla e impórtela en la aplicación de vídeo. (Consulte

Exportación de archivos de mezcla multipista.)

Para editor audio rápidamente desde un archivo de vídeo, seleccione Archivo > Abrir. Esta técnica es excelente para la edición de bandas
sonoras que no requieren una vista previa del vídeo o para readaptar bandas sonoras para soportes de solo audio, como radio o CD.

Ajuste a fotogramas en un clip de vídeo
Para sincronizar una sesión multipista con vídeo, ajuste los clips de audio y el indicador de tiempo actual a los fotogramas.

1. Seleccione Vista > Visualización de la hora y seleccione el formato de hora SMPTE que corresponde a la velocidad de
fotograma del clip.

2. Seleccione Editar > Ajustando > Ajustar a fotogramas.

Personalización del panel Vídeo
En el panel Vídeo, puede obtener vistas previas de clips de vídeo a medida que se reproduce una sesión multipista para sincronizar con precisión
una banda sonora con eventos de vídeo específicos tales como cambios en escenas, secuencias de título o efectos especiales.

Para mostrar u ocultar el panel Vídeo, elija Ventana > Vídeo.
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Panel Vídeo y clip relacionado en el panel Editor

Para personalizar el panel Vídeo, haga clic con el botón derecho en dicho panel y seleccione una de las opciones siguientes:
Un porcentaje de zoom Acerca y aleja.
Mejor ajuste Adapta vistas previas al panel.
Más temas de ayuda
Formatos de archivo de vídeo

Selección y desplazamiento de clips

Ajuste a puntos finales de clip

Zoom en el audio en el panel Editor

  |  
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Uso de aplicaciones de vídeo
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Edición de clips audio desde Adobe Premiere Pro CS5.5 o After Effects
Exportación de una mezcla multipista a Premiere Pro CS5.5
Vinculación de sesiones a archivos de mezcla exportados

Adobe recomienda ¿Desea compartir un tutorial?

Integración de Premiere Pro y
Audition
Jason Levine
Compartir mezclas completas entre las dos
aplicaciones para ofrecer la máxima flexibilidad.

Flujo de trabajo de After
Effects a Audition
Chris Meyer
Mejorar con rapidez las animaciones de vídeo con
potentes herramientas de audio.

Edición de clips audio desde Adobe Premiere Pro CS5.5 o After Effects
En Adobe Premiere Pro® CS5.5 o After Effects®, se pueden abrir rápidamente los clips seleccionados en el Editor de forma de onda para
restaurarlos o mejorarlos. Cuando haya guardado los cambios, el audio actualizado aparecerá automáticamente en los proyectos de vídeo.

En Adobe Premiere Pro, seleccione Editar > Editar en Adobe Audition > Clip.

En After Effects > seleccione Editar > Editar in Adobe Audition.

Para obtener más información, busque “Adobe Audition” en la Ayuda de Premiere Pro o After Effects.

Exportación de una mezcla multipista a Premiere Pro CS5.5
Adobe Premiere Pro y Audition CS5.5 intercambian directamente audio entre las sesiones multipista y las secuencias. Los marcadores de
secuencia aparecen en Audition y las pistas independientes se pueden conservar para obtener la máxima flexibilidad de edición.

Las aplicaciones intercambian secuencias y sesiones utilizando un formato XML compartido, exportado a una carpeta que contiene cualquier
archivo de audio con referencias.

Si desea enviar un solo archivo de mezcla a Premiere y no necesita la opción de exportar pistas individuales, consulte Vinculación de sesiones
a archivos de mezcla exportados.

Varios clips de Audition combinados como recursos en Premiere

1. Seleccione Multipista > Exportar a Adobe Premiere Pro.

2. Especifique un nombre y una ubicación para la carpeta de sesión exportada y establezca las siguientes opciones:

Velocidad de muestreo De forma predeterminada, refleja la velocidad de muestra de la secuencia original. Seleccione otra
velocidad para volver a muestrear el archivo para diferentes medios de salida. (Consulte Conceptos básicos sobre la
velocidad de muestreo.)

Exportación de cada pista o bus como recurso Convierte la duración completa de línea de tiempo de cada pista en un
solo clip, combinando varios clips si es necesario. Seleccione esta opción para ampliar y alinear los clips con los puntos de
inicio y fin de la secuencia.

Mezclar sesión en Exporta la sesión a un solo archivo 5.1 mono estéreo.

Abrir en Adobe Premiere Pro Abre automáticamente la secuencia en Premiere Pro. Anule la selección de esta opción si va
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a editar la secuencia posteriormente o transferirla a un equipo distinto.

3. Haga clic en Exportar.

4. Cuando Premiere Pro abre el archivo XML exportado (automáticamente o mediante el comando Archivo > Importar), se abre
el cuadro de diálogo Copiar pistas de Adobe Audition.

En el menú Copiar en secuencia activa, seleccione si comienzan las pistas de Audition exportadas. Todas las pistas nuevas
se añaden bajo las existentes.

Para enviar el audio de la secuencia desde Premiere Pro to Audition, consulte el tema sobre exportación de pistas de secuencia a Adobe
Audition en la Ayuda de Premiere Pro.

Vinculación de sesiones a archivos de mezcla exportados
Para crear bandas sonoras de vídeo en capas que se puedan actualizar con facilidad, vincule sesiones de varias pistas a archivos de mezcla
exportados. Si selecciona archivos exportados en una aplicación como Adobe Premiere Pro, puede volver a mezclarlos o editarlos en Adobe
Audition. A medida que un proyecto de vídeo avanza, simplemente, vaya repitiendo este proceso para crear una banda sonora final pulida.

Si se utiliza Premiere Pro CS5.5 y se desean compartir mezclas multipista completas, en lugar de archivos de mezcla, consulte Exportación de
una mezcla multipista a Premiere Pro CS5.5.

Incorporación de datos originales de edición en archivos de mezcla exportados

1. Abra una sesión multipista.

2. Seleccione Editar > Preferencias > Marcadores y metadatos (Windows) o Audition > Preferencias > Marcadores o metadatos
(Mac OS).

3. Seleccione Incrustar datos de enlace de Editar original en las mezclas multipista.

4. Cuando exporte las mezclas, seleccione Incluir marcadores y otros metadatos.

Edición de un archivo de mezcla a través de una aplicación de vídeo

1. En la aplicación de vídeo, seleccione un archivo de mezcla que ha exportado de Adobe Audition.

2. Seleccione Editar > Editar original.

3. Seleccione una de las opciones siguientes y haga clic en Aceptar:

Abrir la sesión multipista de Audition que creó el archivo

Abrir el archivo en el editor de forma de onda de Audition

4. Vuelva a mezclar la sesión vinculada en el Editor de forma de onda o edite el archivo de mezcla en dicho editor.

5. Para sobrescribir el archivo original de la aplicación de vídeo, realice una de las acciones siguientes:

En el Editor multipista, seleccione Archivo > Exportar > Mezcla de multipista y especifique el mismo nombre y ubicación
que el archivo original.

En el Editor de forma de onda, seleccione Archivo > Guardar.

Más temas de ayuda
Efecto Creación de originales

Comparación de los editores Forma de onda y Multipista

Exportación de sesiones al formato OMF o Final Cut Pro Interchange
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Tipo de muestra

Ajustes de formato

Incluir marcadores y otros metadatos

Nota:

Almacenamiento de archivos de audio
Extracción de canales de audio a archivos mono
Almacenamiento de sesiones multipista
Exportación de sesiones al formato OMF o Final Cut Pro Interchange
Exportación de plantillas de sesión
Exportación de archivos de sesión
Exportación de archivos de mezcla multipista
Ajustes de formato de audio
Cierre de archivos

Almacenamiento de archivos de audio
En el Editor de forma de onda, puede guardar archivos de audio con diversos formatos. El
formato elegido dependerá de cómo se tenga pensado utilizar el archivo. (Consulte Ajustes
de formato de audio.) Tenga en cuenta que cada formato almacena información exclusiva
que podría ser descartada en caso de guardar el archivo en un formato diferente.

1. En el Editor de forma de onda, realice una de las siguientes operaciones:
Para guardar los cambios en el archivo actual, elija Archivo > Guardar

Para guardar los cambios con un nombre de archivo diferente, seleccione Archivo >
Guardar como. O bien, seleccione Archivo > Exportar > Archivo para mantener el
archivo actual abierto.

Para guardar el audio seleccionado como un nuevo archivo, elija Archivo > Guardar
selección como.

Para guardar todos los archivos abiertos en sus formatos actuales, seleccione
Archivo > Guardar todo.

Seleccione Archivo > Guardar todo el audio como proceso por lotes para procesar
todos los archivos abiertos. Para obtener más información, consulte Procesamiento
de archivos por lotes.

2. Especifique una ubicación y nombre de archivo y elija un formato de archivo.
3. Defina las opciones siguientes:

Indica la velocidad de muestro y la profundidad de bits. Para ajustar
estas opciones, haga clic en Cambiar. (Consulte Cambio de la velocidad de muestreo de
un archivo.)

Indica la compresión de datos y los modos de almacenamiento;
para ajustar estos parámetros, haga clic en Cambiar. (Consulte Ajustes de formato de
audio.)

Incluye marcadores de audio e información del
panel Metadatos en los archivos guardados. (Consulte Uso de marcadores y
Visualización y edición de metadatos XMP.)

Algunas aplicaciones de grabación de CD interpretan incorrectamente información
no relativa al audio (como marcadores y metadatos), lo que produce un ruido
desagradable al comienzo de cada pista.

Was this helpful?
Yes   No 
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Tipo de muestra

Ajustes de OMF

Extracción de canales de audio a archivos mono
Si desea incluir en la salida o editar canales individuales de un archivo estéreo o de sonido
envolvente, extráigalos a archivos mono. Adobe Audition añade el nombre del canal a cada
nombre de archivo extraído. Por ejemplo, un archivo de origen estéreo llamado Jazz.aif,
produce archivos mono denominados Jazz_L y Jazz_R.

En el Editor de forma de onda, seleccione Editar > Extraer canales en archivos mono.

Audition abre automáticamente cada archivo extraído en el panel Editor.

Almacenamiento de sesiones multipista
Una sesión multipista es un archivo pequeño sin audio. Se limita a almacenar información
sobre ubicaciones de archivos de audio relacionados en el disco duro, la duración de cada
archivo de audio en la sesión, los envolventes y efectos aplicados a diversas pistas, etc. Se
puede volver a abrir posteriormente un archivo de sesión guardado para realizar más
cambios en la mezcla.

Si crea mezclas multipista totalmente en Adobe Audition, guarde los archivos de la sesión en
el formato SES nativo. Sin embargo, si quiere compartir composiciones multipista con otras
aplicaciones, consulte Exportación de sesiones al formato OMF o Final Cut Pro Interchange.

Puede guardar sesiones con un registro de todos los archivos abiertos y volver a abrirlos
automáticamente con las sesiones. En las preferencias de Multipista, seleccione Hacer
referencia a todos los archivos de audio y vídeo.

1. En el editor multipista, realice una de las siguientes operaciones:
Para guardar los cambios en el archivo de sesión actual, elija Archivo > Guardar

Para guardar los cambios con un nombre de archivo diferente, seleccione Archivo >
Guardar como. O bien, seleccione Archivo > Exportar > Sesión para mantener la
sesión actual abierta.

Para guardar el archivo de sesión y todos los archivos de audio que contiene,
seleccione Archivo > Guardar todo.

2. Especifique un nombre de archivo y una ubicación.
3. Para incluir información y marcadores de audio del panel Metadatos, seleccione Incluir

marcadores y otros metadatos.

Exportación de sesiones al formato OMF o Final Cut Pro
Interchange
Para transferir mezclas completas a otras aplicaciones en su flujo de trabajo, realice la
exportación al formato OMF o Final Cut Pro Interchange. OMF se creó en un principio para
Avid Pro Tools, pero ahora es un formato de intercambio multipista común para diversas
aplicaciones de mezcla de audio. El formato Final Cut Pro Interchange se basa en archivos
XML legibles, que se pueden editar sin conexión para revisar referencias de texto, ajustes de
mezcla, etc.

Exportación a OMF

1. En el Editor multipista, seleccione Archivo > Exportar > OMF.

2. Especifique un nombre de archivo y una ubicación.

3. Defina las opciones siguientes:

Haga clic en Cambiar para acceder al cuadro de diálogo Convertir tipo
de muestra. (Consulte Conversión de tipos de muestra.)

Haga clic en Cambiar para acceder a lo siguiente:
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Medio

Nota:

Opciones de medios

Duración de control

Volver al principio
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La opción Encapsulado almacena los clips de audio en el propio archivo
OMF para una organización más sencilla. La opción Con referencia almacena
los clips de audio en la misma carpeta que el archivo OMF, permitiendo editarlos
sin conexión, si es necesario.

Los archivos OMF encapsulados se limitan a 2 GB de tamaño.

Determina si los archivos de origen del clip se recortan
en una longitud de clip en el panel Editor o reflejan el archivo original completo.

Para los clips recortados, especifica la duración de tiempo
para incluir fuera de los bordes del clip. Al incluir el audio adicional se
proporciona una mayor flexibilidad para los fundidos y la edición.

La sección Avisos indica los elementos de la sesión que se excluirán o cambiarán. Para
copiar esta información en el portapapeles, haga clic en el botón Copiar advertencias .

Exportar formato de intercambio de Final Cut Pro

1. En el Editor multipista, seleccione Archivo > Exportar > Formato de intercambio FCP
XML.

2. Especifique un nombre de archivo y una ubicación.

3. Para incluir información y marcadores de audio del panel Metadatos, seleccione Incluir
marcadores y otros metadatos.

4. Para combinar archivos de sesión y de origen para facilitar su transferencia a otros
sistemas, seleccione Guardar copias de los archivos asociados. Para cambiar el formato
y tipo de muestra de los archivos de origen exportados, haga clic en Opciones.

Los siguiente elementos de sesión se excluyen del archivo exportado:

El segundo canal de clips estéreo. (Todos los clips y pistas se convierten en mono.)

Clips superpuestos

Efectos y EQ pista.

Los envolventes de automatización distintos a la panorámica de pista mono a estéreo y
volumen del clip.

Enrutamiento de salida, buses, envíos y la pista Maestra.

Exportación de plantillas de sesión
Las plantillas de sesión incluyen todos los clips y las propiedades multipista, lo que le
ayudará a iniciar con rapidez proyectos que requieren ajustes y tareas similares, como por
ejemplo un tema de introducción o música ambiental que compartan varios espectáculos.

1. Seleccione Archivo > Exportar > Sesión como plantilla. A continuación especifique un
nombre y una ubicación.

2. Para aplicar una plantilla a una nueva sesión, seleccione Archivo > Nuevo > Sesión
multipista. A continuación, elija una opción en el panel Plantilla.

Exportación de archivos de sesión
Para combinar archivos de sesión y de origen para facilitar su transferencia a otros equipos o
dispositivos de almacenamiento, exporte archivos de sesión.

Utilice este proceso para cambiar la velocidad de muestreo y la profundidad de bits de
una sesión.
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Volver al principio

Tipo de muestra

Ajustes de formato

Incluir marcadores y otros metadatos

Opciones de mezcla

Volver al principio

1. Elija Archivo > Exportar > Sesión.
2. Seleccione Guardar copias de los archivos asociados y haga clic en Opciones.
3. Para guardar los archivos de origen en un formato diferente, seleccione Convertir

archivos y establezca las opciones deseadas.
4. Para exportar archivos de origen completos o recortados, seleccione una opción del

menú Opciones de medios.

Duración de control indica cuánto audio adicional deberá incluirse al inicio y al final de los
clips recortados. Para una mayor flexibilidad de los ajustes futuros de recorte y fusión,
agregue controles de hasta 10 segundos.

Exportación de archivos de mezcla multipista
Una vez terminada la mezcla de una sesión, se puede exportar parte de la sesión, o la
totalidad de la misma, a diversos formatos comunes. (Consulte Formatos de archivos de
audio.) Cuando se realiza la exportación, el archivo resultante refleja los ajustes de efectos,
panorámica y volumen actual enrutados a la pista Maestra.

Para mezclar rápidamente clips de audio específicos en una pista única, utilice el
comando Multipista > Rebotar a nueva pista. (Consulte Creación de un único clip de
audio a partir de varios clips.)

1. Si desea exportar parte de una sesión, utilice la herramienta Selección de tiempo 
para seleccionar el rango deseado.

2. Elija Archivo > Exportar > Mezcla multipista.

(Como alternativa, seleccione Multipista > Mezcla en nuevo archivo para abrir la mezcla
en el Editor de forma de onda y omita los siguientes pasos.)

3. Especifique una ubicación y nombre de archivo y elija un formato de archivo.
4. Defina las opciones siguientes:

Indica la velocidad de muestro y la profundidad de bits. Para ajustar
estas opciones, haga clic en Cambiar. (Consulte Cambio de la velocidad de muestreo de
un archivo.)

Indica la compresión de datos y los modos de almacenamiento;
para ajustar estos parámetros, haga clic en Cambiar. (Consulte Ajustes de formato
audio.)

Incluye marcadores de audio e información del
panel Metadatos en los archivos guardados. (Consulte Uso de marcadores y
Visualización y edición de metadatos XMP.)

Permiten mezclar las pistas como archivos independientes o de
forma simultánea como salidas mono, estéreo y 5.1. Para ajustar estos y otros ajustes,
haga clic en Cambiar.

En el Editor de forma de onda, seleccione Editar > Editar original para abrir la sesión
multipista que creó un archivo de mezcla. Este comando requiere metadatos
incorporados en el archivo. (Consulte Incorporación de datos originales de edición en
archivos de mezcla exportados.)

Ajustes de formato de audio
En la mayoría de los casos, el audio sin comprimir se debe guardar en los formatos AIFF o
WAV. Guarde el formato mp3 comprimido únicamente cuando cree archivos para Web o
para reproductores de medios portátiles.

En un cuadro de diálogo Guardar como o Exportar, haga clic en Cambiar a la derecha de
Ajustes de formato para acceder a las siguientes opciones.
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Tipo de muestra (disponible solo para archivos de 32 bits)

Nota:

Orden de bytes (solo disponible para archivos de 16 bits)

Compresión

Modo de canal

Velocidad de bits

Para ver el efecto de los cambios de ajustes, observe el Tamaño de archivo estimado en
la parte inferior del cuadro de diálogo.

Ajustes del formato AIFF (*aif, *.aiff, *.aifc)
AIFF es el formato de archivo de audio estándar y sin comprimir para Mac OS.

Ajusta la profundidad de bits del audio. Las
profundidades de bits mayores proporcionan un rango dinámico mayor y reducen la distorsión, aunque
aumentan el tamaño del archivo y el tiempo de procesamiento. Para determinar los ajustes adecuados para
los tipos de salidas más comunes, consulte Conceptos básicos sobre la profundidad de bits.

Audio de clip de ajustes entero que se amplía más allá del rango de amplitud para una profundidad de bits
concreta. Los ajustes del punto flotante requiere algo más de espacio de almacenamiento, pero se conserva
un rango dinámico mucho mayor.

Seleccione Punto flotante de 32 bits si desea procesar varias veces el archivo y descartar los datos de
amplitud mínima.

Para añadir los metadatos de autor a un archivo AIFF, utilice el campo Dublin Core:
Creador de la ficha XMP del panel Metadatos. Consulte Visualización y edición de metadatos
XMP.)

Especifica la secuencia numérica para los
bytes de datos. Seleccione el método Little-Endian para sistemas con procesadores Intel y el método Big-
Endian para sistemas con procesadores PowerPC.

Ajustes del formato Monkey's Audio (.ape)
Monkey's Audio comprime los archivos aproximadamente a la mitad su tamaño original sin
pérdidas, mediante el uso de un algoritmo que conserva la fidelidad de sonido.

Determina el equilibrio entre la velocidad de procesamiento y el tamaño del archivo. (El
procesamiento rápido produce archivos de mayor tamaño y viceversa.)

Ajustes del formato de audio MP2
MP2 (MPEG-1 Audio Layer II) es un formato de compresión con pérdidas especialmente
popular en la radio.

Elija una de las siguientes opciones:

Automático selecciona una de las opciones siguientes en función de la configuración de
canal actual del archivo.

Mono produce un archivo de un canal.
Mono dual genera un archivo de dos canales con el mismo audio en ambos canales.

Estéreo produce un archivo de dos canales, procesando los canales independientemente
y conservando las imágenes estéreo.

Estéreo combinado procesa ambos canales a la vez, lo que reduce el tamaño del archivo
pero a menudo afecta a las imágenes estéreo.

Ajuste el equilibrio entre el tamaño del archivo y la calidad de audio. Los ajustes más
altos aumentan el tamaño y la calidad; los más bajos reducen el tamaño y la calidad.

Para obtener más información acerca de las opciones avanzadas, coloque el ratón sobre
ellas hasta que aparezca la información sobre herramienta.

Ajustes del formato MP3
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Tipo

Velocidad de bits (para velocidades de bits constantes) o Calidad (para variable)

Tipo de muestra (disponible solo para archivos de 32 bits)

Nota:

Admite más de 4 GB

Formato

Codificación

Orden de bytes

Calidad VBR (solo archivos OGG)

MP3 es el formato de audio comprimido estándar para la distribución en línea.

Seleccione Constante para aplicar una velocidad de bits constante o Variable para cambiar la
velocidad de bits basada en el contenido de audio.

Ajuste el equilibrio
entre el tamaño del archivo y la calidad de audio. Los ajustes más altos aumentan el tamaño y la calidad; los
más bajos reducen el tamaño y la calidad.

Evite comprimir el mismo audio a mp3 más de una vez. La apertura y realmacenamiento
de un archivo .mp3 hace que se vuelva a comprimir, por lo que cualquier artefacto del
proceso de compresión queda más pronunciado.

Ajustes del formato QuickTime (*.mov de solo audio)
No se puede ajustar la configuración del formato para los archivos QuickTime de solo audio,
que siempre se guardan como datos PCM (Pulse Code Modulation) sin comprimir.

Ajustes del formato Wave PCM (.wav, .bwf)
Wave PCM es el formato de audio sin comprimir estándar en Windows.

Puede incluir metadatos Difundir onda en archivos Windows PCM. Consulte Visualización
y edición de metadatos XMP.)

Ajusta la profundidad de bits del audio. Las
profundidades de bits mayores proporcionan un rango dinámico mayor y reducen la distorsión, aunque
aumentan el tamaño del archivo y el tiempo de procesamiento. Para determinar los ajustes adecuados para
los tipos de salidas más comunes, consulte Conceptos básicos sobre la profundidad de bits.

Audio de clip de ajustes entero que se amplía más allá del rango de amplitud para una profundidad de bits
concreta. Los ajustes del punto flotante requiere algo más de espacio de almacenamiento, pero se conserva
un rango dinámico mucho mayor.

Las opciones de punto flotante 16.8 y 24.0 no estándar se proporcionan para la
compatibilidad con versiones anteriores de Adobe Audition. (16.8 era el formato interno
utilizado por Audition 1.0. 24.0 fue un ajuste opcional de la misma versión.)

Almacena archivos superiores a 4 GB utilizando el formato RF64, que refleja el
estándar European Broadcasting Union, o bien, el formato Multiple Data Chunks compatible con las versiones
anteriores de Audition.

Nota: Para garantizar la compatibilidad con una amplia gama de aplicaciones, seleccione el formato RF64
para los archivos superiores a 4 GB.

Ajustes del formato libsndfile, FLAC y OGG
Una amplia variedad de formatos comparten las opciones siguientes.

El formato FLAC es comprimido (lo que reduce el tamaño de archivo) y sin pérdidas (el
audio se reproduce con total fidelidad).

Especifica el formato y la extensión del archivo.

Especifica el esquema de almacenamiento de datos para el archivo. 

Especifica la secuencia numérica para los bytes de datos. Con Orden de bytes
predeterminado se aplica automáticamente el valor predeterminado para el procesador del sistema y suele
ser la mejor opción.

Determina el equilibrio entre el tamaño del archivo y la calidad de audio.
(Los valores más altos producen archivos más grandes, pero de mejor calidad.)
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Cierre de archivos
Realice cualquiera de las acciones siguientes:

Para cerrar el archivo de actual en el panel Editor, elija Archivo > Cerrar.

Para cerrar todos los archivos de sesión, vídeo y audio abiertos, elija Archivo >
Cerrar todo.

Para cerrar archivos a los que no se hace referencia en una sesión multipista,
seleccione Archivo > Cerrar medios no utilizados.

Para cerrar la sesión actual y los clips de audio relacionados en el Editor multipista,
seleccione Archivo > Cerrar sesión y sus medios.

Almacenamiento de audio entre marcadores en archivos nuevos

Exportación de una mezcla multipista a Premiere Pro

Creación de un clip de audio a partir de una pista maestra o de bus

Acrobat
Creative Cloud
Creative Suite
Digital Marketing Suite
Digital Publishing
Suite
Elements
Mobile apps
Photoshop
Touch Apps
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Adobe Audition Help / Saving and exporting files (CS5.5)
Adobe Community Help

Products Affected
Adobe Audition CS5.5

Contact support
Note:

To the top

Sample Type

Format Settings

Include Markers and Other Metadata

Note:

To the top

Save audio files
Extract audio channels to mono files
Save multitrack sessions
Export sessions to OMF or Final Cut Pro Interchange format
Export multitrack mixdown files
Audio format settings
Close files

Some features in the Windows version of Adobe Audition 3.0 are not available in
CS5.5. Examples include some file formats and effects, CD burning, MIDI, the metronome,
clip grouping and time stretching, and control surface support. For a complete list, see Adobe
Audition 3.0 features replaced or not implemented in CS5.5.

Save audio files
In the Waveform Editor, you can save audio files in a variety of common formats. The format
you choose depends on how you plan to use the file. (See Audio format settings.) Keep in
mind that each format stores unique information that might be discarded if you save a file in a
different format.

1. In the Waveform Editor, do one of the following:
To save changes in the current file, choose File > Save.

To save changes under a different filename, choose File > Save As. Or choose File >
Export > File to keep the current file open.

To save currently selected audio as a new file, choose File > Save Selection As.

To save all open files in their current formats, choose File > Save All.

Use the Save Selection As command to break up a long recording into smaller, more
manageable files.

2. Specify a filename and location, and choose a file format.
3. Set the following options:

Indicates the sample rate and bit depth. To adjust these options, click
Change. (See Convert the sample rate of a file.)

Indicates data compression and storage modes; to adjust these, click
Change. (See Audio format settings.)

Includes audio markers and information from the
Metadata panel in saved files. (See Working with markers and Viewing and editing XMP
metadata.)

Some CD-burning applications misinterpret non-audio information such as
markers and metadata, producing an unpleasant burst of noise at the beginning of each
track.

Extract audio channels to mono files
If you want to edit or output individual channels of a stereo or surround-sound file, extract
them to mono files. Adobe Audition appends the channel name to each extracted filename.
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Sample Type

OMF Settings

Media

Note:

Media Options

Handle Duration

For example, a stereo source file named Jazz.aif produces mono files named Jazz_L and
Jazz_R.

In the Waveform Editor, choose Edit > Extract Channels To Mono Files.

Audition automatically opens each extracted file in the Editor panel.

Save multitrack sessions
A multitrack session file is a small, non-audio file. It merely stores information about locations
of related audio files on your hard drive, the duration of each audio file within the session, the
envelopes and effects applied to various tracks, and so forth. You can reopen a saved
session file later to make further changes to the mix.

If you create multitrack mixes entirely in Adobe Audition, save session files in the native
SESX format. If you plan to share multitrack compositions with other applications, however,
see Export sessions to OMF or Final Cut Pro Interchange format.

1. In the Multitrack Editor, do one of the following:
To save changes to the current session file, choose File > Save

To save changes under a different filename, choose File > Save As. Or choose File >
Export > Session to keep the current session open.

To save the session file and all the audio files it contains, choose File > Save All .

2. Specify a filename and location.
3. To include audio markers and information from the Metadata panel, select Include

Markers And Other Metadata.

Export sessions to OMF or Final Cut Pro Interchange format
To transfer complete mixes to other applications in your workflow, export to OMF or Final Cut
Pro Interchange format. OMF was originally created for Avid Pro Tools, but now is a common
multitrack exchange format for many audio mixing applications. Final Cut Pro Interchange
format is based on human-readable XML files, which you can edit offline to revise text
references, effect settings, and so on.

Export to OMF

1. In the Multitrack Editor, choose File > Export > OMF.

2. Specify a filename and location.

3. Set the following options:

Click Change to access the Convert Sample Type dialog box. (See
Converting sample types.)

Click Change to access the following:

Encapsulated stores audio clips in the OMF file itself for easier
organization. Referenced stores audio clips in the same folder as the OMF file,
letting you edit them offline if necessary.

Encapsulated OMF files are limited to 2 GB in size.

Determines whether clip source files are trimmed to clip length
in the Editor panel or reflect the entire original file.

For trimmed clips, specifies the time duration to include
beyond clip edges. Including additional audio provides more flexibility for fades
and editing.
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The Warnings section indicates elements of the session that will be excluded or changed. To
copy this information to clipboard, click the Copy Warnings button .

Export to Final Cut Pro Interchange format

1. In the Multitrack Editor, choose File > Export > FCP XML Interchange Format.

2. Specify a filename and location.

3. To include audio markers and information from the Metadata panel, select Include
Markers And Other Metadata.

The following session elements are excluded from the exported file:

The second channel of stereo clips. (All clips and tracks become mono.)

Overlapping clips

Effects and track EQ.

Automation envelopes other than clip volume and mono-to-stereo track panning.

Output routing, sends, buses, and the Master track.

Export multitrack mixdown files
After you finish mixing a session, you can export all or part of it in a variety of common
formats. (See Audio file formats.) When you export, the resulting file reflects current volume,
pan, and effects settings routed to the Master track.

To quickly mix specific audio clips down to a single track, use the Multitrack  > Bounce To
New Track command. (See Create a single audio clip from multiple clips.)

1. If you want to export part of a session, use the Time Selection tool  to select the
desired range.

2. Choose File > Export > Multitrack Mixdown.

(Alternatively, choose Multitrack > Mixdown To New File to open the mixdown in the
Waveform Editor and skip the steps below.)

3. Specify a filename and location, and choose a file format.
4. Set the following options:

Indicates the sample rate and bit depth. To adjust these options, click
Change. (See Convert the sample rate of a file.)

Indicates data compression and storage modes; to adjust these, click
Change. (See Audio format settings.)

Includes audio markers and information from the
Metadata panel in saved files. (See Working with markers and Viewing and editing XMP
metadata.)

In the Waveform Editor, choose Edit > Edit Original to open the multitrack session
that created a mixdown file. This command requires embedded metadata in the file.
(See Embed edit-original data in exported mixdown files.)

Audio format settings
In most cases, you should save uncompressed audio to the AIFF or WAV formats. Save to
the compressed mp3 format only when creating files for the web or portable media players.

In a Save As or Export dialog box, click Change to the right of Format Settings to access the
options below.

To see the effect of settings changes, note the Estimated File Size at the bottom of the
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dialog box.

AIFF format settings (*aif, *.aiff, *.aifc)
AIFF is the standard uncompressed audio file format on Mac OS.

Sets the audio bit depth. Higher bit depths provide more
dynamic range and reduce distortion, though they increase file size and processing time. To determine the
proper setting for common output types, see Understanding bit depth.

Integer settings clip audio that extends beyond the amplitude range for a given bit depth. Floating Point
settings require slightly more storage space, but retain much greater dynamic range.

Choose 32-bit Floating Point if you want to repeatedly process the file and discard minimal amplitude data.

To add Author metadata to an AIFF file, use the Dublin Core: Creator field on the XMP
tab of the Metadata panel. (See Viewing and editing XMP metadata.)

Specifies the numerical sequence for bytes of data. Choose the
Little-Endian method for systems with Intel processors and the Big-Endian method for systems with PowerPC
processors.

mp3 format settings
mp3 is the standard compressed audio format across platforms.

Choose Constant to apply a consistent bitrate or Variable to change the bitrate based on audio
content.

Adjusts the tradeoff between file size and audio
quality. Higher settings increase size and quality; lower settings reduce size and quality.

Avoid compressing the same audio to mp3 more than once. Opening and resaving an
mp3 file causes it to be recompressed, so any artifacts from the compressing process
become more pronounced.

QuickTime format settings (audio-only *.mov)
You cannot adjust format settings for audio-only QuickTime files, which are always saved as
uncompressed PCM (Pulse Code Modulation) data.

Wave PCM format settings (.wav, .bwf)
Wave PCM is the standard uncompressed audio format on Windows.

You can include Broadcast Wave metadata in Windows PCM files. (See Viewing and
editing XMP metadata.)

Sets the audio bit depth. Higher bit depths provide more
dynamic range and reduce distortion, though they increase file size and processing time. To determine the
proper setting for common output types, see Understanding bit depth.

Integer settings clip audio that extends beyond the amplitude range for a given bit depth. Floating Point
settings require slightly more storage space, but retain much greater dynamic range.

The nonstandard 16.8 and 24.0 Floating Point options are provided for compatibility
with previous versions of Adobe Audition. (16.8 was the internal format used by Audition 1.0.
24.0 was an optional setting from the same version.)

Stores files larger than 4GB using either RF64 format, which reflects the current
European Broadcasting Union standard, or the Multiple Data Chunks format supported by previous versions
of Audition.

note: To ensure compatibility with a wide range of applications, choose the RF64 format for files greater than
4GB.
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Close files
Do any of the following:

To close the current file in the Editor panel, choose File > Close.

To close all open audio, video, and session files, choose File > Close All.

To close files that aren’t referenced by an open multitrack session, choose File >
Close Unused Media.

To close the current session and related audio clips in the Multitrack Editor, choose
File > Close Session and Its Media.

Save audio between markers to new files

Export a multitrack mix to Premiere Pro CS5.5

Create an audio clip from a bus or master track

Acrobat
Creative Cloud
Creative Suite
Digital Marketing Suite
Digital Publishing
Suite
Elements
Mobile Apps
Photoshop
Touch Apps
Student and Teacher
Editions
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About the Metadata panel and XMP
Show or hide XMP metadata
Edit XMP metadata
Search XMP metadata

In Adobe Audition, the Metadata panel provides BWF, ID3, and RIFF tabs that let you quickly
access this common audio metadata. The XMP tab provides the same information, combined
with a longer list of metadata common to Adobe video applications. (For example, the Display
Title field on the RIFF tab corresponds to the Title field in the Dublin Core section of the XMP
tab.)

To preserve metadata when you save files, select Include Markers and Other
Metadata in the Save or Export dialog box.

The BWF tab applies to Broadcast Wave files, which let you specify a time offset for
playback, as well as standard descriptive metadata. To include Broadcast Wave metadata in
a file, you must save in WAV format; see Save audio files. To insert a Broadcast Wave file in
the Multitrack Editor, see Spot-insert a Broadcast Wave file into a session.

The ID3 and RIFF tabs apply to mp3 and radio industry metadata, respectively.

About the Metadata panel and XMP
To streamline your workflow and organize your files, use XMP metadata. Metadata is a set of
descriptive information about a file. Video and audio files automatically include basic
metadata properties, such as date, duration, and file type. You can add details with properties
such as location, director, copyright, and much more.

With the Metadata panel, you can share this information about assets throughout Adobe
video and audio applications. Unlike conventional clip properties, which are limited to only
one application’s Project or Files panel, metadata properties are embedded in source files, so
the data automatically appears in other applications. This sharing of metadata lets you quickly
track and manage video assets as they move through your production workflow.

Properties in the Metadata panel also appear in Adobe Bridge, providing additional
details that help you quickly browse assets.

For a video about the Metadata panel, see the Adobe website.

Maxim Jago explains XMP metadata in a video from, “Premiere Pro CS5 for Avid Editors.”

About schemas and properties
A metadata schema is a collection of properties specific to a given workflow. The Dynamic
Media schema, for example, includes properties like Scene and Shot Location that are ideal
for digital video projects. Exif schemas, by contrast, include properties tailored to digital
photography, like Exposure Time and Aperture Value. More general properties, like Date and
Title, appear in the Dublin Core schema. To display different properties, see Show or hide
metadata.

For information about a specific schema and property, hover the pointer over it in the
Metadata panel. For most items, a tool tip appears with details.

About the XMP standard
Adobe applications store metadata using the Extensible Metadata Platform (XMP). XMP is
built on XML, which facilitates the exchange of metadata across a variety of applications and
publishing workflows. Metadata in most other formats (such as Exif, GPS, and TIFF)
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automatically transfers to XMP so you can more easily view and manage it.

In most cases, XMP metadata is stored directly in source files. If a particular file format
doesn’t support XMP, however, metadata is stored in a separate sidecar file.

Project assets without corresponding files don’t support XMP. Examples from Adobe Premiere
Pro include Bars and Tone, Universal Counting Leader, Color Matte, Titles, Black Video, and
Transparent Video.

To customize the creation and exchange of metadata, use the XMP Software
Development Kit. For more information about XMP, see Extensible Metadata Platform.

Show or hide XMP metadata
To optimize the Metadata panel for your workflow, show or hide entire schemas or individual
properties, displaying only those that you need.

1. From the options menu  for the Metadata panel, select Metadata Display.

2. To show or hide schemas or properties, select or deselect them from the list.

Save, switch, or delete metadata sets
If you use multiple workflows, each requiring different sets of displayed metadata, you can
save sets and switch between them.

1. From the options menu  for the Metadata panel, select Metadata Display.

2. Do any of the following:

To save a customized set of displayed metadata, click Save Settings. Then enter a
name, and click OK.

To display a previously saved set of metadata, select it from the menu.

To delete a previously saved set of metadata, select it from the menu, and click
Delete Settings.

Create schemas and properties
If you have a unique, customized workflow that the default metadata options don’t address,
create your own schemas and properties.

1. From the options menu  for the Metadata panel, select Metadata Display.

2. Click New Schema, and enter a name.

3. In the list, click Add Property to the right of the schema name.

4. Enter a property name, and select one of the following for Type:

Displays whole numbers that you drag or click to change.

Displays fractional numbers that you drag or click to change.

Displays a text box (for properties similar to Location).

Displays a check box (for On or Off properties).

Edit XMP metadata
Similarly named properties are linked in the Metadata and Files panels. However, the
Metadata panel provides more extensive properties.

1. In the Editor panel, open the desired file or session.
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2. In the Metadata panel, edit text or adjust values as needed.

Search XMP metadata

1. In the Editor panel, open the file or session you want to search.

2. In the Metadata panel, click the XMP tab.

3. In the search box, enter the text you want to find.

The list of metadata collapses to reveal only properties that contain your search string.

4. To navigate through the search results, click the Previous and Next buttons   to the
right of the search box, or press Tab.

5. To exit the search mode and return to the full list of metadata, click the close button  to
the right of the search box.
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Find shortcuts
Customize shortcuts
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Restore the default shortcuts

Adobe Audition provides a default set of keyboard shortcuts to help you speed up the editing
process. In menus and tool tips, available keyboard shortcuts appear to the right of command
and button names. You can customize nearly all default shortcuts and add shortcuts for other
functions.

Find shortcuts
Do any of the following:

For menu commands, look for shortcuts to the right of command names.

For tools or buttons, look for shortcuts to the right of tool tips. (To display tool tips,
hold the pointer over a tool or button.)

For a complete list of all shortcuts, choose Edit > Keyboard Shortcuts.

Customize shortcuts
You can customize nearly all default keyboard shortcuts and add shortcuts for other
commands.

1. Choose Edit > Keyboard Shortcuts.
2. In the Command column, select the command you want to customize.
3. If you want to replace or remove an existing shortcut, choose it from the Shortcuts For

Command menu.
4. Do any of the following:

To create a shortcut, click inside the Press Shortcut box, and press the desired key
combination. Then click Assign.

To remove a shortcut, click Remove.

If you enter a key combination that’s already in use, Audition displays an alert. Click Yes
to transfer the shortcut to a different command, or No to retain the existing assignment.

Assign shortcuts to the Workspace commands to quickly switch between custom panel
layouts.

Save or delete custom sets of shortcuts
1. Choose Edit > Keyboard Shortcuts.
2. Do either of the following:

To save a custom set, click Save As, enter a name, and click OK.

To delete a custom set, choose it from the Set menu, and then click Delete.

Restore the default shortcuts
1. Choose Edit > Keyboard Shortcuts.
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2. From the Set menu, choose Default Set.

Acrobat
Creative Cloud
Creative Suite
Digital Marketing Suite
Digital Publishing
Suite
Elements
Mobile Apps
Photoshop
Touch Apps
Student and Teacher
Editions

Ad Choices

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/en_US/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy
http://idiom-q-win-1/products/catalog.html?promoid=JOPBT
http://idiom-q-win-1/solutions.html?promoid=JOPCC
http://idiom-q-win-1/marketing/?promoid=JOPCD
http://idiom-q-win-1/digital-media/?promoid=JOPCE
http://idiom-q-win-1/solutions/customer-experience/web-experience-management.html?promoid=JOPCF
http://idiom-q-win-1/solutions/customer-experience/web-experience-management.html?promoid=JOPCF
http://helpx.adobe.com/go/gffooter_industries
http://idiom-q-win-1/education.html?promoid=JOPCH
http://helpx.adobe.com/go/gffooter_financial_services
http://helpx.adobe.com/go/gffooter_government
http://helpx.adobe.com/go/gffooter_help
http://helpx.adobe.com/go/gffooter_product_help_centers
http://helpx.adobe.com/go/gffooter_order_return
http://helpx.adobe.com/go/gffooter_download_install
http://helpx.adobe.com/go/gffooter_myadobe
http://helpx.adobe.com/go/gffooter_learning
http://helpx.adobe.com/go/gffooter_adobe_developer_connection
http://helpx.adobe.com/go/gffooter_adobe_developer_connection
http://helpx.adobe.com/go/gffooter_adobetv
http://helpx.adobe.com/go/gffooter_training_certification
http://helpx.adobe.com/go/gffooter_forums
http://helpx.adobe.com/go/gffooter_design_center
http://helpx.adobe.com/go/gffooter_buy
http://helpx.adobe.com/go/gffooter_homeuse
http://helpx.adobe.com/go/gffooter_homeuse
http://helpx.adobe.com/go/gffooter_students_store
http://helpx.adobe.com/go/gffooter_students_store
http://helpx.adobe.com/go/gffooter_small_medium_business
http://helpx.adobe.com/go/gffooter_small_medium_business
http://helpx.adobe.com/go/gffooter_licensingprograms
http://helpx.adobe.com/go/gffooter_licensingprograms
http://helpx.adobe.com/go/gffooter_special_offers
http://helpx.adobe.com/go/gffooter_downloads
http://helpx.adobe.com/go/gffooter_adobe_reader
http://helpx.adobe.com/go/gffooter_adobe_flashplayer
http://helpx.adobe.com/go/gffooter_adobe_air
http://helpx.adobe.com/go/gffooter_adobe_shockwave_player
http://helpx.adobe.com/go/gffooter_company
http://helpx.adobe.com/go/gffooter_news_room
http://helpx.adobe.com/go/gffooter_partner_programs
http://helpx.adobe.com/go/gffooter_corporate_social_responsibility
http://helpx.adobe.com/go/gffooter_career_opportunities
http://helpx.adobe.com/go/gffooter_investor_relation
http://helpx.adobe.com/go/gffooter_events
http://helpx.adobe.com/go/gffooter_legal
http://helpx.adobe.com/go/gffooter_security
http://helpx.adobe.com/go/gffooter_contact_adobe
http://helpx.adobe.com/go/gffooter_terms_of_use
http://helpx.adobe.com/go/gffooter_online_privacy_policy
http://helpx.adobe.com/go/gffooter_trust_icon
http://helpx.adobe.com/go/gffooter_choose_region
http://idiom-q-win-1/products/acrobat.html?promoid=JOPBV
http://idiom-q-win-1/products/acrobat.html?promoid=JOPBV
http://idiom-q-win-1/products/creativecloud.html?promoid=JQPER
http://idiom-q-win-1/products/creativecloud.html?promoid=JQPER
http://idiom-q-win-1/products/creativesuite.html?promoid=JOPBW
http://idiom-q-win-1/products/creativesuite.html?promoid=JOPBW
http://idiom-q-win-1/products/digital-marketing-suite.html?promoid=JOPBY
http://idiom-q-win-1/products/digital-marketing-suite.html?promoid=JOPBY
http://idiom-q-win-1/products/digital-publishing-suite-family.html?promoid=JOPBZ
http://idiom-q-win-1/products/digital-publishing-suite-family.html?promoid=JOPBZ
http://idiom-q-win-1/products/digital-publishing-suite-family.html?promoid=JOPBZ
http://idiom-q-win-1/products/elements-family.html?promoid=JOPBX
http://idiom-q-win-1/products/elements-family.html?promoid=JOPBX
http://idiom-q-win-1/products/mobileapps/?promoid=JOPCA
http://idiom-q-win-1/products/mobileapps/?promoid=JOPCA
http://idiom-q-win-1/products/photoshopfamily.html?promoid=JOPCB
http://idiom-q-win-1/products/photoshopfamily.html?promoid=JOPCB
http://idiom-q-win-1/products/touchapps.html?promoid=JOPBU
http://idiom-q-win-1/products/touchapps.html?promoid=JOPBU
http://idiom-q-win-1/education/students.html?promoid=JUTMH
http://idiom-q-win-1/education/students.html?promoid=JUTMH


Adobe Audition Help / Default keyboard shortcuts
Adobe Community Help

Products Affected
Adobe Audition CS6
Adobe Audition CS5.5

Contact support
To the top

To the top

Keys for playing and zooming audio
Keys for editing audio files
Keys for mixing multitrack sessions

These partial lists include the shortcuts that Adobe Audition experts find most useful. For a
complete list of shortcuts, choose Edit > Keyboard Shortcuts.

Keys for playing and zooming audio

Keys for editing audio files
The following keyboard shortcuts apply only in the Waveform Editor.

Result Windows
shortcut

Mac OS shortcut

Repeat previous command (opening its
dialog box and clicking OK)

Shift+R Shift+R

Repeat previous command (opening its Ctrl+R Command+R

Result Windows
shortcut

Mac OS
shortcut

Toggle between Waveform and Multitrack Editor 8 8

Start and stop playback Spacebar Spacebar

Move current-time indicator to beginning of timeline Home Home

Move current-time indicator to end of timeline End End

Move current-time indicator to previous marker, clip,
or selection edge

Ctrl+left
arrow

Command+left
arrow

Move current-time indicator to next marker, clip, or
selection edge

Ctrl+right
arrow

Command+right
arrow

Toggle preference for Return CTI To Start Position
On Stop

Shift+X Shift+X

Zoom in horizontally = =

Zoom in vertically Alt+= Option+=

Zoom out horizontally - -

Zoom out vertically Alt+minus
sign

Option+minus
sign

Add marker M or *
(asterisk)

M or * (asterisk)
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dialog box but not clicking OK)

Open Convert Sample Type dialog box Shift+T Shift+T

Capture a noise reduction profile for the
Noise Reduction effect

Shift+P Shift+P

Activate left channel of a stereo file for
editing

Up arrow Up arrow

Activate right channel of a stereo file for
editing

Down arrow Down arrow

Make spectral display more logarithmic
or linear

Ctrl+Alt+up or
down arrow

Option+Command+up or
down arrow

Make spectral display fully logarithmic or
linear

Ctrl+Alt+Page
Up or Down

Option+Command+Page
Up or Down

Increase or decrease spectral resolution Shift+Ctrl+up or
down arrow

Shift+Command-up or
down arrow

Keys for mixing multitrack sessions
The following keyboard shortcuts apply only in the Multitrack Editor.

Result Windows
shortcut

Mac OS
shortcut

Select the same input or output for all audio tracks Ctrl+Shift-
select

Command+Shift-
select

Activate or deactivate Mute, Solo, Arm For Record,
or Monitor Input in all tracks

Ctrl+Shift-
click

Command+Shift-
click

Adjust knobs in large increments Shift-drag Shift-drag

Adjust knobs in small increments Ctrl-drag Command-drag

Nudge selected clip to the left Alt+comma Option+comma

Nudge selected clip to the right Alt+period Alt+period

Maintain keyframe time position or parameter value Shift-drag Shift-drag

Reposition envelope segment without creating
keyframe

Ctrl-drag Command-drag
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